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Trademarks
Products in this manual are referred to by their trade names. In 
most, if not all cases, these designations are claimed as trademarks 
or registered trademarks of their respective companies.

This manual contains the following safety information:
■ Appendix B lists instructions for safe use.

You are advised to read this information before you start using 
the system.
Technical safety information, such as safety data sheets, can 
also be found in this appendix.

■ Where applicable, cautions and attentions are used throughout 
this guide to point out safety precautions to be adhered to. (see 
‘Notation conventions’ on page 10)
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Notation conventions

Definition

There are a number of notation conventions used in this manual. This 
consistent style enables you to quickly become conversant with the use of this 
manual and consequently the Océ TCS400.

Attention getters
There are several types of information to which we draw your attention. This 
information is classified as follows:

Note: In a Note, information is given about the proper function of the machine 
or application. Useful advice concerning its operation may also be given.

Attention: The information that follows Attention is given to prevent something 
(your copy or original, the copier or printer, data files etc.) from being 
damaged.

Caution: The information that follows Caution is given to prevent you from 
suffering personal injury.

Description 

Each section or subsection contains a description of the feature or operation 
identified in the title. It might also include possible applications, as well as any 
guidelines, that you should bear in mind.

Procedures 

A description is followed by a procedure. A procedure always begins with a 
phrase which briefly describes the procedure, followed by a series of numbered 
steps that take you, step by step, through all phases of performing the 
operation.

Figures and tables 

Figures and tables are titled and numbered sequentially throughout this 
manual. Figures include pictures of product components, screendumps, 
examples, and diagrams of concepts discussed in the description.
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The documentation set 

Introduction

This user manual describes how to operate the Océ TCS400 and helps you 
make optimal use of the Océ TCS400. This user manual is intended for 
common users, key operators, system administrators and repro operators. (see 
‘The Océ TCS400 users’ on page 13)

The complete documentation set of the Océ TCS400 includes the following:
■ The Océ TCS400 user manual
■ The Océ Power Logic® controller connectivity manual
■ The self-support guide
■ On-line help files in the Océ Power Logic® applications
■ An additional context-sensitive, abridged version of the on-line help in the 

Océ Settings Editor
■ The documentation for the drivers and the job submission software.

The User's Manual

The User's Manual is supplied with the Océ TCS400, as a PDF file in 16 
languages on the CD-ROM.
You can also contact your local Océ organization for the latest version of the 
User's Manual.

The Connectivity Manual

The connectivity manual is supplied as a PDF on a separate CD-ROM (English 
only).

The Self-support Guide

The self support guide is supplied as a booklet in 18 languages. The 
Self-support Guide has two chapters. The first chapter contains tips to help you 
find solutions to the questions that can occur when using the system. The 
second chapter contains safety information that you can also find in appendix 
B of this manual. (see ‘Instructions for safe use’ on page 304)
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On-line help files in the Océ Power Logic® applications

The on-line help files in the Océ Power Logic® applications include detailed 
descriptions of all functional aspects of the applications.
The on-line help files in the Océ Power Logic® applications are supplied in all 
the supported languages.
The generic help describes how to connect to a controller from a remote 
location.

The Océ Settings Editor includes an additional context-sensitive concise help 
besides the traditional on-line help in the help menu. This concise help text is 
displayed when you select a setting. This concise help is an abridged version 
of the on-line help in the help menu.

The documentation for the drivers and the job submission software

The documentation set for the drivers and the job submission software includes 
the following:
■ Windows® Printer Driver 

An installation guide to help you to install the driver.
Windows Printer Drivers Self-support Guide.
An on-line help with detailed descriptions of all functional aspects.

■ Océ Postscript 3 driver
A getting started manual to help you to install and configure the driver.
An on-line help with detailed descriptions of all functional aspects.

■ Océ ADI/HDI driver
An installation guide to help you to install the driver.
AutoCAD Printer Drivers self support guide.
An on-line help with detailed descriptions of all functional aspects.

■ Océ Print Exec® job submission software.
On-line help files with detailed descriptions of all functional aspects.
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The Océ TCS400 users

Introduction

The Océ TCS400 has the following types of users:
■ Common user
■ Repro operator
■ Key operator
■ System administrator.

Common user

The common user is a person who uses the system for print jobs, copy jobs or 
scan to file jobs. The common user has no permissions to change the system 
settings. The Océ Power Logic® controller software does not authenticate the 
common user. Therefore the common user is referred to as an anonymous user. 
In order to be consistent with the Océ Power Logic® controller software, the 
common user is referred to as an anonymous user in this manual.

Repro operator

The repro operator is responsible for the daily use of the Océ TCS400 in a 
central repro department. The repro operator has no permissions to change the 
settings in the Océ Settings Editor. In the Océ Queue Manager the repro 
operator has the same permissions as the key operator. In the Océ Scan 
Manager the repro operator can delete destinations and files.

Key operator

The key operator is responsible for the user maintenance and the system 
settings of the Océ TCS400.
The key operator has the permission to define the key operator settings in the 
Océ Settings Editor.

The key operator has full permission in the Océ Queue Manager, the Océ 
System Control Panel, and the Océ Scan Manager.
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System administrator

The system administrator is responsible for installing and configuring the Océ 
TCS400 in the network environment.

The system administrator has the following tasks and permissions in the Océ 
Settings Editor:
■ Update the IT8 data file for scanner calibration
■ Define the system administrator settings in the Océ Settings Editor.
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The Océ TCS400 multifunctional color system

Introduction

The Océ TCS400 is a modular wide-format color system.
The Océ TCS400 offers a wide range of print, copy, and scan-to-file 
functionality. The Océ TCS400 uses the CMYK color model. The printer 
contains printheads for cyan, magenta, yellow, and black (CMYK) and is based 
on thermal inkjet technology.

The Océ TCS400 consists of the following modules:
■ The printer
■ The scanner
■ The Océ Power Logic® Controller.

The modular construction of the Océ TCS400 allows you to create a 
customized configuration. The Océ Power Logic® Controller is required for all 
configurations.

The Océ TCS400 main components

When you have a configuration without a monitor, a keyboard and a mouse 
directly connected to the controller, you can place the Océ Power Logic® 
controller inside the controller cabinet of the printer.
When you have a configuration with a monitor, a keyboard and a mouse 
directly connected to the controller, you cannot place the Océ Power Logic® 
controller inside the controller cabinet of the printer.
You can always place the Océ Power Logic® controller inside a separate 
controller cabinet.

The following figure depicts a Océ TCS400 with a complete configuration.
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[1] The Océ TCS400 multifunctional color system

[1] The Océ TCS400 multifunctional color system

1 The printer
2 The Océ Power Logic® controller inside a separate controller cabinet with a 

monitor, a keyboard and a mouse directly connected to the controller
3 The scanner.
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The Océ TCS400 printer

Introduction

The printer is a 36 inch color printer with a true resolution of 600 dpi. The Océ 
TCS400 is available with 1 or 2 media rolls.

Illustration
[2] The media input side of the printer

[2] The media input side of the printer
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[3] The output side of the printer

[3] The output side of the printer
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The main components of the Océ TCS400 printer
[4] The main components of the printer

[4] The main components of the printer

1 Printer operator panel
2 Carriage with the printheads
3 Media rolls
4 Integrated receiving tray
5 Ink tanks
6 The door to the integrated Océ Power Logic® controller cabinet
7 The door to the maintenance cassette.

The following illustrations depict a detailed view of the main components.
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[5] The printer operator panel

[5] The printer operator panel

[6] The carriage with the printheads

[6] The carriage with the printheads
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[7] The ink tanks

[7] The ink tanks

[8] The maintenance cassette

[8] The maintenance cassette
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[9] The media rolls

[9] The media rolls

[10] The integrated Océ Power Logic® controller cabinet

[10] The integrated Océ Power Logic® controller cabinet

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


24 Océ TCS400 User manual

The printer operator panel

Introduction

This section describes the parts and the functions of the printer operator panel. 
You can turn the printer operator panel for easy vision from both sides of the 
printer.

Use the printer operator panel to view system information on the on-line screen 
and to do actions on the off-line screen.

The main components of the printer operator panel include the following:
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[11] The main components of the printer operator panel

[11] The main components of the printer operator panel

1 The upper softkeys
2 The red attention LEDs
3 The screen
4 The on-line / off-line key with green LED
5 The stop key
6 The lower softkeys.

The screen

The screen of the printer operator panel displays different types of information. 
The type of information depends on the mode of the system.
When the printer is in the on-line mode, the screen displays general system 
information and job information.
When the printer is in the off-line mode, the screen displays various wizards 
for user action.
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The keys

The printer operator panel includes the following keys:
■ An on-line / off-line key
■ A stop key
■ Two upper softkeys
■ Two lower softkeys.

■ On-line / off-line key
Use the on-line / off-line key to switch between the on-line mode and the 
off-line mode on the screen. If you press the on-line / off-line key while the 
printer is active, the printer finishes the print. The printer then goes off-line. 
The next section contains more information about the on-line mode and the 
off-line mode (see ‘The on-line mode and the off-line mode’ on page 27).

■ Stop key
Use the stop key to delete or to stop a job (see ‘Delete or stop an active job 
on the printer’ on page 153).

The function of a softkey depends on the mode of the printer operator panel. 
(see ‘The on-line mode and the off-line mode’ on page 27)

Use the upper softkeys to perform the following:
■ Scroll through the information tabs on the on-line screen.
■ Scroll through the wizard cards on the off-line screen.
■ Step through the wizards on the off-line screen.

Use the lower softkeys to perform the following:
■ Select fields on the on-line screen
■ Select the wizards on the off-line screen
■ Select options in the wizards on the off-line screen.

Red attention LEDs

If operator action is required, the red error LEDs illuminate and you will hear 
an audio signal. The printer displays the following types of signals:
■ An attention signal.

A short interrupted audio signal. The red LEDs flash two times.
■ A warning signal.

A short interrupted audio signal. The red LEDs remain illuminated
■ An error signal

A long, uninterrupted audio signal. The LEDs flash continuously.

Chapter 8 Error handling describes how to correct possible errors.
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The on-line mode and the off-line mode

Introduction

Use the on-line / off-line key to switch between the on-line mode and the 
off-line mode on the screen of the printer operator panel. If you press the 
on-line / off-line key while the printer is active, the printer finishes the print. 
The printer then goes off-line.
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The on-line mode

When the printer is in the on-line mode, the green LED is on. The screen of the 
printer operator panel displays the following five information cards.

[1] On-line mode - Information cards

[1] On-line mode - Information cards

Information card Displayed information

Job information ■ Job status
■ Job name
■ Progress indication
■ Selected print mode.

Media information The media types loaded on the system .

Ink level information The ink level of each ink tank. There are four 
indication types.

■ Percentage of ink in a tank (1% - 100%).
■ 'Ink tank empty' (0%). The indication for the 

empty tank blinks.
■ The ink tank is not in place. The indication 

shows a dashed rectangle.
■ Possible obstruction of ink path. (see 

‘Miscellaneous errors’ on page 208)

Printhead information The status of each printhead. There are three 
status types.

■ All printheads OK
■ Defective printheads

During the last check in the 'Optimize print 
quality' wizard, failed nozzles were detected. 
The printer can continue to print. Use the 
'Optimize print quality' to check for failed 
nozzles and to recover the failed nozzles. The 
last time the printheads were checked is 
displayed on the lower left corner off the 
screen. (see ‘Use the Optimize print quality 
wizard’ on page 141).

System information ■ Error messages and warnings about the 
maintenance cassette.

■ Make a demo print
■ Change the language.
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Use the upper softkeys to scroll through the information tabs. The screen for 
each information card can contain the following parts:

[2] The parts of the on-line screen

[2] The parts of the on-line screen

Note: The information on the on-line screen is also available in the Océ System 
Control Panel.

The off-line mode

Press the on-line / off-line key to enter the off-line mode. When the printer is 
in the off-line mode, the green LED is off. The printer operator panel displays 
a set of wizards. A wizard always requires a user action. When you initially 
enter the off-line mode, the printer operator panel displays the wizards 1 and 
2. The next time you enter the off-line mode, you return to the previous 
position.

Part Function

Navigation Use the upper softkeys to navigate through the informa-
tion cards. Press the keys to select the next tab or the pre-
vious tab.

Tab The tab contains an icon for an information card.

Card The card is the center area of the screen. The card dis-
plays the details of the selected information type.
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Use the upper softkeys to scroll through the wizard cards. You can select the 
following wizards:

1 'Feed & cut'(see ‘Cut the output and clean cut a roll of media’ on page 161)
2 'Change media type'(see ‘Change the type of media defined on the printer’ on 

page 164)
3 'Optimize print quality'(see ‘Use the Optimize print quality wizard’ on 

page 141)
4 'Replace printhead'(see ‘Replace a defective printhead’ on page 186)
5 'Replace cassette'(see ‘Replace the maintenance cassette’ on page 192)
6 'Replace ink tank'(see ‘Replace the ink tanks’ on page 183)
7 'Display counters'

Select this wizard to check the amount of media and ink that is used since the 
system was installed. Press the softkey for 'Finish' to return to the off-line 
screen.

8 'Configure system'(see ‘Configure the network settings of the Océ TCS400’ on 
page 49)

9 'Language' (switch only).

The screen of the off-line mode contains the following parts:

[3] The parts of the off-line screen

[3] The parts of the off-line screen

Part Function

Card The cards show the names and a graphical representation 
of the wizards.

Navigation Use the upper softkeys to navigate through the cards and 
through the wizards. Use the lower softkeys to select a 
card or options within the wizards.
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The Océ TCS400 scanner

Introduction

The scanner is a 40 inch color scanner with an optical resolution of 508 dpi.

The main components are described below.

The main components of the Océ TCS400 scanner
[12] The main components of the scanner

[12] The main components of the scanner

1 Scanner operator panel
2 Top cover
3 Scanner feed table
4 Front compartment
5 Integrated receiving tray (optional).
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The scanner operator panel

Introduction

This section describes the parts and the functions of the scanner operator panel.

Use the scanner operator panel for the following.
■ Define the settings for the copy jobs
■ Define the settings for the scan-to-file jobs
■ Start the scanning
■ Access to system settings
■ Calibrate the scanner.

The main components of the scanner operator panel include the following:
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[13] The main components of the scanner operator panel

[13] The main components of the scanner operator panel

1 The screen
2 The upper softkeys
3 The home key
4 The release original key
5 The start key
6 The numeric display
7 The numeric keys
8 The lower softkeys
9 The stop key

10 The correction key
11 The arrow keys.

The screen

When you turn on the scanner, the screen displays the home screen. The home 
screen contains the 'Entry to the copy settings' and the 'Entry to the scan-to-file 
settings'. 

When you select the 'Entry to the copy settings', the screen displays the copy 
settings with the default values defined in the Océ Settings Editor. (see ‘Define 
the copy settings on the scanner operator panel’ on page 61)
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When you select the 'Entry to the scan-to-file settings', the screen displays the 
scan-to-file settings with the default values defined in the Océ Settings Editor. 
(see ‘Define the copy settings on the scanner operator panel’ on page 61)

[14] The Home screen

[14] The Home screen

The home screen also gives access to the system settings. Use the softkey 
above the 'System' card to access the following:

■ The language settings.
The language settings include the first and the second language defined in 
the Océ Settings Editor.

■ The original handling settings.
The original handling settings include the original release modes and the 
auto feed settings.

■ 'Deskew'
When this setting is enabled , the scanner automatically corrects the angle 
of a slightly skewed image. The 'Deskew' setting operates only when the 
'Size' setting on the 'Original' card is set to 'Automatic'. (see ‘Define the size 
of the originals’ on page 66)(see ‘Define the size of the originals’ on 
page 85)

■ The scanner calibration wizards.
[15] The System screen

[15] The System screen

If an error occurs on the scanner, the screen displays an error recovery screen. 
The error recovery screen fills the complete screen.
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The upper left corner of the screen displays the system information. The 
system information is not available in the following situations:
■ During a wizard
■ The screen displays an error recovery screen.

The keys

The keys on the scanner operator panel have the following functions:
■ The numeric keys.

Use the numeric keys to set numeric values. For example, the number of 
copies or the scaling factors.

■ The start key
Use the start key to start the original feed. When you scan a set, press the 
start key to close the set.

■ The stop key
Use the stop key to stop the scanner. When you make a direct copy, press 
the stop key to stop the printer.

■ The correction key
Use the correction key to reset a setting to its default value. Press the 
correction key one time to reset a setting to its default value. Press the 
correction key two times to reset the numeric display to 1. 

■ The home key.
Use the home key to return to the home screen. When you are in an error 
recovery screen, you cannot use the home key to return to the home screen.

■ The release original key
Use the release original key to release the original from the scanner after it 
is scanned.

■ The upper softkeys
Use the upper softkeys to move through the cards.

■ The lower softkeys
Use the lower softkeys to define the job settings.

■ The arrow keys
Use the arrow keys to define numeric settings.
Use the upper and lower arrow keys to increase or decrease the active value 
by 1. Use the left and right arrow keys to increase or decrease the active 
value by 10. Hold down the arrow keys, to rapidly scroll through the values.
When you define the scale values, use the left arrow key to move through 
the reduction steps defined in the Océ Settings Editor. Use the right arrow 
key to move through the enlargement steps defined in the Océ Settings 
Editor. Use the arrow keys to define the settings in spin boxes.
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The Océ Power Logic® controller

Introduction

The Océ Power Logic® controller is based on a standard PC platform running 
Windows® XP embedded.

The Océ Power Logic® controller is required for the following:
■ Process the print jobs
■ Define the default system settings
■ Manage the job queue
■ Manage the set memory
■ Receive jobs over the network.

The location of the Océ Power Logic® controller

You can place the Océ Power Logic® controller in one of the following 
locations:
■ Inside the controller cabinet of the Océ TCS400 printer
■ If you have a monitor, a keyboard and a mouse connected to the Océ Power 

Logic® controller, the controller is always placed inside a separate 
controller cabinet. (see ‘The Océ TCS400 multifunctional color system’ on 
page 16)
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The applications that run on the Océ Power Logic® controller
[4] Océ applications that can run on the Océ Power Logic® controller

[4] Océ applications that can run on the Océ Power Logic® controller

Application Function

Océ System Control 
Panel

■ Display the status of the printer
■ Display the media available on the system
■ Display the ink level for each color
■ Display the status of the scanner
■ Display the volume of set memory in use
■ Print the configuration settings
■ Print a demo print.

Océ Settings Editor Change the default settings of the system. You 
need a password to edit the settings of the Océ 
Settings Editor. There are two types of settings.
■ Key operator settings (KO settings)
■ System administrator settings (SA settings).

The key operator can define the key operator set-
tings.
The system administrator can define the system 
administrator settings.
The repro operator and the anonymous users can 
only view the settings.

Océ Queue Manager ■ Control and view the job queue
■ Inspect the progress of a job
■ Cancel jobs
■ Delete jobs
■ Pause and restart jobs
■ Move jobs to the top
■ Reprint multiple sets from the history queue.
■ Print jobs from the inbox queue
■ View the properties of jobs in the print queue, 

inbox queue and history queue.

Océ Scan Manager ■ Create and manage the destinations for scan to 
file

■ Define the file names
■ Manage the files
■ View the scanned files.

Océ Remote Logic® Use Océ Remote Logic® to access the three appli-
cations mentioned above from a remote worksta-
tion.
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Introduction

This chapter contains all the information you need to get started. You can learn 
more about the following:
■ Turn on and off the Océ TCS400
■ The energy save modes
■ Change the display language
■ Configure the network settings.
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Turn on and off the Océ TCS400

Turn on and off the Océ TCS400

Introduction

The Océ Settings Editor application contains an important setting for the start 
up and shut down of the printer and Océ Power Logic® controller. The path of 
the setting is the following:

KO - System - Synchronize printer and Power Logic controller power 
on/off.

Depending on this setting, you can turn the Océ TCS400 printer and the Océ 
Power Logic® controller on and off, together or separately.

You can define if this setting is 'On' or 'Off'. The following paragraphs describe 
how to turn on and off the Océ TCS400 when the above setting is set to either 
'On' or 'Off'.

The setting 'Synchronize printer and Power Logic controller power on/off 'does 
not work for the scanner. You can only turn the scanner on or off separately.

The Océ TCS400 printer and Océ Power Logic® controller have 2 energy save 
modes that enable you to prevent unnecessary power consumption when the 
system remains turned on in an idle state (see ‘Energy save modes’ on 
page 44).

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


42 Océ TCS400 User manual

Turn the Océ Power Logic® controller and the printer on

Perform the following when the setting KO - System - Synchronize printer 
and Power Logic controller power on/off if the Océ Settings Editor is set to 
'On':

1 Press the on/off button of the printer.
The Océ Power Logic® controller and the printer both start up.
[16] The on/off button of the printer

[16] The on/off button of the printer

Perform the following when the setting KO - System - Synchronize printer 
and Power Logic controller power on/off if the Océ Settings Editor is set to 
'Off'.

1 Press the on/off button on the Océ Power Logic® controller.
2 Press the on/off button on the printer.
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Turn the Océ Power Logic® controller and the printer off

Perform the following when the setting KO - System - Synchronize printer 
and Power Logic controller power on/off if the Océ Settings Editor is set to 
'On': There are two possibilities:

1 Press the on/off button on the printer or
2 select 'Shut down' from the 'System' menu in the Océ System Control Panel.

The Océ Power Logic® controller and the printer both shut down.

Perform the following when the setting KO - System - Synchronize printer 
and Power Logic controller power on/off if the Océ Settings Editor is set to 
'Off'.

1 Press the on/off button on the printer.
The printer shuts down.

2 Open the Océ System Control Panel application on the Océ Power Logic® 
controller.

3 From the 'System' menu, select 'Shut down'.
The Océ Power Logic® controller shuts down.

Turn the scanner on and off

1 Press the switch at the rear of the scanner.
The scanner begins initializing.

2 After the scanner initializes, this takes 3 to 5 minutes, turn the Océ Power 
Logic® controller on.

The scanner needs 5 minutes to warm up before you can scan a job. The 
scanner needs 60 minutes to warm up for the best quality output.
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Energy save modes

Introduction

The Océ TCS400 has two modes to prevent unnecessary power consumption.
■ The energy save mode

The energy save mode functions only for the printer and Océ Power Logic® 
controller.

■ The sleep mode.

The energy save mode

The system uses less energy in the energy save mode than in the normal 
operating mode. Both the printer and the Océ Power Logic® controller remain 
turned on. By default, the energy save mode is enabled in the Océ Settings 
Editor. Use the setting KO - System - Timers - Energy save mode in the Océ 
Settings Editor to define the delay in minutes before the Océ TCS400 enters 
the energy save mode.

When the Océ TCS400 is in the energy save mode, you can activate the system 
as follows:
■ Send a job
■ Press a key on the printer operator panel
■ Press the retract button to retract a roll
■ Load a roll.

Note: The energy save mode complies with the EPA Energy Star® sleep mode 
requirements for wide format printers. In Appendix B this mode is referred to 
as sleep mode.

The sleep mode

The power supply of the printer is turned off in the sleep mode. The exposure 
lamp on the scanner turns off and the screen displays a sleep mode message. 
The Océ Power Logic® controller remains turned on.

The system uses less energy in the sleep mode than in the energy save mode. 
Use the setting KO - System - Timers - Sleep mode timer in the Océ Settings 
Editor to define the delay in minutes before the Océ TCS400 enters the sleep 
mode.
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There are two ways to activate the printer from the sleep mode.
■ Send a job
■ Press the on/off button of the printer.

The printer needs about 1 minute to wake up from the sleep mode. The green 
LED illuminates. This indicates that the system wakes up. During the wake-up 
period the screen remains blank.

Press any key on the scanner operator panel to activate the printer from the 
sleep mode.

The scanner needs 5 minutes to warm up before you can scan a job. The 
scanner needs 60 minutes to warm up for the best quality output.
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Prepare the Océ TCS400 for use

Change the display language of the Océ TCS400

Introduction

You can change the display language for the following components:
■ The controller applications
■ The printer operator panel
■ The scanner operator panel.

Change the language of the controller applications
You can change the display language of the controller applications (Océ 
Settings Editor, Océ System Control Panel, Océ Queue Manager). You can 
choose from 18 available languages. (see ‘Parameters of supported languages’ 
on page 258)

If you have a keyboard, mouse and monitor with your Océ Power Logic® 
controller, you can access the controller applications local on the controller. If 
you do not have a keyboard, mouse and monitor with your Océ Power Logic® 
controller, you must use Océ Remote Logic® to connect to the controller 
applications.

Change the language of the operator panels
You can change the language of the printer operator panel from the on-line 
screen and the off-line screen. You can change the language of the scanner 
operator panel from the system screen. You can only toggle between two 
languages. Make sure that the first language and the second language are 
correctly defined in the Océ Settings Editor. You can choose from 15 available 
languages.

Use the setting KO - System - Localization - Display languages - First 
language to define the default language.
Use the setting KO - System - Localization - Display languages - Second 
language to define the alternative language.

Note: Only the first language and the second language defined in the Océ 
Settings Editor are available on the operator panels.
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How to change the language of the controller applications

1 Open the 'View' menu.
2 Select 'Language'.

If you connect to the controller from Océ Remote Logic®, all languages are 
available. If you use the controller applications local on the controller, only the 
first language and the second language defined in the Océ Settings Editor are 
available.

3 Select one of the languages.
The screen language of the application changes to the selected language.

Note: If you connect to the controller from Océ Remote Logic® and you change 
the display language, only the display language of the current application will 
change. If you use the controller applications local on the controller and you 
change the display language, the display language of all applications will 
change.

How to change the language on the on-line screen of the printer operator panel

1 Use the upper softkeys to select the 'System' tab.
2 Press the lower right softkey to change the language.

[17] Press the lower-right softkey to change the language

[17] Press the lower-right softkey to change the language

How to change the language on the off-line screen of the printer operator panel

1 Press the on-line / off-line key to set the printer off-line.
2 Use the upper softkeys to scroll to the 'Language' card.

[18] The language card on the off-line screen

[18] The language card on the off-line screen

3 Press the softkey below the 'Language' card to change the language.
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How to change the language on the scanner operator panel

1 On the home screen, press the upper right softkey for 'System' to enter the 
system screen.

2 Press the softkey below the 'Language' card to change the language.
[19] The language card on the system screen

[19] The language card on the system screen

Note: If the first language and the second language defined in the Océ Settings 
Editor are the same, the language card is not visible.
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Configure the network settings of the Océ TCS400

Introduction

The system administrator is responsible for installing and configuring the Océ 
TCS400 in the network environment. There are two ways to configure the 
network settings.
■ From the printer operator panel

The off-line screen on the printer operator panel contains a wizard to 
configure the network settings.

■ With the system administrator settings (SA settings) in the Océ Settings 
Editor.
The Océ Settings Editor allows you to configure a large number of system 
settings. Only the system administrator is authorized to define the system 
settings.

Actions in the Configure system wizard

You can perform the following actions in the 'Configure system' wizard.
■ Enable DHCP for adapter 1, 2 or 3
■ Set the IP address for adapter 1, 2 or 3
■ Set the IP subnet mask for adapter 1, 2 or 3
■ Set the default gateway for adapter 1, 2 or 3
■ Clear the set memory (see ‘Miscellaneous errors’ on page 208).

Use this option for a damaged job that you cannot delete in the Océ Queue 
Manager.

The 'Configure system' wizard also contains installation settings and service 
settings. A password protects the installation settings and the service settings. 
Only Océ service engineers can access the installation settings and the service 
settings.
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How to configure the system from the printer operator panel 

1 Press the on-line / off-line key to set the printer off-line (see ‘The on-line mode 
and the off-line mode’ on page 27).

2 Use the upper softkeys to scroll to the 'Configure system' card.

3 Press the softkey below the 'Configure system' card to enter the wizard.
The screen displays the message 'Use this wizard to configure the system.'

4 Press the key for 'Next'.
The screen displays the message 'Select item.'

5 Use the lower softkeys to select 'Network settings adapter [number]'.

6 Press the key for 'Next'.
7 The screen displays 'Use DHCP server for adapter [number]?'. Use the lower 

softkeys to select 'Yes' or 'No'.
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Continue with step 8 when you select 'Yes'.
Continue with step 9 when you select 'No'.

8 After you select 'Yes', press the key for 'Next'.
The screen displays 'Finish' and 'Back'.
Press the key for 'Finish' if you want to use the DHCP server. The network 
settings are now received from the DHCP server. The wizard finishes here.
Press the key for 'Back' and continue with step 10 if you want to configure the 
network settings manually.

9 After you select 'No', press the key for 'Next'.
10 The screen displays 'Set IP address for adapter [number]'.

Press the keys for '-' and '+' to define the IP address.
After you finish an octet, press the key for 'Next' to go to the next octet.

11 Press the key for 'Next' after you finish the last octet. The screen displays 'Set 
subnet mask for adapter [number]'.
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Press the keys for '-' and '+' to define the subnet mask.
After you finish an octet, press the key for 'Next' to go to the next octet.

12 Press the key for 'Next' after you finish the last octet. The screen displays 'Set 
default gateway for adapter [number]'.

Press the keys for '-' and '+' to define the default gateway.
After you finish an octet, press the key for 'Next' to go to the next octet.

13 After you finish the last octet, the screen shows an overview of all the network 
settings.

Press the key for 'Finish' to confirm the settings and to exit the wizard.

How to configure the system from the Océ Settings Editor

1 Log on to the system administrator mode.
2 From the 'View' menu in the menu bar, select 'SA settings'.
3 Use the buttons on the left toolbar to display the required group of settings.
4 Select the required settings in the tree structure.
5 Define the settings in the update area.
6 Click the 'Apply' button to confirm the new settings.
7 Log off from the system administrator mode to prevent unauthorized use of the 

application.
See the on-line help in the Océ Settings Editor for more information about how 
to configure the system from the Océ Settings Editor.
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Introduction to how to send print jobs to the Océ TCS400

Send print jobs to the Océ TCS400

You can send your print jobs to the Océ TCS400 in various ways. The default 
configuration of the Océ TCS400 includes the following:
■ Printer drivers
■ Océ Print Exec® Workgroup
■ FTP.

After you send jobs to the printer, you can manage the jobs through the Océ 
Queue Manager and the printer operator panel (see ‘Introduction to how to 
manage your jobs’ on page 152).

Note: The settings defined in the printer drivers or the job submission tools 
always overrule the settings defined in the Océ Settings Editor. 
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Important points for the sending of print jobs

Before you send print jobs to the Océ TCS400, remember the following:
■ The values defined in the Océ Settings Editor are default values for the 

system. You can define a number of job settings in the printer drivers or the 
job submission tools. The settings defined in the printer drivers or the job 
submission tools always overrule the settings defined in the Océ Settings 
Editor.
Chapter 10 of the user manual and the on-line help in the Océ Settings 
Editor include complete information about the Océ Settings Editor

■ Make sure the media type and size defined in your job match the media type 
and size defined on the printer.

■ Make sure you define the correct print mode for your job.
■ Make sure you define the correct media type for your job.
■ Make sure you define the correct job settings. For example, orientation, 

rotate, shift, and 'Automatic roll switch'. The section about the correct 
media types for your jobs describes the job settings you can use with the 
different media types and sizes.

A job submission tool, like Océ Print Exec® Workgroup, provides you with 
information about the media defined on the system. The printer drivers do not 
give this type of information. When you use the printer drivers to send your 
jobs, use Océ Remote Logic to view information about the media defined on 
the printer in the Océ System Control Panel.

Chapter 4 of the User's Manual includes more information about how to send 
print jobs to the Océ TCS400.

Chapter 6 includes more information about how to define the correct media 
settings for your jobs.
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Send print jobs to the Océ TCS400 from 
your software environment

Use the printer drivers to send jobs to the Océ TCS400

Introduction

The Océ TCS400 is delivered with a driver pack CD-ROM. You can also 
download the latest Océ drivers, free of charge, from our Web site 
www.oce.com.

Note: More information about how to install, configure and use the drivers is 
available in the documentation provided with the drivers.

Available printer drivers

Use the following printer drivers with the Océ TCS400 to print files from the 
software applications:
■ Windows® printer driver

Use the Windows® printer driver to print from Microsoft® Windows® 9.x, 
ME, 2000, NT 4.0, or XP.

■ AutoCAD® ADI/HDI drivers
Use the AutoCAD® ADI driver to print from AutoCAD® 14. Use the 
AutoCAD® HDI driver to print from AutoCAD® 2000/2001/2002.

■ Océ Postscript 3 driver.
Use the Océ Postscript 3 driver to print from graphical application software 
on Microsoft® Windows, Apple® Macintosh and Unix™ Postscript.
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Use Océ Print Exec® workgroup to send jobs to the Océ TCS400

Introduction

Océ Print Exec® workgroup is a job submission application which allows you 
to send print jobs to the Océ TCS400 through your web browser

Note: Please consult the on-line help on the Océ Print Exec® workgroup 
application for detailed information.

Before you begin

Requirements for the browser software and network.
■ Microsoft® Internet Explorer® 4.01 (SP 2) or higher versions, or
■ Netscape Navigator® 4.08 or higher versions.
■ TCP/IP network, which connects the printer and the end user workstation
■ Port 8001, not filtered.

How to connect to Océ Print Exec® workgroup

1 Enable Océ Print Exec® workgroup in the Océ Settings Editor.
2 Enter the following URL in your browser: http://printer name.

Note: The printer name is the domain network server (DNS) name or IP 
address of the printer.
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Use FTP to send jobs to the Océ TCS400

Introduction

The Océ TCS400 supports printing through FTP. You can print the files 
through FTP from a command line prompt, an FTP application, or from a Web 
browser. The most convenient way to print files through FTP is to drag and 
drop the files or to copy and paste the files, into the 'Jobs' folder on the FTP site 
of your Océ TCS400. 

Web browsers that support job submission through FTP

The following Web browser supports the drag and drop of files:
■ Netscape® Navigator 4.x.

Drag the jobs into the 'Jobs' folder on the FTP site of your Océ TCS400. The 
jobs appear in the print queue of the Océ Queue Manager.

The following Web browsers support the copy and paste of files:
■ Netscape® Navigator 4.x
■ Microsoft® Internet Explorer 5.5.

Paste the jobs into the 'Jobs' folder on the FTP site of your Océ TCS400. The 
jobs appear in the print queue of the Océ Queue Manager.
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Introduction to how to do copy jobs on the Océ TCS400

This chapter contains all the information you need to perform copy jobs from 
the Océ TCS400 scanner. You can learn more about the following:
■ How to define the job settings
■ How to start a job.

The 'Important copy settings' section in this chapter describes the settings that 
need special attention and which are not described anywhere else in this 
manual. 

The chapter 'Ensure the best quality output' describes how to use the settings 
that control the image quality on the output.

The on-line help in the Océ Settings Editor gives complete information about 
the different settings.

After you start the jobs on the scanner, you can manage the jobs from the Océ 
Queue Manager.
You can stop or delete the copy jobs from the scanner operator panel.
When the printer processes the job, you can also stop or delete the jobs from 
the printer operator. panel.(see ‘Introduction to how to manage your jobs’ on 
page 152)
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Use the Océ TCS400 scanner to perform 
copy jobs

Define the copy settings on the scanner operator panel 

Introduction

This section gives a description of the setting cards and describes how to 
change the default settings for the copy jobs.

The copy settings

The copy settings are divided over the following four setting cards on the 
scanner operator panel:

1 The 'Original' card.
2 The 'Output' card.
3 The 'Layout' card
4 The 'Image' card.

[20] The Original card

[20] The Original card

[21] The Output card

[21] The Output card
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[22] The Layout card

[22] The Layout card

[23] The Image card

[23] The Image card

Use the settings on the 'Original' card for the following:
■ Define all the settings that deal with the original
■ Define the 'Input mode'. (see ‘Create and start a copy job’ on page 64)
■ Define the size of the original
■ Remove a leading strip
■ Select the area of the original that you can see on the output.

Use the settings on the 'Output' card for the following:
■ Define all the settings that deal with the output media
■ Define the output media
■ Define the media width.
■ Define the copy length
■ Add a leading strip
■ Add a trailing strip.

Use the settings on the 'Layout' card for the following:
■ Define all the settings that deal with the layout changes
■ Define the scale factor.
■ Define the horizontal and the vertical alignment.
■ Shift the image. 
■ Mirror the image.
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Use the settings on the 'Image' card for the following:
■ Define all the settings that deal with the image quality at the pixel level
■ Define the correct quality mode.
■ Define the correct color mode
■ Define the exposure of the light areas and the dark areas
■ Define the correct image type
■ Enable automatic background compensation
■ Enable inversion.

Note: The on-line help in the Océ Settings Editor gives a complete description 
of the different settings.

Before you begin

Define the default values of the settings in the Océ Settings Editor. See the 
on-line help in the Océ Settings Editor about how to define the default settings.

How to define the copy settings

1 On the home screen, press lower softkey for 'Entry to the copy settings' to enter 
the settings screen.

2 Select a card with the upper softkeys.
3 Change the settings with the lower softkeys.

4 Use the arrow keys to define the settings, or the options within the settings, that 
use a spin box. 
A number of settings have more options than the screen can display. A number 
of other settings have numeric values. Use the arrow keys to select the options 
the screen cannot display. Use the arrow keys or the numeric keys to enter the 
numeric settings.
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Create and start a copy job

Introduction

This section describes a general workflow for the copy jobs on the scanner. The 
Océ TCS400 scanner can do the following types of copy jobs.
■ Single sheet 
■ Set.

Make sure that you define the correct input mode on the scanner operator panel 
(see ‘The copy settings’).

How to create and start a single sheet job 

1 Place the original face down, center aligned along the measurement ruler. If 
you feed the original, keep the original in position until it is drawn into the 
scanner.

2 On the home screen, select the 'Entry to the copy settings'.
3 Define the job settings on the screen. Use the upper softkeys to select the 

setting card and use the lower softkeys to define the settings in the cards.
4 On the 'Input mode' section of the 'Original' card, select 'Single sheet'.
5 On the 'Media' section in the 'Output' card select the required media.
6 Use the numeric keys to define the number of copies.

If the 'Start' key is not pressed before the end of the 'Panel time-out', as defined 
in the Océ Settings Editor, all settings return to their default values.

7 Press the green 'Start' key to start the copy job.
Your original is fed into the scanner. The copying starts.
Note: Make sure you first define the settings before you feed the original.

8 When the original is held at the front side or the back side, use the release 
original key on the scanner operator panel to remove the original. (see ‘The 
scanner operator panel’ on page 32).
Note: Use the KO - Scanner - Settings - Original release mode setting in the 
Océ Settings Editor to define the 'Original release mode'. (see ‘Original 
release mode’ on page 157).

9 Use the home key to return to the home screen. (see ‘The scanner operator 
panel’ on page 32).
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How to create and start a set

1 Place the original face down, center aligned along the measurement ruler. If 
you feed the original, keep the original in position until it is pulled into the 
scanner.

2 Use the numeric keys to enter the number of copies.
3 On the home screen, select the 'Entry to the copy settings'.
4 Define the job settings on the screen. Use the upper softkeys to select the 

setting card, and the lower softkeys to define the settings in the cards.
5 On the 'Input mode' section of the 'Original' card, select 'Set'.
6 On the 'Media' section in the 'Output' card select the required media.
7 Press the green 'Start' key for each original of a set.

To close a set, press the 'Start' key without feeding an original.
Note: When 'Auto feed' is enabled on the 'System' screen, each original after 
the first original is automatically fed into the scanner. You must only press the 
'Start' key after the set is complete. Make sure you first define the settings 
before you feed the original.

8 When the original is held at the front side or the back side, use the release 
original key on the scanner operator panel to release the original. (see ‘The 
scanner operator panel’ on page 32).
Note: Use the KO - Scanner - Settings - Original release mode setting in the 
Océ Settings Editor to define the 'Original release mode'.

9 Use the home key to return to the home screen. (see ‘The scanner operator 
panel’ on page 32).
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Important copy settings

Define the size of the originals

Introduction

Define the size of the originals on the 'Original' card of the scanner operator 
panel.

The following settings are available:
■ 'Automatic'

The scanner detects the size of the original based on the width of the 
original. 

■ 'Standard width'
TThe scanner scans only the selected standard width.
This setting overrules the automatically detected width of the original.

■ 'Custom'
The width is the width selected in the 'Original custom width' setting and 
the length is equal to the length selected in the 'Original custom length' 
setting. 
Use this setting to scan only a part of the original.
The 'Area selection' is function is only available when you select 'Custom' 
as the original width.
This setting overrules the automatically detected width of the original.

Before you begin

Use the KO - System - Media - Paper series setting in the Océ Settings Editor 
to define the default paper range used when you select 'Standard' as the ' 
Original size method'.
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Define the original size

1 Select the 'Original' card with the upper softkeys.
2 Select the 'Original size method' setting with the softkey for 'Size'.
3 When you select 'Standard width' as the 'Original size method', use the softkey 

for 'Standard' to select the original standard size for the defined paper range. 
4 If you select 'Custom' as the 'Original size method', use the softkey for 'Custom' 

to select 'Custom width' or 'Custom length'.
5 Use the arrow keys to define the 'Custom length' and the 'Custom width'.

If you select 'Full length' as the 'Custom length', the complete length of the 
original is scanned.
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Define the area selection

When to do

The Océ TCS400 scanner has an option that allows you to select an area of the 
image on your original. 

You can use this setting when you only need to see a specific area of the image 
on the output. 

Before you begin

Use the 'Area selection' settings in the Océ Settings Editor to define the default 
values for the 'Area selection'.

Define the area selection

1 Select the 'Original' card with the upper softkeys.
2 Use the softkey for 'Size' to select 'Custom' as the 'Original size method'

Note: The 'Area selection' is only available when the 'Original size method' is 
set to 'Custom'.

3 Set the 'Custom Width' to the correct value for the original.
4 Set the 'Custom Length' to 'Full length'.
5 Press the softkey for 'Area selection' to enter the area selection screen.

The area selection screen appears. 
[24] The area selection screen

[24] The area selection screen
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6 Use the 'Selection type' setting to define the following 
■ 'Delete area'

Delete the selected area from your output.
The area is grayed out on the output.

■ 'Keep area'
Keep the selected area but delete the area that was not selected.
The complete image on the output is grayed out, except the selected area.

■ 'Off'
The 'Area selection' setting is not active.

7 Use the settings 'Horizontal offset' and 'Vertical offset' to define the location of 
the area.

8 Use the settings 'Width' and 'Length' to define the size of the area.
Note: Turn the original face up to measure the offset and the size of the area.

9 Use the softkey for 'Back' to return to the 'Original' card.
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Define the output settings

Introduction

Define the output settings for your copy output in the 'Output' card of the 
scanner operator panel.

You can define the following settings:
■ Media type
■ Media width
■ Cut length
■ Add strip.

Use this setting to add a strip to your output. A leading strip is added to the 
top of your output. A trailing strip is added to the bottom of your output.

Before you begin

Use the KO - System - Media - Paper series setting in the Océ Settings Editor 
to define the default paper range used in the 'Media size' setting.

Use the KO - Jobs - Copy - Template - Output card - Media setting in the 
Océ Settings Editor to define a default media type for your jobs.

Define the media type

1 Select the 'Output' card with the upper softkeys.
2 Select the 'Media type' setting with the softkey for 'Media type'.
3 Use the softkey for 'Media type' to select the media types available on the 

printer.
4 Use the spin box with the arrow keys to select a media type that is not available 

on the printer.
If you select a media type that is not available on the printer, the Océ System 
Control Panel and the printer operator panel display a media request.
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Define the media width

1 Select the 'Output' card with the upper softkeys
2 Select the 'Media width' setting with the softkey for 'Media width'.

Select one of the following:
■ 'Automatic'

The system selects an available media size based on the original width 
detected by the scanner and the scale factor. Use this setting for a minimum 
of loss of media.
The standard size includes the print margin. When the system detects an 
original width wider than the standard format size, the output is printed on 
the next larger media size. Adjust the print margin to change the standard 
format size. Use the  KO - Jobs - Print - Defaults - Print margin X setting 
in the Océ Settings Editor to adjust the print margin.

■ 'Roll width'
When the 'Scale' setting on the 'Layout' card is set to 'Automatic', 'Roll 
width' fits the image to the media roll selected in the 'Media' setting.

■ A DIN or ANSI size.
Use this setting to print the output on the selected media size. When the 
media size is not available, the printer shows a media request.

Note: Available are only those the media sizes in the paper series defined in the 
Océ Settings Editor. 

Define the cut length

1 Select the 'Output' card with the upper softkeys
2 Select the 'Cut length' setting with the softkey for 'Cut length'.

Select one of the following:
■ 'Synchro'

The length of the output is related to the length of the image.
Select 'Synchro' to prevent the loss of information.

■ 'Standard'
The length of the output corresponds to a standard DIN or ANSI format, 
depending on the media width.
You can select a standard cut length in landscape orientation or in portrait 
orientation.

■ Custom.
The length of the output is user-defined.
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Define the scale settings 

Introduction

Define the scale settings on the 'Layout' card of the scanner operator panel.

Define the scale settings

1 Select the 'Layout' card with the upper softkeys.
2 Select the 'Scale' setting with the softkey for 'Scale'.

Select one of the following:
■ 'Automatic'

The image is scaled automatically to fit exactly on the media width selected 
on the 'Output' card.

■ '1:1'
The image on the output has the exact size of the image on the original.

■ Custom.
You can define a scale factor in a range from 10% to 1000%.
When the result of the scale factor is larger than the output size, loss of 
information occurs.

Use the automatic scaling setting

1 Select 'Automatic' with the softkey for 'Scale' on the 'Layout 'card .
2 Define the width with the softkey for 'Media width' on the 'Output' card.

When the width is defined as 'Automatic', a '1:1' copy is made. 
When the width is defined as 'Roll width', the image fits exactly on the media 
roll selected on the 'Output' card.(see ‘Define the output settings’ on page 70).
When the width is defined as a standard size, the image on the output is printed 
in the standard size selected. For example, if the original size was A3 and the 
'Media width' selected was A1, the image on the output has an A1 size.
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Define the position of the image on the output

Introduction

Define the position of the image on the output in the 'Layout' card of the 
scanner operator panel.

Before you begin

The system calculates the position of the image on the output based on the 
media width selected on the 'Output' card. Before you define the position of the 
image on the output, first define the media width on the 'Output' card.
When you select 'Automatic' as the 'Media width', the system puts the image 
on the output based on the width detected by the scanner.
When you select 'Roll width' as the 'Media width', the system puts the image 
on the output based on the width of the selected media roll.
When you select a standard size as the 'Media width', the system puts the image 
on the output based on the selected standard size.
(see ‘Define the output settings’ on page 70)
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Define the position of the image on the output

1 Select the 'Layout' card with the upper softkeys.
2 Select the 'Horizontal align' setting with the softkey for 'Align'.

Use the arrow keys to select one of the following.
■ 'Right'

The image is put on the right margin.
■ 'Left'

The image is put on the left side margin.
■ 'Centre'.

The image is put in center of the output.

3 Select the 'Vertical align' with the softkey for 'Align'.
Use the arrow keys to select one of the following.
■ 'Top'

The image is put on the top of the output.
■ 'Bottom'

The image is put on the bottom of the output.
■ 'Centre'.

The image is put in the center of the output.

4 Select the 'Horizontal shift' setting with the softkey for 'Shift'.
■ A negative is a shift to the left
■ A positive value is a shift to the right.

5 Select the 'Vertical shift' setting with the softkey for 'Shift'.
■ A negative is a shift to the bottom
■ A positive value is a shift to the top.
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The settings that control the image quality 

Definition

Define the settings that control the image processing on the 'Image' card of 
scanner operator panel.

The settings for image quality

The selection of the media and the quality modes depends on the application 
of the output. (see ‘Recommended media types and quality modes’ on 
page 126)

Increase the dark exposure to increase the contrast.

Set the background compensation to 'Automatic' for all the jobs.
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Introduction to how to scan to file on the Océ TCS400

This chapter contains all the information you need to do scan-to-file jobs from 
the Océ TCS400 scanner. You can learn more about the following:
■ How to define the job settings
■ How to start a job.

The 'Important scan-to-file settings' section in this chapter describes the 
settings that control the file size and the image quality and the available file 
formats for scan to file.

Chapter 6, the 'Use Océ Scan Manager for your scan-to-file jobs' describes the 
software application that you need for your scan-to-file jobs.

Use the Océ Scan Manager for the following.
■ Create the destinations
■ Manage the destinations
■ View the scanned files
■ Print the scanned files.

The on-line help in the Océ Scan Manager gives full information about the 
different functions of the application.
The on-line help in the Océ Settings Editor gives full information about the 
different job and system settings.
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Use the Océ TCS400 scanner to scan to file

The scan-to-file settings on the scanner operator panel 

Definition

This section gives a description of the setting cards for the scan-to-file jobs.

The scan-to-file settings

The scan-to-file settings are divided over following 4 setting cards on the 
scanner operator panel.
■ The 'Original' card
■ The 'File' card
■ The 'Layout' card
■ The 'Image' card.
[25] The Original card

[25] The Original card

[26] The File card

[26] The File card
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[27] The Layout card

[27] The Layout card

[28] The Image card

[28] The Image card

Use the settings on the 'Original' card for the following:
■ Define all the settings that deal with the original
■ Define the size of the original
■ Remove a leading strip.

Use the settings on the 'File' card for the following.
■ Define all the settings that deal with the destination and file output
■ Select the destination for scan to file
■ Define the file format

(see ‘File formats for scan to file’ on page 91)
■ Define the file compression

(see ‘The settings that control the file size and the image quality’ on 
page 86)

■ Define the file organization for 'TIFF' files
(see ‘The settings that control the file size and the image quality’ on 
page 86)

Use the settings on the 'Layout' card for the following:
■ Define all the settings that deal with the layout changes
■ Define the scale factor
■ Mirror the image.
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Use the settings on the 'Image' card for the following:
■ Define all the settings that deal with the image quality at the pixel level
■ Define the file resolution

(see ‘The settings that control the file size and the image quality’ on 
page 86)

■ Define the color depth
(see ‘The settings that control the file size and the image quality’ on 
page 86)

■ Define the correct color mode
■ Define the exposure of the light areas and the dark areas
■ Define the correct image type
■ Enable automatic background compensation

Note: The on-line help in the 'Océ Settings Editor' gives a complete description 
of the different settings.
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Define the scan-to-file settings on the scanner operator panel 

Introduction

This section describes how to change the default settings for the scan-to-file 
jobs.

Before you begin

Define the default values of the settings in the Océ Settings Editor. See the 
on-line help in the Océ Settings Editor about how to define the default settings.

How to define the scan-to-file settings

1 On the home screen, press lower softkey for 'Entry to the scan-to-file settings' 
to enter the settings screen.

2 Select a card with the upper softkeys.
3 Change the settings with the lower softkeys.
4 Use the arrow keys to define the settings, or the options within the settings, that 

use a spin box.
A number of settings have more options than the screen can display. A number 
of other settings have numeric values. Use the arrow keys to select the options 
the screen cannot display. Use the arrow keys or the numeric keys to enter the 
numeric settings.
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Create and start a scan-to-file job

Introduction

This section describes a general workflow for the scan-to-file jobs.

How to create and start a scan-to-file job 

1 Place the original face down, center aligned along the measurement ruler. If 
you feed the original, keep the original in position until it is drawn into the 
scanner.

2 On the home screen, select the 'Entry to the scan-to-file settings'.
3 Define the job settings on the screen. Use the upper softkeys to select the 

setting card and use the lower softkeys to define the settings in the cards.
On the 'File' card select the following.
■ The destination for the file for the file in the 'Destination' section
■ The file format of the file in the 'File type' section
■ The file compression method for the selected file type in the 'Compression' 

section.
■ The file organization for TIFF files in the 'Organization' section.

On the 'Image' card select the following.
■ The color depth for the selected file type in the 'Colour depth' section
■ The resolution for the file in the 'Resolution' section.

Note: Make sure that the file properties you select are supported in your 
software environment.

4 Press the green 'Start' key to start the scan job.
Your original is fed into the scanner. The scanning starts.
Note: The 'Start' key only functions if you are in the job settings screen. If you 
are in the home screen or the 'System' screen, the 'Start' key does not function.
If the 'Start' key is not pressed before the end of the 'Panel time-out' all settings 
return to their default values. Define the 'Panel time-out' in the Océ Settings 
Editor.

5 When the original is held at the front side or the back side, use the release 
original key on the scanner operator panel to remove the original.(see ‘The 
scanner operator panel’ on page 32).
Note: Use the KO - Scanner - Settings - Original release mode setting in the 
Océ Settings Editor to define the 'Original release mode'. (see ‘Original 
release mode’ on page 157).

6 Use the home key to return to the home screen. (see ‘The scanner operator 
panel’ on page 32).
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Retrieve the scanned files from the controller

When to do

The following files are stored local on the controller
■ Files scanned to a local destination.
■ When you scan to a remote destination and an error occurs, the file is stored 

in the 'Unsent' folder on the controller.

The scanned files are also stored in the temporary store on the controller, 
regardless of the destination you define. 

Use File Transfer Protocol (FTP) to retrieve the files from the controller.

How to retrieve the scanned files from the controller

1 Launch an FTP client.
2 Enter the 'Open' command followed by the host name of the Océ Power Logic® 

controller or the IP address
Note: You can also enter ftp host_name in the FTP client.
Press Enter.

3

The connection with the Océ Power Logic® controller is established. 
A dialog box prompts you for a user name.

4 Enter the user name 'anonymous' with the password 'anonymous'.
Press Enter.

5 Enter 'bin' to set the transmission mode to binary.
6 Use the command 'cd tempstore' to go to the 'tempstore' directory.
7 Go to the 'scan' directory to retrieve a file from a destination local on the 

controller.
Go to the 'unsent' directory to retrieve a file from the 'Unsent' folder on the 
controller.

8 Use the 'get' command to retrieve the file. For example 'get floorplan.tif'
9 Use the 'bye' command to quit FTP.
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Important scan-to-file settings

Define the size of the originals

Introduction

The following settings are available:
■ 'Automatic'

The scanner detects the size of the original based on the width of the 
original.
This is the recommended setting.

■ 'Standard width'
The scanner scans only the selected standard width.
This setting overrules the automatically detected width of the original.

■ 'Custom'
The width is the width selected in the 'Original custom width' setting and 
the length is equal to the length selected in the 'Original custom length' 
setting. 

Before you begin

Use the KO - System - Media - Paper series setting in the Océ Settings Editor 
to define the default paper range used when you select 'Standard' as the ' 
Original size method'.

Define the original size

1 Select the 'Original' card with the upper softkeys.
2 Select the 'Original size method' setting with the softkey for 'Size'.
3 When you select 'Standard width' as the 'Original size method', use the softkey 

for 'Standard' to select the original standard size for the defined paper range. 
4 If you select 'Custom' as the 'Original size method', use the softkey for 'Custom' 

to select 'Custom width' or 'Custom length'.
5 Use the arrow keys to define the 'Custom length' and the 'Custom width'.

If you select 'Full length' as the 'Custom length', the complete length of the 
original is scanned.
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The settings that control the file size and the image quality

Introduction

A number of settings control the size of the file and the quality of the image. 
The better the quality of the image, the larger the file size. The settings that 
control the size of the file and the quality of the image are interdependent. The 
definition of one settings influences the options you have for another setting.

This section describes the following:
■ the settings that control the size of the file and the quality of the image
■ the dependencies of the settings.
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File size and image quality
[5] The settings that control the file size and the image quality

[5] The settings that control the file size and the image quality

The setting on the 
scanner operator 
panel

Location of the setting 
in the Océ Settings Ed-
itor

Explanation

'File format' on the 
'Original' card

Path: KO - Jobs - Scan 
to file - Defaults - File - 
File format

Use this setting to define 
the file type of the 
scanned files.

'File compression' on 
the 'File' card

Path: KO - Jobs - Scan 
to file - Defaults - File - 
... compression

Use this setting to define 
the compression method 
for the files

'TIFF organization' 
on the 'File' card

Path: KO - Jobs - Scan 
to file - Defaults - File - 
TIFF organization

Use this setting to define 
the internal organization 
of TIFF files.

'File resolution 'on 
the 'Image' card

Path: KO - Jobs - Scan 
to file - Defaults - Im-
age - File resolution

Use this setting to define 
the resolution of the 
scanned images

'Colour depth' on the 
'Image' card

Path: KO - Jobs - Scan 
to file- Defaults - Image 
- color depth ...

Use this setting to define 
the number of bits color 
information per pixel
Use this setting to define 
the color of the output.
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[6] The effect of the sett ings on the file size and the image quality

The setting on the 
scanner operator 
panel

Effect on the file size Effect on the image 
quality

'File format' (see ‘File formats for scan to 
file’ on page 91)

'TIFF' and 'PDF' are 
file formats with op-
timal image quality 

'File compression' A higher compression factor 
results in a smaller file size.
The highest available com-
pression factor for 'TIFF' files 
is 'Packbits'. 
The highest available com-
pression factor for 'PDF' files 
is 'Flate'.
Note: 'Group 3 ' and 'Group 
4' are the compression 
methods which are best for 
text and vector drawings. If 
you select 'Group 3 ' or 
'Group 4' to scan a photo, 
this compression method can 
cause the file size to increase 
instead of decrease.
'Flate' can take longer to 
process.

The file compression 
methods available on 
the Océ TCS400 do 
not control the quali-
ty of the image.
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[6] The effect of the settings on the file size and the image quality

'TIFF organization' ■ 'Raw'
This file organization type 
method gives the best 
print performance.

■ 'Stripped'
This file organization type 
is a compromise between 
print performance and 
view performance. 

■ 'Tiled' .
This file organization type 
gives the best view 
performance.

Note: 'Raw' has the best 
compatibility with old 
drawing programs.

N/A

'File resolution ' A higher resolution results in 
a larger file size.

A higher resolution 
results in a higher 
image quality

'color depth' A higher number of bits 
per pixel makes more 
color possible.

■ 1 bit makes only black and 
white images possible

■ 8 bits makes grayscale 
images possible

■ 24 bits makes true color 
possible

A higher number of bits per 
pixel results in a larger file 
size.

The options depend 
on the file format 
you selected. See the 
table below.

The setting on the 
scanner operator 
panel

Effect on the file size Effect on the image 
quality
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The dependencies of the settings
[7] The dependencies of the settings

[7] The dependencies of the settings

Note: The section 'File formats for scan to file' contains information about the 
available file formats. (see ‘File formats for scan to file’ on page 91)

Available file formats Available file compres-
sion methods

Available color depths

TIFF
File organization

■ Raw
■ Stripped
■ Tiled

None (uncompressed) Black & white, 1 bit per 
pixel

Grayscale, 8 bits per 
pixel

RGB, 24 bits per pixel

Group 3 2D Black & white, 1 bit per 
pixel

Group 4 Black & white, 1 bit per 
pixel

Packbits Black & white, 1 bit per 
pixel

Grayscale, 8 bits per 
pixel

RGB, 24 bits per pixel

CALS-I Group 4 Black & white, 1 bit per 
pixel

PDF Group 4 Black & white, 1 bit per 
pixel

Flate Black & white, 1 bit per 
pixel

Grayscale, 8 bits per 
pixel

RGB, 24 bits per pixel
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File formats for scan to file

Introduction

The Océ TCS400 supports the following file formats for scan to file.
■ 'TIFF 6.0'
■ 'PDF 1.3'
■ 'CALS-I'.

The format you select depends on the function of the file.
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Explanation of the TIFF file format

General explanation When to use the file 
format

File organization

'TIFF' means Tagged 
Image File Format.

Versatility and compati-
bility make the 'TIFF' 
format a widely used 
format. You can use the 
TIFF format on both the 
Mac and PC platforms. 
The 'TIFF' format sup-
ports a wide range of 
picture bit depth, and al-
lows a many forms of 
compression.
You can use TIFF files 
in most graphic applica-
tions.

The data can be 
stored in a 'TIFF' file 
in the following 
ways

■ 'Raw'
This file 
organization type 
does not break the 
image into parts.

■ 'Strips'
The 'TIFF' method of 
breaking the image 
into strips is 
acceptable for 
low-resolution and 
medium-resolution 
images. 

■ 'Tiles'.
You can access the 
high-resolution 
images more 
efficiently if the 
image is broken into 
square tiles instead 
of the horizontally 
wide, but vertically 
narrow strips.
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Explanation of the PDF file format

Explanation of the CALS-I file format

General expla-
nation

When to use the 
file format

File size File organiza-
tion

'PDF' means Por-
table Document 
Format

'PDF' enables 
you to reproduce 
the documents 
exactly like they 
appeared in the 
original develop-
ment application.
You must use 
Adobe® Acro-
bat® or Adobe® 
Illustrator® ap-
plications to 
open the PDF 
files.

A feature of the 
'PDF' file format 
is its ability to 
describe com-
plex pages and 
documents while 
maintaining rela-
tively small file 
sizes.

The 'PDF' files 
can have differ-
ent compression 
methods

General explanation When to use the file 
format

File organization

'CALS' means Comput-
er-aided Acquisition 
and Logistics Support 
and is a USA military 
standard.

'CALS' files are intend-
ed for document imag-
ing.

Monochrome,1-bit im-
age data only.
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Define the scale settings

Introduction

Define the scale settings on the 'Layout' card of the scanner operator panel.

Define the scale settings

1 Select the 'Layout' card with the upper softkeys.
2 Select the 'Scale' setting with the softkey for 'Scale'.

Select one of the following:
■ 'Automatic'

The image is scaled automatically to fit exactly on the media width selected 
on the 'Output' card.

■ '1:1'
The image on the output has the exact size of the image on the original.

■ Custom.
You can define a scale factor in a range from 10% to 1000%.
When the result of the scale factor is larger than the output size, loss of 
information occurs.

Use the automatic scaling setting

1 Select 'Automatic' with the softkey for 'Scale' on the 'Layout 'card .
2 Select a standard size with the softkey for 'Size' on the 'Layout' card.
3 The image scales to the output size you selected. For example, if the original 

size was A3 and the output size selected was A1, the image on the output has 
a A1 size.
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Chapter 7 
Use Océ Scan Manager for your 
scan-to-file jobs
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Introduction to the Océ Power Logic® controller: Océ Scan 
Manager

Introduction

This chapter describes how to use the Océ Scan Manager for your scan-to-file 
jobs.

Access the Océ Scan Manager local on the controller. You must have a 
keyboard, mouse and monitor with your Océ Power Logic® controller to use 
the Océ Scan Manager.

See 'Océ Power Logic® controller: Océ Settings Editor' for information about 
how to start the application locally on the controller. (see ‘Start the Océ Power 
Logic® controller applications’ on page 220).

Description of the Océ Scan Manager

The Océ Scan Manager allows you to do the following.
■ Create the destinations for scan-to-file
■ Define the file names
■ Print scanned files
■ Retrieve scanned files.

Océ View Station LT

Océ View Station LT is an application that runs with Océ Scan Manager. Océ 
View Station LT enables you to view the scanned file.

When 'Auto view' is enabled, Océ View Station LT starts automatically to 
display the scanned file when the scan to file is complete. (see ‘Manage the 
scanned files’ on page 107).

User modes

Only the key operator and the service operator are allowed to make changes in 
Océ Scan Manager.
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Overview of the Océ Scan Manager

Introduction

This section contains an overview of the Océ Scan Manager application. Use 
the Océ Scan Manager for scan to file.

The structure of the Océ Scan Manager

The Océ Scan Manager has the following fields.
■ The menu bar
■ The top tool bar
■ The destination area
■ The scanned files area
■ The status bar.
[29] The Océ Scan Manager

[29] The Océ Scan Manager
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The menu bar
[8] The menu bar items

[8] The menu bar items

Component Function

'File' ■ When no objects are selected, you can do the 
following from the 'File' menu.

■ Log on to a user mode
■ Log off from the previous user mode.

When a destination is selected, you can do the 
following from the 'File' menu.

■ Add a new destination
■ Delete the selected destination
■ View the properties of the selected destination
■ Open the destination
■ Save the destination.

When a file is selected, the 'File' menu includes the 
following items.

■ View the properties of the selected file
■ Delete the selected file
■ Print the selected file
■ View the selected file.

'Edit' ■ Use 'Automatic logon', to start the Océ Scan Manager 
application automatically in the defined user mode.

'View' ■ Toggle between the display languages
■ Refresh the list of files.

'System' ■ Clear the temporary store
■ Use 'Auto view' to enable or disable the automatic 

view of the scan file.

'Help' ■ Access the contents of the on-line help
■ Get more information about the copyright and the 

version of the application.
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The tool bar
[9] The buttons of the toolbar

[9] The buttons of the toolbar

The destination area
[10] The parts of the destination area

[10] The parts of the destination area

The scanned files area

The scanned files area shows the files scanned to the destination selected in the 
destination area.
The scanned files that are scanned last, are shown on the bottom of the list.
When you cannot see the files that are scanned last, use the 'Refresh' button on 
the toolbar to update the view or select 'Refresh' in the 'View ' menu.

[30] The Refresh button on the toolbar

[30] The Refresh button on the toolbar

Component Function

'New' Create a destination

'Delete' Delete a destination

'View' View the scanned file

'Refresh' Update the screen.

'Print' Print a scanned file.

Component Function

The tree struc-
ture (left-hand 
pane of the main 
window)

Displays the following.
■ The destinations
■ The temporary store
■ The 'Unsent' folder.

The destination 
area (right-hand 
pane of the main 
window) 

Displays the following.
■ The file name
■ The file type
■ The file resolution
■ The file size
■ The pixel size of the image
■ The original size.
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The following information is shown for each file.
■ The file name
■ The file size
■ When the file was last modified
■ The resolution of the file
■ The size of the image in the file.

The status bar

The status bar of Océ Scan Manager displays the following information.
■ The system status (connected, disconnected)
■ The system to which Océ Scan Manager is connected
■ The scan clicks (indicates the area that is scanned)
■ A message field
■ The user mode.

Icon Description

Océ Scan Manager is connected to a system.

Océ Scan Manager is not connected to a system.
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Use the Océ Scan Manager

Create destinations

Introduction

You can scan to file to the following types of destination.
■ Local

The local destinations are temporary and can only contain a small number 
of scanned files. Use the SA - System - Set memory reservation setting in 
the Océ Settings Editor to define the available space on the controller for 
scanned files.

■ A network destination with SMB
■ An internet destination with FTP.

You can create a maximum number of 10 destinations.

Note: You can only enter names in Japanese for remote destinations in SMB.

Create a local destination

1 Select 'Destinations' in the tree structure.
2 From the 'File' menu, select 'New'.

You can also click the 'New' button on the toolbar.
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The 'Destination properties' dialog box opens.
[31] The Destination properties dialog box

[31] The Destination properties dialog box

3 Enter a name for the destination in the 'Name' text box.
This name will appear on the scanner panel.

4 From the 'Type' drop-down list box, select 'On the controller'.
5 Enter a path of the target folder in the 'Path' text box. 

You can also click the 'Browse' button to select the path.
6 Click 'OK' to accept the destination properties.

Create a network destination with SMB

1 Create a shared folder on a workstation. For example c:\Scan.
2 From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialog box opens.

3 From the 'Type' drop-down list box, select 'SMB'.
4 Enter the system name of the workstation where you created the shared folder 

in the 'System' text box.
Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


Use Océ Scan Manager for your scan-to-file jobs 103

5 Enter a path of the target folder in the 'Path' text box.
The path name is the name of the shared folder on your workstation. For 
Windows NT® , Windows® 2000 and XP, use the DOS name of the shared 
folder. For Windows 95/98® use the folder name. This is case sensitive.
You can also select a shared folder from the drop-down list.

6 If you defined a user name and a password for the shared folder on the 
workstation, then enter the user name and the password in the required fields.
Note: Make sure the user has write-access privileges on the destination.

7 Define the required file naming properties.
8 Click 'OK'.

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
then shows the contents of the new SMB destination.

Create an internet destination with FTP

1 Create a home directory and a subdirectory on a workstation. For example 
c:Ftp/Scan

2 Enable FTP on the workstation.
3 From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialog box opens.

4 From the 'Type' drop-down list box, select 'FTP'.
5 Enter the system name of the workstation where you created the shared folder 

in the 'System' text box.
Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6 Enter a path of the target folder in the 'Path' text box.
The path name is the name of the destination folder on the workstation.

7 A user name and password is defined on the FTP server that runs on the 
workstation to access to the directory on the workstation through FTP. Enter 
this user name and this password in the required fields on the Destination 
Properties dialog box of the Océ Scan Manager.
Note: Make sure the user has write-access privileges on the destination.

8 Define the required file naming properties.
9 Click 'OK'.

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
then shows the contents of the new FTP destination.
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Manage destinations

Introduction

You can do the following to manage the destinations.
■ Lock a destination.
■ Unlock a destination
■ Delete a destination
■ Change the destination properties.

Purpose

When you lock a destination, an anonymous user cannot change the 
destination properties.

Lock or unlock a destination

1 Select a destination.
2 From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3 Check the 'Locked' check box.

Uncheck the 'Locked' check box to unlock the destination.
4 Click 'OK' to accept the destination properties

Delete a destination

1 Log on to the key operator mode or the repro operator mode.
2 Select a destination.
3 From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
The selected destination is deleted.

Note: You cannot delete the last destination.
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Change the destination properties

1 Select a destination.
2 From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3 Change the destination properties like described in the 'Create destinations' 

section. (see ‘Create destinations’ on page 101)
Note: When the destination is locked, anonymous users cannot change the 
destination properties.
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Define a file name

When to do

When you scan, the scanner operator panel shows the file name. 
Before a new scan-to-file job, enter a new file name or replace the file name 
with ###.
When the file name is not changed, the new scan-to-file job writes over the 
previous scan-to-file job.

Define a file name

1 Select a destination.
2 From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3 Enter a name in the 'Base name' text box.

The 'Base name' can contain '###' for automatic file naming. An ascending 
number replaces the '###'. There are no limits to the number of dots in the base 
name.

4 Select the check box 'Add correct file extension' to define a file extension. Use 
the setting KO - System - Scan to file - File extension ... in the Océ Settings 
Editor to define a file extension.

5 Click 'Apply' or press 'Enter' to accept the settings.
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Manage the scanned files

Introduction

The right-hand pane of the destination area displays information about the 
scanned files.

You can do the following to manage the scanned files.
■ View a scanned file''

When 'Auto view' is enabled, Océ View Station LT starts automatically to 
display the scanned file when the scan to file is complete.

■ Print a scanned file
■ Delete a scanned file
■ View the properties of a scanned file.

View a scanned file

1 Select a file.
2 From the 'File' menu, select 'View'.

You can also click the 'View' button on the toolbar.
[32] The View button on the toolbar

[32] The View button on the toolbar

Océ View Station LT starts and displays the file

Enable Auto view

1 From the 'System' menu, select 'Auto view'.
A check mark in the menu in front of 'Auto view' indicates that 'Auto view' is 
enabled. 

Print a scanned file

1 Select a file.
2 From the 'File' menu, select 'Print'.

You can also click the 'Print' button on the toolbar.
[33] The Print button on the toolbar

[33] The Print button on the toolbar

The system prints the selected file with the default settings defined in the Océ 
Settings Editor.
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Delete a scanned file

1 Log on to the key operator mode or the repro operator mode.
2 Select a file.
3 From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
[34] The Delete button on the toolbar

[34] The Delete button on the toolbar

The system deletes the selected file.

Clear the temporary store

1 From 'System' menu, select 'Clear temporary store' or, 
2 Use the settings Path: KO - System - Disk cleanup - ... - ... in the Océ Settings 

Editor to clear the temporary store automatically.

View the properties of a scanned file

1 Select a file.
2 From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
[35] The Properties button on the toolbar

[35] The Properties button on the toolbar
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3 The 'Scanfile properties' window appears.
[36] The Scanfile properties window

[36] The Scanfile properties window

4 Click 'OK' to close the 'Scanfile properties' window.

Océ View Station LT

Introduction to Océ View Station LT

Description of Océ View Station LT

Océ View Station LT is a viewer included in Océ Scan Manager. Océ View 
Station LT displays the scanned files.

When 'Auto view' is enabled, Océ View Station LT starts automatically to 
display the scanned file when the scan to file is complete. You can also start 
Océ View Station LT manually. (see ‘View a scanned file’)
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Overview of Océ View Station LT

Introduction

Océ View Station LT has the following fields.
■ The menu bar
■ The view ribbon
■ The view area.
[37] Océ View Station LT

[37] Océ View Station LT
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The menu bar

■ The menu bar has the following menu's.
■ 'File'
■ 'View'
■ 'Preference'
■ 'Help'.
[11] The File menu

[11] The File menu

[12] The View menu

Item Function

'Close' Close the active document.

'Properties' Open the properties dialog box of the document. The 
properties dialog box enables you to change some prop-
erties of the document.

Item Function

'Fit' Scale the image to fill the window.

'1:1' Show the image at a 1:1 scale factor.

'Magnify' Zoom into the page.

'Reduce' Zoom out of the page.

'Refresh' Refresh the view of all the windows that show the active 
document.

'Invert' Reverse the black and white parts of the image.

'Mirror' Mirror the image.

'Rotate 90 CCW' Rotate the image 90 degrees counter-clockwise (to the 
left).

'Rotate 90 CW' Rotate the image 90 degrees counter-clockwise (to the 
right).

'Rotate 180' Rotate the image 180 degrees.

'Sample' When active, 'Sample' shows only a sample of bilevel 
raster pixels.

'Negate' Reverse the showed raster image pixels. Change the 
dominant raster image pixels for scaling.
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[12] The View menu

[13] The Preference menu

[13] The Preference menu

[14] the Help menu

[14] the Help menu

'Scale to gray' When active, 'Scale to gray' shows the active bilevel ras-
ter image as a grayscale image.

'Monochrome' Show an image or screen with only background and fore-
ground colors, like black-and-white or bilevel.

Item Function

'View ribbon' Show the view ribbon. The view ribbon provides easy 
access to some 'File', 'View', and 'Preference' menu 
items. See the 'View ribbon' section below.

'Status bar' Shows the status bar at the bottom of the Océ View Sta-
tion LT window. The Status Bar shows the pointer co-or-
dinates and a status line.

'Reference' Show the 'Reference' window. The 'Reference' window is 
a small, normally floating window. The 'Reference' win-
dow shows the complete current page in miniature. The 
crossed box in the 'Reference' window indicates the part 
of the page showed in the document window. Move or 
change the size of the crossed box to change the area of 
the page showed.

'Detail' Shows the 'Detail' window.

'Measurement' Enables you to measure the lines and the areas on the im-
age.

Item Function

'About' Show information about Océ View Station LT.

Item Function
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The view ribbon
[15] The View ribbon

[15] The View ribbon

Button Function

Reverse the black and white parts of the image.

Scale the image to fill the window.

Show the image at a 1:1 scale factor.

Zoom into the page.

Zoom out of the page.

Mirror the image.

Rotate the image 90 degrees counter-clockwise (to the 
left).

Rotate the image 90 degrees counter-clockwise (to the 
right).

Rotate the image 180 degrees.

Enables you to measure the lines and the areas on the im-
age.

how the 'Reference' window. The 'Reference' window is 
a small, normally floating window. The 'Reference' win-
dow shows the complete current page in miniature. The 
crossed box in the 'Reference' window indicates the part 
of the page showed in the document window. Move or 
change the size of the crossed box to change the area of 
the page showed.

Shows the 'Detail' window.
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The view area

The view area shows the scanned file.

When the memory is almost full, the viewer cannot show the scanned file. 
Then, the viewer shows a red border with a red cross.

[38] An error view in Océ View Station LT

[38] An error view in Océ View Station LT

Use your right mouse button to click on the file shown in the view area. You 
can select the following menu items from the pop-up menu.
■ 'Zoom ±'
■ 'Pan' (Hand tool)
■ 'Fit'
■ 'Magnify'
■ 'Reduce'
■ 'Invert'
■ 'Rotate 90 CCW'
■ 'Rotate 90 CW'
■ 'Rotate 180'.
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Introduction to how to ensure the best quality output

Introduction

This chapter describes how to make sure you have the best quality for your 
print jobs, scan-to-file jobs and copy jobs.
It is important to know that the quality of your copy output depends on both 
the scan quality of the scanner and the print quality of the printer.

■ The Océ TCS400 offers several methods that help you to define the best 
print mode for your job. These methods are described in the 'Output modes' 
section of this chapter.

■ The Océ TCS400 has 3 methods that help you to identify and analyze 
changes in the output quality, the 'Quality check' print, the 'Tone scale area 
check' print, and the 'Demo print'. The 'Check the output quality' section of 
this chapter describes these 3 methods. 

■ When you find problems with the output quality, the 'Optimize the output 
quality' section of this chapter helps you to correct the problems. (see ‘Use 
the Optimize print quality wizard’ on page 141).

Remember that the output quality depends on the following:
■ Media type 

(see ‘Change the type of media defined on the printer’ on page 164)
■ Output mode

(see ‘Introduction to the output modes’ on page 118)
■ Room temperature and humidity.

When to do

Only perform actions to optimize the output quality based on the information 
supplied in the 'Check the output quality ' section. 
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When you are not satisfied with the output quality, use the following procedure

1 First, make sure that you load and define the correct media type on the printer.
Use the 'Change media type' wizard to load a media roll and to change the 
media type defined on the system. (see ‘Change the type of media defined on 
the printer’ on page 164).
Then, make sure you define the correct media type for your job.
The following problems are never connected to media: Ignore the above steps 
for these problems and directly continue with step 3.
■ The length and width measurements are different from the original
■ The colored lines are not well aligned
■ Missing sections in lines or stepped lines
■ Missing parts of text
■ Drop-out caused by nozzle problems.

2 Make sure you defined the correct output mode for your job. (see 
‘Introduction to the output modes’ on page 118).
Note: The output modes for the print jobs match the output modes for the copy 
jobs with the exception of the modes related to file content. (see ‘Introduction 
to the output modes’ on page 118).

3 Finally, if you have defined the correct media and the correct print mode, and 
you are still not satisfied with the output quality, use the wizards to achieve 
optimal output quality. (see ‘Optimize the output quality on the printer’ on 
page 137) and (see ‘Optimize the output quality from the scanner’ on 
page 144)
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Output modes

Introduction to the output modes

Introduction

The Océ TCS400 enables you to select the correct mode for your output 
requirements. You can select the following modes:
■ Modes related to color
■ Modes related to the output quality
■ Modes related to file content 
■ Modes related to image type.

When you perform print jobs, define the required output modes in the printer 
driver.
When you do copy jobs, define the required output modes on the 'Image' card 
on the scanner operator panel.

Define the default output modes in the Océ Settings Editor.

Modes related to color

Use this setting to define the color mode of the Océ TCS400. You can select 
the following:

[16] The color modes

[16] The color modes

Color mode Function

'Color' The Océ TCS400 prints the jobs in full color.
Use this setting when the image on the original is in color 
and the printed output requirement is color.

'Grayscale' The Océ TCS400 prints the jobs in grayscale.
Use this setting when the image on the original is in color 
and the printed output requirement is greyscale.
Use this setting when the image on the original is grey-
scale.
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Modes related to the output quality

Use these modes to define the output quality. You can select the following:

[17] The output quality

[17] The output quality

Quality mode Function

'Check' The print speed is very high. The output quality is good.
Use this setting when output quality is not the most im-
portant. For example, to check if all the information is 
visible on the printed output.

'Release' The print speed is high. The output quality is very good.
This quality mode offers a good combination of output 
quality and productivity. Use this setting to print good 
quality drawings at high speed. For example, to approve 
bid-sets or for internal releases of drawings.

'Presentation' The print speed is moderate. The output quality is opti-
mal.
Use this setting when you need the best possible output 
quality. For example, to present drawings to the custom-
ers.
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Modes related to file content for the print jobs

Use the content modes to define the best output quality for your original file.

[18] Content modes (print jobs)

[18] Content modes (print jobs)

Content mode Function

'Area fills' When you select the 'Area fills' mode, the printer does 
ink reduction corrections. The ink reduction corrections 
prevent ink saturation that can cause the cockling of the 
media.
When you select the 'Area fills' mode, the printer prints 
vivid colors. The 'Area fills' mode is the best mode for 
files that contain filled areas. For example GIS files.

'Lines/Text' When you select the 'Lines & Text' mode, the printer 
does not do ink reduction corrections. When you print 
files that contain filled areas in the 'Lines & Text' mode, 
ink saturation can occur. Ink saturation can cause the 
cockling of the media.
The 'Lines & Text' mode is a fast and productive mode. 
The 'Lines & Text' mode is the best mode for files that 
contain line drawings and text. For example 2D CAD 
drawings
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Modes related to the image type for the copy jobs

Use the image types to define the best copy quality for your original file.
The available image types depend on the selected color mode. The two tables 
below show the image types for 'Grayscale' and 'Color' copies in the sequence 
given.

[19] Image types for copy output in greyscale

[19] Image types for copy output in greyscale

[20] Image types for copy output with color

Image type Function

'Line art' This is a fast and productive mode. 
The 'Line art' mode is the best mode 
for files that contain line drawings 
and text. For example CAD draw-
ings.

'Photo' The system optimizes for filled ar-
eas.

'Dark original' The system optimizes for originals 
with a dark media background. An 
image drawn on dark colored media 
is displayed sharp on the output.

'Blueprint' The output of a negative image is 
positive, and the output of a positive 
image is negative.

Image type Function

'Line art' This is a fast and productive mode. 
The 'Line art' mode is the best mode 
for files that contain line drawings 
and text. For example CAD drawings 
and aged archives.

'Photo' The system produces optimal color 
rendering. The 'Photo' mode is the 
best mode for files that require high 
quality color. The 'Photo' mode is the 
best mode for originals with a large 
color range. For example, high gloss 
photo's.
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[20] Image types for copy output with color

'Map' The system optimizes for filled areas 
and small detailed information. The 
'Maps' mode is the best mode for GIS 
files, magazines, and newsletters.

'Artwork' The system optimizes for filled areas 
and produces optimal color fastness. 
The media background of the image 
is optimal on the output. The 'Maps' 
mode is the best mode for inkjet, 
past-ups, artist impressions, and 
drawings with photo's.

Image type Function
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Output quality and print speed

Introduction

The quality of your printed output and the print speed depend on the following 
parameters.
■ The media type
■ The color mode
■ The content mode for the print jobs
■ The image type for the copy jobs
■ The output quality mode.

The following determines the actual quality of your printed output.
■ The print speed.

The lower the print speed, the better the output quality.
■ The scan speed for the copy jobs and the scan-to-file jobs.

A lower scan speed results in a better output quality.

The following table describes the relation between the output quality and the 
media type:
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The relation between the output quality and the media types
[21] The relation between the output quality and the media types

Content 
mode (print 
jobs)

Image type 
(copy jobs)

Quality 
mode

Color mode Print speed 
(A0 not in-
cluding the 
drying time 
and the pro-
cessing time)

'Lines & 
Text'

'Line art'
'Dark origi-
nal'
'Blueprint'

'Check' 'Grayscale' All media: 
1'10"

'Lines & 
Text'

'Line art'
'Dark origi-
nal'
'Blueprint'

'Release' All media: 
3'30"

'Lines & 
Text'

'Line art'
'Dark origi-
nal'
'Blueprint'

'Presentation' All media: 
7'00"

'Area fills' 'Photo' 'Check' All media: 
1'10"

'Area fills' 'Photo' 'Release' All media: 
7'00"

'Area fills' 'Photo' 'Presentation' All media: 
11'45"
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[21] The relation between the output quality and the media types

'Lines & 
Text'

'Line art'
'Maps'

'Check' 'Color' All media: 
2'20"

'Lines & 
Text'

'Line art'
'Maps'

'Release' Uncoated 
media: 4'20"
Coated me-
dia, Film and 
photo paper: 
9'35"

'Lines & 
Text'

'Line art'
'Maps'

'Presentation' Uncoated 
media: 9'35"
Coated me-
dia, Film and 
photo paper: 
12'00"

'Area fills' 'Photo'
'Artwork'

'Check' All media: 
9'35"

'Area fills' 'Photo'
'Artwork'

'Release' Uncoated 
media: 6'40"
Coated me-
dia: 11'45"
Film and 
photo paper: 
12'00"

'Area fills' 'Photo'
'Artwork'

'Presentation' Uncoated 
media: 
12'00"
Coated me-
dia: 23'30"
Film and 
photo paper: 
23'30"

Content 
mode (print 
jobs)

Image type 
(copy jobs)

Quality 
mode

Color mode Print speed 
(A0 not in-
cluding the 
drying time 
and the pro-
cessing time)
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Recommended media types and quality modes

Introduction

The selection of the media and the quality modes depends on the application 
of the output. The tables give you an idea of which media type and quality 
modes to use in a work process.
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CAD drawings - Grayscale
[22] CAD drawings - Grayscale

[22] CAD drawings - Grayscale

When to use Recommended media type Recommended Quali-
ty mode

To check a draw-
ing

Draft paper
Standard paper
Tracing paper
Bond
Translucent bond

'Check'
'Release'

To release a draw-
ing

Draft paper
Standard paper
Tracing paper
Premium coated paper
Matte film
Bond
Translucent bond
Deluxe bond

'Release'

To present a 
drawing

Draft paper
Standard paper
Tracing paper
Premium coated paper
Matte film
Bond
Translucent bond 
Deluxe bond

'Presentation'

To archive a 
drawing

Matte film
Color vellum

'Release'
'Presentation'

Diazo Tracing paper
Matte film
Translucent bond
Color vellum

'Release'
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CAD and GIS drawings - color
[23] CAD and GIS drawings - color

[23] CAD and GIS drawings - color

CAD and GIS drawings - color (high density)
[24] CAD and GIS drawings - color (high density)

[24] CAD and GIS drawings - color (high density)

When to use Recommended media type Recommended quali-
ty mode

To check a draw-
ing

Draft paper
Standard paper
Tracing paper
Bond
Translucent bond 

'Check'

To release a draw-
ing

Draft paper
Standard paper
Premium coated paper
Matte film
Bond
Deluxe bond

'Release'

To present a draw-
ing

Draft paper
Standard paper
Premium coated paper
Matte film
Bond
Coated bond

'Presentation'

To archive a draw-
ing

Matte film 'Release'
'Presentation'

When to use Recommended media type Recommended quali-
ty mode

To release a draw-
ing

Premium coated paper
High gloss photo paper

'Release'

To present a draw-
ing

Premium coated paper
High gloss photo paper

'Release'
'Presentation'
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Check the quality of the printed output 

Quality check print

Introduction

The Océ TCS400 offers two possibilities to check the quality of your printed 
output.
■ Make a quality check print
■ Make a tone scale area print
■ Make a demo print.

This section describes the problems you can analyze by making a quality check 
print or demo print. The 'Optimize print quality' section describes how you can 
solve problems with the quality (see ‘Use the Optimize print quality wizard’ 
on page 141).

How to make a quality check print

The system prints the 'Quality check' print in the 'Presentation' quality mode 
and the 'Lines & Text' content mode. The system uses a minimum of media for 
the 'Quality check' print. We recommend you use Premium coated paper for the 
'Quality check' print. 

Do the following to make a quality check print.
1 Scroll to the 'System information' card on the on-line screen of the printer 

operator panel.
2 Use the lower softkey for 'Demo prints' to enter the menu.
3 Use the lower softkey to select 'Quality check'. 

Check the output for the problems with the quality described below.

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


130 Océ TCS400 User manual

How to analyze the quality check print

The 'Quality check' print option is a quick method to help you find the cause 
of an unsatisfactory output quality. The 'Quality check' print option is 
especially useful to check the quality of printed lines.
Use the 'Quality check' print option on the printer operator panel to trace the 
following problems:

[25] Description of output quality problems

Graphical representa-
tion of the problem

Problem Description

Not available The color of one area 
runs into the color of 
another area

Check if the color of one 
area runs into the color of 
another area. The media 
type influences the image 
quality. The bleeding test 
consists of black and yel-
low areas with white lines 
in between. If you use Pre-
mium Grade paper, a 
0.008 inch line must be 
visible.

Not available The color of one line 
runs into the color of 
another line

Check that the lines or the 
white space between the 
lines are visible.

White stripes in filled 
areas

Check for white stripes in 
filled areas. White stripes 
are not acceptable.

Not available The output color is 
not the same as the 
original color

Make sure you define the 
correct software settings 
like the correct pen set-
tings.

Not available The length and width 
measurements are 
different from the 
original

Check that the frame of 
the quality check print is 
exactly the size of an 
8.5x11". 

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


Ensure the best quality output 131

[25] Description of output quality problems

Not available The colored lines are 
not well aligned or 
blurred

The horizontal and verti-
cal registration of the col-
ored lines. Check to 
ensure that the colored 
lines are well aligned and 
sharp.

Missing sections in 
lines or stepped lines

Check for the quality of 
lines. Two patterns to 
show the line quality, cir-
cles and 45° lines.

Missing parts of char-
acters

Check for the quality of 
text. The text must be 
readable. Check for wrong 
alignment of the text.

Graphical representa-
tion of the problem

Problem Description
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Tone scale area check

How to make a tone scale area print

The system prints the 'Tone scale area check' print in the 'Presentation' quality 
mode and the 'Area fills' content mode. The system uses a minimum of media 
for the 'Tone scale area' print. You are recommended to use Premium coated 
paper for the 'Tone scale area check' print. 

Do the following to make a tone scale area print.
1 Scroll to the 'System information' card on the on-line screen of the printer 

operator panel.
2 Use the lower softkey for 'Demo prints' to enter the menu.
3 Use the lower softkey to select 'Tone scale area check'. 

Check the output for the problems with the quality described below.
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How to analyze the tone scale area check

The 'Tone scale area check' print option is a quick method to help you find the 
cause of an unsatisfactory output quality. The 'Tone scale area check' print 
option is especially useful to check the quality of the color rendering and the 
color fastness.
Use the 'Tone scale area check' print option on the printer operator panel to 
trace the following problems.

[26] Description of output quality problems

[26] Description of output quality problems

The 'Optimize print quality' section describes how you can solve problems 
with the quality (see ‘Use the Optimize print quality wizard’ on page 141).

Graphical representa-
tion of the problem

Problem Description

Drop-out Problems with the noz-
zles can cause drop-out.

Banding Banding means that a 
print contains regular 
horizontal stripes. 
These stripes can ap-
pear as light or dark 
bands. Problems with 
the nozzles can cause 
banding. The tone scale 
area check is printed in 
the 'Presentation' mode 
and must not contain 
banding.
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Demo print

How to make a demo print

The system prints the 'Demo' print in the 'Presentation' quality mode and the 
'Area fills' content mode. The demo print takes 12 minutes to print.

There are two methods for starting the demo print.
■ Through the Océ System Control Panel
■ Through the 'System information' card on the on-line screen of the printer 

operator panel.
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How to analyze the demo print

You can make a demo print to get an impression of the print capabilities of the 
Océ TCS400. You can also use the 'Demo' print option to check the output 
quality for the different content types.
Use the demo print to trace the following problems:

[27] Description of output quality problems

Graphical representa-
tion of the problem

Problem Description

Drop-out Problems with the nozzles 
can cause drop-out.

Banding Banding means that a 
print contains regular hor-
izontal stripes. These 
stripes can appear as light 
or dark bands. Problems 
with the nozzles can cause 
banding. Banding can oc-
cur in the 'Check' and 'Re-
lease' modes if you print a 
high density print. For the 
best output quality always 
use the 'Presentation' 
mode.
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[27] Description of output quality problems

The 'Optimize print quality' section describes how you can solve problems 
with the quality (see ‘Use the Optimize print quality wizard’ on page 141).

Not available Cockling Check for the cockling of 
the media caused by ink 
saturation. Cockling can 
occur in the 'Lines & text' 
content mode. The system 
does ink reduction correc-
tions in the 'Area fills' con-
tent mode.

Not available Coalescence Coalescence means that 
the individual ink drops 
merge on the media. The 
result is a bad image qual-
ity. 
Coalescence occurs in the 
'Check' mode when you 
print on high gloss photo 
paper.

Graphical representa-
tion of the problem

Problem Description
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Methods to optimize the output quality

Optimize the output quality on the printer 

Introduction

This section describes different methods which you can use to optimize the 
output quality on the printer under the conditions described in the previous 
section.

Problem analysis and solutions 
[28] Problem analysis and solutions

Problem Method of 
analysis

Solutions

The color of one 
area merges with 
the color of an-
other area

Quality check 
print

■ Use the 'Area fills' content mode (see 
‘Output quality and print speed’ on 
page 123)

■ The media type defined on the printer 
must be the same as the media 
available on the printer. If the media 
type defined on the printer is not the 
same as the media available on the 
printer, use the 'Change media type' 
wizard to change the media type (see 
‘Change the type of media defined on 
the printer’ on page 164)

■ Use coated media
■ Use the default drying time
■ Use the setting KO - Printer - 

Climate dependent alignment to 
define if the system must 
automatically do an alignment when a 
large change in climate occurs.

■ Remove the printer from high 
humidity conditions.
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The color of one 
line runs into the 
color of another 
line

Quality check 
print

■ The media type defined on the printer 
must be the same as the media 
available on the printer. If the media 
type defined on the printer is not the 
same as the media available on the 
printer, use the 'Change media type' 
wizard to change the media type (see 
‘Change the type of media defined on 
the printer’ on page 164)

■ Use coated media
■ Use the default drying time
■ Use the setting KO - Printer - 

Climate dependent alignment to 
define if the system must 
automatically do an alignment when a 
large change in climate occurs.

■ Remove the printer from areas of high 
humidity.

White stripes in 
filled areas

Quality check 
print

■ Use the 'Area fills' content mode
■ Use the 'Presentation' quality 

mode(see ‘Output quality and print 
speed’ on page 123)

■ Use the 'Optimize print quality' 
wizard to correct the problem (see 
‘Use the Optimize print quality 
wizard’ on page 141).

The output color 
is not the same as 
the original color

Quality check 
print

■ Make sure you define the correct 
software settings, for example the 
correct pen settings.

■ Use the 'Area fills' content mode
■ Use the 'Presentation' quality mode

The length and 
width measure-
ments are differ-
ent from the 
original

Quality check 
print

■ Make sure you defined the correct 
scale settings

■ Use the 'Presentation' quality mode
■ Use the 'Optimize print quality' 

wizard to correct the problem.

Problem Method of 
analysis

Solutions
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The colored lines 
are not well 
aligned or 
blurred

Quality check 
print

■ Use the 'Lines & text' content mode
■ Use the 'Presentation' quality mode
■ Use the 'Optimize print quality' 

wizard to correct the problem.
■ If failing printheads cause this 

problem, use the 'Replace printhead' 
wizard to replace the failing 
printheads (see ‘Replace a defective 
printhead’ on page 186).

Missing sections 
in lines or 
stepped lines

Quality check 
print

■ Use the 'Lines & text' content mode
■ Use the 'Presentation' quality mode
■ Use the 'Optimize print quality' 

wizard to correct the problem.
■ If failing printheads cause this 

problem, use the 'Replace printhead' 
wizard to replace the failing 
printheads.

Missing parts of 
characters

Quality check 
print

■ Use the 'Lines & text' content mode
■ Use the 'Presentation' quality mode
■ Use the 'Optimize print quality' 

wizard to correct the problem.

Ink saturation 
causes the media 
to cockle

Demo print ■ Use the 'Area fills' content mode
■ The media type defined on the printer 

must be the same as the media 
available on the printer. If the media 
type defined on the printer is not the 
same as the media available on the 
printer, use the 'Change media type' 
wizard to change the media type 

■ Use coated media.
■ Use the default drying time.
■ Use the setting KO - Printer - 

Climate dependent alignment to 
define if the system must 
automatically do an alignment when a 
large change in climate occurs.

■ Remove the printer from areas of high 
humidity.

Problem Method of 
analysis

Solutions
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[28] Problem analysis and solutions

The individual 
ink drops merge 
on the media

Demo print Coalescence occurs in the 'Check' mode 
when you print on high gloss photo pa-
per. Use the 'Release' or 'Presentation' 
quality mode

Problems with 
the nozzles cause 
drop-out

Demo print ■ Use the 'Optimize print quality' 
wizard to correct the problem.

■ A defective or end-of-life 
maintenance cassette can cause this 
problem. Use the 'Replace cassette' 
wizard to replace the maintenance 
cassette (see ‘Replace the 
maintenance cassette’ on page 192)

■ Use the 'Optimize print quality' 
wizard to correct the problem.

The print con-
tains regular hor-
izontal light or 
dark bands

Demo print ■ The media type defined on the printer 
must be the same as media roll 
available on the printer. If the media 
type defined on the printer is not the 
same as the media available on the 
printer, use the 'Change media type' 
wizard to change the media type

■ Use the 'Presentation' quality mode
■ Use the 'Optimize print quality' 

wizard to correct the problem.

color consistency 
problems

N/A ■ Some types of media can discolor 
with age. Check that the media is new 
and that is stored correctly.

■ Use the setting KO - Printer - 
Climate dependent alignment to 
define if the system must 
automatically do an alignment when a 
large change in climate occurs.

■ Remove the printer from areas of high 
humidity.

Problem Method of 
analysis

Solutions
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Use the Optimize print quality wizard

Introduction

The off-line screen of the printer operator panel contains the 'Optimize print 
quality' wizard that helps you to correct the problems with the output quality. 
The wizard performs the following actions:
■ Calibration
■ Recover a nozzle failure
■ Align the printheads for the selected media type.

Define the settings for automatic calibration, nozzle failure detection, and 
printhead alignment in the Océ Settings Editor. See the on-line help within the 
Océ Settings Editor application. You can start the calibration, nozzle failure 
detection and printhead alignment from the printer operator panel.

During the 'Optimize print quality' wizard, the system performs an alignment. 
The alignment requires the use of media. Make sure at least one roll of media 
is loaded before you enter the 'Optimize print quality' wizard.

When to do

Before you start the 'Optimize print quality' wizard, first check the following:
■ Did you use the correct media type?
■ Did you use the correct print mode?

Only start the wizard when you are sure that you used the correct media type 
and the correct print mode and if the output quality is still not satisfactory.

How to use the Optimize print quality wizard

1 Press the on-line / off-line key to set the printer off-line.
2 Press the upper softkeys to scroll to the 'Optimize print quality' card.
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3 Press the lower softkey for 'Optimize print quality' to enter the wizard.
An introduction screen displays the message 'Use this wizard to optimize the 
print quality.' A roll must be available on the printer for use during calibration.

4 Press the key for 'Next'.
The screen displays the message 'Select roll to use'. 
You can only calibrate on six defined media types (see ‘Overnight printing’ on 
page 179). When calibration is not possible with the loaded media, the system 
asks you to load the correct media. When calibration is possible with one of 
the rolls, the system automatically uses the correct roll of media. When 
calibration is possible with both rolls, continue with step 5.

5 Press the lower softkeys to select a media roll for the calibration.

6 Press the key for 'Next'.
The screen displays the message 'Preparing calibration...' The system prepares 
for the quality check.
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The screen displays feedback about the calibration process. The system does a 
nozzle failure recovery.
You can stop the calibration process at any time. Press the key for 'Cancel' to 
stop the calibration process.
When there are no defective printheads, you can perform a printhead 
alignment. The screen displays the message 'All printheads OK. Perform 
alignment?'

7 Press the key for 'Yes'. The system performs a printhead alignment. The screen 
displays the message 'Aligning printheads...'
When you select 'No', the system returns to the off-line menu.
When there are printheads with defective nozzles, you cannot do a printhead 
alignment. The screen displays the message 'defective printheads' with the 
color and number of the defective printheads.

8 Press the key for 'Replace' to enter the 'Replace printhead' wizard (see ‘Replace 
a defective printhead’ on page 186).
Press the key for 'Ignore' to return to the off-line screen.
Note: When the fallback mode is disabled in the Océ Settings Editor or when 
more than one printhead of one color is defective, you must replace the 
defective printheads immediately.
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Optimize the output quality from the scanner

Introduction

The Océ TCS400 scanner has the following methods to make sure you have a 
consistent output quality:
■ Automatic scanner adjustment

The scanner automatically makes the adjustments to make sure the quality 
is consistent.

■ Settings on the scanner operator panel
■ Scanner calibration.

This section describes different methods which you can use to optimize the 
output quality from the scanner for your copy jobs and your scan-to-file jobs.
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Problem analysis and solutions
[29] Problem analysis and solutions

[29] Problem analysis and solutions

Problem Solutions

The image on the output is some 
what wrong aligned.

Enable the 'Deskew' function on the 
'System' screen of the scanner opera-
tor panel.
Use 'Deskew' for originals that do not 
contain lines or text.
Deskew is especially useful for small 
originals.

Pollution of the background of the 
image

Use the arrow keys to enable the 'Au-
tom. background compensation' 
function on the 'Image' card of the 
scanner operator panel.
When the glass plate and the white 
platen are dirty, the background of 
the image can also become polluted. 
When the glass plate and the white 
platen are dirty, clean the glass plate 
and the white platen. (see ‘Clean the 
scan area’ on page 197)

The image is too dark or too light. 
There is not enough contrast between 
dark and light areas in the image.

Use the 'Dark areas' and the 'Light ar-
eas' settings on the 'Image' card of the 
scanner operator panel. Use the left 
and right arrow keys to increase or 
decrease the exposure.

General problems with the quality of 
the output.

Use the 'Scanner calibration' wizard 
on the 'System' screen of the scanner 
operator panel to calibrate the scan-
ner.
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Calibrate the scanner

Introduction

To maintain a consistent quality of the output, the Océ TCS400 scanner 
operator panel has a calibration wizard. 

When to do

Use the scanner calibration wizard to get consistent output of high quality.
Between 2 scanner calibrations, the automatic scanner adjustment stabilizes 
the output quality. The automatic scanner adjustment keeps the scanner 
independent of changes in the environment.
Use the scanner calibration wizard to start a scanner calibration when the scan 
quality decreases.

Use the scanner calibration wizard when the following error message appears 
on the screen.
■ 'Unable to align the cameras. Please calibrate the scanner.'

Before you begin

■ Turn on the scanner at least one hour before you do the scanner calibration
The scanner needs one hour to warm-up for optimal calibration.

■ Clean the glass plate of the scanner
(see ‘Clean the scan area’ on page 197)

■ Clean the white platen of the scanner
(see ‘Clean the scan area’ on page 197)

■ Clean the calibration sheet
■ The scanner operator panel must display 'Ready'.
■ Make sure the IT8 file matches the scanner calibration sheet.

(see ‘Update the IT8 file for scanner calibration’ on page 149)

Required tool

The scanner calibration sheet inside the front compartment. 
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How to calibrate the scanner

1 Press the upper key for 'System' on the home screen.
2 Press the lower key for 'Scanner calibration' to enter the wizard.

[39] Entry to the scanner calibration wizard on the System screen.

[39] Entry to the scanner calibration wizard on the System screen.

The screen displays 'Use this wizard to calibrate the scanner' and the time and 
the date of the last successful calibration.
[40] The first step of the scanner calibration wizard

[40] The first step of the scanner calibration wizard

3 Press the upper key for 'Next'.
The screen prompts you to clean the glass plate and white platen.
[41] The second step of the scanner calibration wizard

[41] The second step of the scanner calibration wizard
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4 After you cleaned the glass plate and white platen, press the key for 'Next'. 
5 Place the calibration sheet face down, center aligned.

[42] The third step of the scanner calibration wizard

[42] The third step of the scanner calibration wizard

6 Press the key for 'Next'.
The scanner starts the calibration. The calibration takes 10 minutes. If you 
press the key for 'Cancel', the calibration process aborts. Then, the screen 
prompts you to remove the calibration sheet.
[43] The fourth step of the scanner calibration wizard

[43] The fourth step of the scanner calibration wizard

7 If the calibration is completed, remove the calibration sheet. 
[44] The fifth step of the scanner calibration wizard

[44] The fifth step of the scanner calibration wizard

8 Press the key for 'Done'.
The scanner returns to the 'System' screen.
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Update the IT8 file for scanner calibration

Introduction

This section explains how to update the IT8 file which is paired to the scanner 
calibration sheet. 

Note: You must log on as system administrator in the Océ Settings Editor to 
update the IT8 file.

When to do

The IT8 file must match the scanner calibration sheet, which is normally found 
inside the front compartment of the scanner. You can find the IT8 file on the 
disk supplied with the scanner calibration sheet.

If you receive a new scanner calibration sheet, replace the IT8 file on the 
controller with the IT8 file received with the scanner calibration sheet.

How to update the IT8 file

1 Log on to the system administrator mode in the Océ Settings Editor.
2 From the 'Calibration' menu, select 'Scanner'.

The 'Scanner calibration' window appears.
3 Click the 'Browse' button and browse to the location of the IT8 file.
4 Select the IT8 file and click the 'Upload' button.

The system uploads the IT8 file. When the IT8 file is correctly uploaded, the 
system gives a confirmation.
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Chapter 9 
Manage jobs on the Océ TCS400
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Introduction to how to manage your jobs

This chapter describes the actions you can perform to manage your jobs. You 
can perform the following actions on the Océ TCS400.
■ Delete or stop a job
■ Feed originals on the scanner
■ Set the 'Original release mode'
■ Cut the output
■ Clean cut a roll of media
■ Change the media type
■ Change the default drying time
■ Use the fallback mode to adapt the print speed to compensate for failing 

printheads
■ Use the 'Overnight printing' feature to print for a long period without 

operator attendance, for example outside office hours.
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Delete or stop jobs

Delete or stop an active job on the printer

Introduction

This section describes how to delete or stop an active job on the printer. You 
can delete and stop print jobs from the printer operator panel and from the Océ 
Queue Manager.

How to delete or stop an active print job from the printer operator panel

1 Press the 'Stop' key on the printer operator panel.
The printer stops immediately.
A dialog box on the screen asks the user to resume or delete the job.
If you do not select an option, the printer automatically continues the printing 
after 5 minutes.

2 Use the lower softkeys to indicate whether you want to resume or delete the 
job.

Note: When you delete a job, the drying is not skipped. Press the key for 'Skip 
drying' to cancel the drying during the drying time. When the setting KO - 
Printer - Automatic media cut in the Océ Settings Editor is set to 'On', the 
printer then cuts the media. If the setting is disabled, use the 'Feed & cut' 
wizard to cut the output.
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How to cancel jobs from the Océ Queue Manager

Attention: You can never undo this action.

1 Select the jobs in the print queue, the history queue, or the inbox queue.
2 From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

A cross icon indicates the deleted job.
The system does not print the canceled job.
You can select more than one job with the mouse and the shift or control key.
Note: An anonymous user cannot cancel a job from a remote system.

How to cancel active print jobs from the Océ Queue Manager

Attention: You can never undo this action.

1 Select the active job in the print queue.
2 From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

The printer stops the printing immediately.
If the controller was still processing part of the job, the controller flushes the 
job.
Note: An anonymous user cannot cancel a job from a remote system.

How to place jobs on hold in the Océ Queue Manager

1 Select the jobs in the print queue.
2 From the 'Job' menu, select 'Hold', or click the 'Hold' button on the toolbar.

A job that is placed on hold keeps its position in the print queue. The job will 
not print until the job is resumed. While a job is on hold, other jobs are printed. 
The jobs that were in the queue behind the job on hold are also printed.
You can select more than one job with the mouse and the shift or control key.
Note: The active print job cannot be placed on hold in the Océ Queue Manager.

How to restart jobs in the Océ Queue Manager

1 Click the job that was placed on hold.
2 From the 'Job' menu, select 'Resume', or click the 'Resume' button on the 

toolbar.
The job restarts.
You can select more than one job with the mouse and the shift or control key.
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Delete or stop a job on the scanner

Introduction

This section describes how to delete or stop a job on the scanner. The location 
where you delete or stop a job from depends on the type of job and on where 
the job is in the system.

You can delete or stop a copy from the following locations in the system.
■ When you scan an original, delete or stop a copy job from the scanner 

operator panel. The scanner stops.
■ When a copy job is in a queue on the Océ Queue Manager application, 

delete or stop the copy job in the Océ Queue Manager. Delete or stop the 
copy jobs in the Océ Queue Manager with the same method you use to 
delete or stop the print jobs. (see ‘Delete or stop an active job on the printer’ 
on page 153). The copy jobs have a special indication on the Océ Queue 
Manager.

■ When the printer prints a copy job, delete or stop the copy job from the 
printer operator panel. Delete or stop the copy jobs from the printer operator 
panel with the same method you use to delete or stop the print jobs. (see 
‘Delete or stop an active job on the printer’ on page 153)

You can only stop a scan-to-file on the scanner.

How to delete or stop an active job from the scanner operator panel

1 Press the red ' Stop' key.
The original transport on the scanner stops immediately.
When the printer processes a copy job, the printer stops.

2 A dialog box on the screen asks the user to remove the original.
3 Use the softkeys for 'Forward' or 'Rewind' to remove the original from the scan 

area.
When you have removed the original, the system is ready to start the next job.
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Handle the originals on the scanner 

Feed the original

Introduction

Use the following methods to feed the original:

Before you begin

Set the 'Auto feed' setting on the 'System' screen.

The 'Auto feed' setting determines the method to feed the original.
■ 'Auto feed' is enabled.

When the original is inserted, the original is fed through the scanner. Before 
you feed the original, make sure you first define the correct job settings.

■ 'Auto feed' is not enabled. 
When the original is inserted, the original is fed into the scanner. After you 
define the correct settings, press the green 'Start' key to feed the original 
through the scanner.

How to feed the original

1 When 'Auto feed' is enabled, first define the job settings.
2 Feed the original face down.
3 Align the original on the measurement ruler.

The original feed table has a measurement ruler. The measurement ruler has 
two sides. The metric measurements are found on one side, the imperial 
measurements are on the other side.
The regular standard sizes for the original feeding are marked below the ruler.

4 If 'Auto feed' is not enabled, define the job settings and then press the green 
start key.
After you insert the original, you can measure the original size with the ruler 
printed on the pressure platen.

5 The original is fed into the scanner. The printer starts.
6 Collect the output from the printer.
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Original release mode

Introduction

Use the 'Original release mode' on the 'System' screen to define where originals 
are held after the scan is complete.

Before you begin

Use the KO - Scanner - Settings - Original release mode setting in the Océ 
Settings Editor to define the default values.

Define where originals are held after they are scanned

The 'Original release mode' has the following settings:
■ 'Hold'

The scanner holds the original at the rear after the scan is complete.
■ 'Release'

The scanner releases the original at the rear after the scan is complete.
■ 'Rewind'

The scanner rewinds and holds the original at the front side after the scan is 
complete.
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Thick originals

Introduction

You can adjust the pressure platen on your scanner to the thickness of your 
original.

[30] The adjustment steps

[30] The adjustment steps

Position Thickness

0 (default position) 2 mm (0.08")

1 4 mm (0.16")

2 6 mm (0.24")

3 8 mm (0.31")

4 10 mm (0.39")

5 12 mm (0.47")

6 14 mm (0.55")

7 16 mm (0.63")
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How to adjust the pressure platen to the thickness of your original

1 Open the scanner cover to expose the pressure platen.
2 Use one hand to press down on the platen.
3 Put two fingers in the recesses in the front of the slider. Adjust the slider to the 

thickness of the original.
[45] Put two fingers in the recesses in the front of the slider

[45] Put two fingers in the recesses in the front of the slider

Use the measurement scale on top of the slider to adjust the slider to the 
thickness of the original.
[46] The measurement scale on top of the slider

[46] The measurement scale on top of the slider

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


160 Océ TCS400 User manual

4 Repeat the procedure for the other slider.
Make sure both the sliders are adjusted to same thickness.

5 Close the scanner cover.

Note: If the pressure platen is not in the default position for longer than a 
defined time, the error message 'Unable to adjust the scanner lower the 
pressure platen' can appear. If this error message appears, return the pressure 
platen to the default position. Wait until the scanner adjustment is complete, 
then adjust the pressure platen again. (see ‘An adjustment error’ on page 214)

Result

If a thick original is inserted, the original is fed through the scanner 2 inches 
more than a thin original. The additional inches are not shown on the output.
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Handle the media on the printer

Cut the output and clean cut a roll of media

Introduction

The off-line screen of the printer operator panel contains the 'Feed & cut' 
wizard that helps you perform the following:
■ Cut the output.
■ Clean cut a roll of media. Use this option to cut the roll so that the edge is 

straight.

You can only use the 'Feed & cut' wizard to cut the output when 'Automatic cut' 
is disabled in the Océ Settings Editor.

Note: If 'Automatic cut' is enabled in the Océ Settings Editor, the system 
automatically cuts the output.

How to use the Feed & cut wizard to cut the output.

1 Press the on-line / off-line key to set the printer off-line.
2 Use the upper softkeys to scroll to the 'Feed & cut' card.
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3 Press the softkey below the 'Feed & cut' card to enter the wizard.
The screen displays the message 'Preparing Feed & cut...'. The system prepares 
for the feed and cut. This can take between 0 and 20 seconds.

4 Press the key for 'Feed' to feed the output in steps of 2 inches.

5 Press the key for 'Cut' to cut the output.
If you do not need to cut the output, press the key for 'Finish' to return to the 
on-line screen.
After you select 'Cut', the system returns to the on-line menu.

How to use the Feed & cut wizard to clean cut a roll of media

1 Press the on-line / off-line key to set the printer off-line.
2 Use the upper softkeys to scroll to the 'Feed & cut' card.
3 Press the softkey below the 'Feed & cut' card to enter the wizard.

■ If multiple rolls are available on the system, the screen displays the message 
'Select roll for Feed & cut.'

■ If one roll is available on the system, the wizard moves directly to the 'Cut?' 
screen.
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4 The screen displays the message 'Select roll for Feed & cut.' Use the lower 
softkeys to select a media roll to clean cut.

5 Press the key for 'Next' to continue. The screen displays the message 'Cut?'

6 Use the lower softkeys to select the cut length option. Select one of the 
following: 
■ 'Yes, long strip'

Feeds the media with a full roll rotation feed (20 inches) before the printer 
cuts the media.

■ 'Yes, short strip'
The printer automatically cuts the media with the least possible media waste 
(8 inches).

7 Press the key for 'Finish' to confirm the settings. The screen displays the 
message 'Cutting sheet...'.

After the sheet is cut, you automatically exit the wizard.
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Change the type of media defined on the printer

Introduction

The standard configuration of the Océ TCS400 contains two rolls of media. 
The Océ TCS400 is also available with one roll. Appendix A contains a list of 
the supported media types and media sizes.

This section describes the following:
■ How to remove and load a roll of media.
■ How to change the type of media defined on the system.

When to do

Change a roll when a job needs a media type or size that is not on one of the 
rolls.
Change the media type that is defined on the system if the defined media type 
and the available media type do not correspond.

Before you begin

Use the KO - System - Media - Paper series setting to define the correct paper 
series in the Océ Settings Editor.
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How to remove a roll of media 

1 Press the retract button on the right-hand side of the roll.
[47] Press the retract button

[47] Press the retract button
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The medium automatically retracts from the printer.
2 Use both hands to remove the roll.

[48] Remove the roll

[48] Remove the roll
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3 Both far ends of the roll contain flanges with handles. Lift the handles to 
release the flanges.
[49] Release the flanges

[49] Release the flanges
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4 Remove the flanges.
[50] Remove the flanges

[50] Remove the flanges
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How to load a new media roll

1 Insert the flanges in both ends of the new media roll.
2 Press the handles down to fasten the flanges.
3 Put the saddles into position at the ends of the track.

[51] Saddles

[51] Saddles
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4 Use both hands to place both flanges in the dark blue saddles on the printer.
5 Use both hands to slide the medium under the paper guide. Place the media on 

the printer as shown in the figure below.

The medium loads into the printer from the top of the media roll.
Make sure the medium makes contact with the paper guide.

6 The printer automatically draws the medium in the correct position.
When the printer loads the roll of media, the screen of the printer operator 
panel shows the feedback.

Note: The printer automatically detects the width of the media.
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How to select the settings for the new roll of media 

Attention: After you load a new roll of media, the screen of the printer operator 
panel displays a wizard. Use the wizard to define the media type and the cut 
option for the new media roll.

1 The screen displays the message 'Select media type on roll (number)'. Use the 
lower softkeys to select the media type.
[52] Select the media type

[52] Select the media type

2 Press the key for 'Next' to enter the cut option screen. The system displays the 
question 'Cut?'

3 Use the lower softkeys to select the cut option for the media.
[53] Select the cut option

[53] Select the cut option

Select one of the following:
■ 'Yes, long strip'

Cut the media with a full roll rotation feed (20 inches) before the printer cuts 
the media. You can use this option if the media is damaged or polluted with, 
for example, tape residue.

■ 'Yes, short strip'
Cut the media with the shortest possible strip (8 inches).

■ 'No'
No media cut.

4 Press the key for 'Finish' to confirm the settings and to exit the wizard.
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How to correct the media type defined on the system

Attention: You only need to correct the type of media if an incorrect media type 
was defined when the roll was loaded.

If you define a type of media that is different from the media type loaded on the 
system, the print quality decreases and pollution of the system can occur.

1 Press the on-line / off-line key to set the printer off-line.
2 Use the upper softkeys to scroll to the 'Change media type' card.

[54] Change media type card on the off-line screen

[54] Change media type card on the off-line screen

3 Press the softkey below the 'Change media type' card to enter the wizard.
4 An introduction screen displays the message 'Use the retract button to replace 

a roll. Press Next to change the media type for a loaded roll.'
[55] Introduction screen

[55] Introduction screen
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If you do not want to load a new roll, use the upper right softkey to continue 
the wizard at the introduction screen. If you do want to load a new roll, press 
the retract button to change the media roll. (see figure 47)

5 When you press the retract button, the screen displays the message 'Load new 
media'. Change the media roll as described in the above sections. 

6 If you do not press the retract button and continue in the 'Change media type' 
wizard, the screen displays the message 'Select roll to change media type for'. 
Use the lower softkeys to select the correct roll to change the media type for.
[56] Select a roll to change the media type.

[56] Select a roll to change the media type.

7 Press the key for 'Next' to continue. The screen displays the message 'Change 
media type of roll [number]'. Use the lower softkeys to select the correct media 
type for the media roll.
[57] Select the correct media type for the roll

[57] Select the correct media type for the roll

8 Press the key for 'Finish' to confirm the settings and to exit the wizard.
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Define the correct media for your jobs

To achieve optimal output quality.

1 Make sure you load and define the correct media type on the printer.
Use the 'Change media type' wizard to load a media roll and to change the 
media type defined on the system.

2 Make sure you define the correct media type for your job. Make sure the media 
type and the media format defined in your job is available on the printer.

Define the correct media on the printer and the correct settings in the job 
submission tools to set the Océ TCS400 for productive use or high output 
quality.

When productivity with different media sizes is the most important 
requirement

1 Load and define two media rolls on the printer with different media sizes and 
the same media types.

2 Use the 'Landscape' orientation to print a job on a media size that is one size 
smaller than the media defined on the system. For example, 23x33 prints in 
landscape on 33x47 and 17x23 prints in landscape on 23x33. You are not 
required to cut the media by hand.

3 Use the 'Auto rotate' setting in the Océ Settings Editor or the job submission 
tools to rotate the orientation automatically.

The above procedure is based on DIN media sizes. You can also use this 
procedure with ANSI media sizes.

If productivity is the only important requirement
1 Load and define two media rolls on the printer with the same media sizes and 

the same media types.
2 Enable the 'Automatic roll switch' in the Océ Settings Editor or the job 

submission tools.
If roll one is empty, the printer switches automatically to roll two.

If the output quality is the most important requirement
1 Load and define two media rolls on the printer with the same media sizes and 

with different media types.
Select the media types you define based on the output quality you require.
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Drying times

Typical drying times

Introduction

The printer automatically adapts the default drying time. The default drying 
time depends on the following:
■ The media type
■ The ambient humidity
■ The print mode.

Of you print grayscale in the 'Check' quality mode, the system decreases the 
drying time to 20% of the default value.

You can change the drying time for all the media types. You can select a 
percentage of 0% - 999% of the default drying time (see ‘Change the default 
drying time’ on page 177).

Typical drying times per media type

The following table describes typical drying times for Océ media under 
standard conditions (22 °C, 50% relative humidity):
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[31] Typical drying t imes per media type

[31] Typical drying times per media type

Note: For maximum productivity, the system does not perform drying times of 
0'20" or less. If you change the default drying time, the system uses the drying 
times of 0'20" or less for the arithmetic operation.

Media type Media name Drying 
time

Draft paper Océ Draft Paper 20 lb. bond 2'15"

Standard paper Océ Standard Paper 24 lb. 
bond

1'15"

Bond Océ Check Bond uncoated 20 
lbs

1'15"

Deluxe bond Océ Deluxe Bond uncoated 
24 lbs

0'20"

Premium coated paper Océ Premium Grade Paper 24 
lb. bond

0'20"

Coated bond Océ Color Bond coated 24 lbs 0'20"

Matte photo paper Océ Smart Matte Paper 100 
45 lb. bond

3'00"

High gloss photo paper Océ Smartfit Plus Photogloss 
47 lb. bond

6'40"

Tracing paper Océ Tracing Paper 24 lb. bond 8'00"

Translucent bond Océ Translucent Bond 16 lb. 
bond
Océ Translucent Bond 18 lb. 
bond

1'45"

Monochrome vellum Océ Monochrome Vellum 16 
lb. bond
Océ Monochrome Vellum 20 
lb. bond

8'40"

Color vellum Océ Color Vellum 20 lb. bond 9'20"

Matte film Océ Double Matte Film 95 µ
Océ Film Double Matte Eras-
able 3 mil
Océ Film Double Matte Eras-
able 4 mil

12'40"
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Change the default drying time

Introduction

You can change the drying time with a percentage of the default drying time. 
For example, if you set the default drying time for Premium coated paper, 
under the conditions used in the table above, to 200%, the drying time will be 
0'40".

How to change the default drying time

1 Open the Océ Settings Editor application.
2 Go to the setting KO - Printer - Media settings - Drying time.
3 Select the required media type.
4 Define the required percentage.
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Continuous printing

Fallback mode

Introduction

If printheads are failing, the Océ TCS400 can continue to print with the same 
output quality. To use this option, the setting  KO - Printer - Fallback mode 
in the Océ Settings Editor must be enabled.

Use of the fallback mode

If the fallback mode is enabled, and printheads fail, the printer continues to 
print with the same quality at half the speed.
If the printer is in the grayscale mode and a color printhead fails, the printer 
continues to print grayscales at full speed. If a black printhead fails, the printer 
continues to print at half the speed.
If the fallback mode is not enabled and you continue to print, the output quality 
decreases. The print speed does not decrease. (see ‘When to do’ on page 186)
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Overnight printing

Introduction

The Océ TCS400 has the ability to print unattended, for example outside office 
hours. To use this option, the setting  KO - Printer - Calibration - Overnight 
printing in the Océ Settings Editor must be enabled.
When the setting 'Overnight printing' is enabled, the system will automatically 
perform checks, alignments and calibrations to ensure a consistent output 
quality.

Substantial changes of the temperature or the humidity can have an adverse 
influence on the print quality. Use the setting KO - Printer - Climate 
dependent alignment to define if the system must automatically do an 
alignment when a large change in climate occurs.

Use of overnight printing

The setting 'Overnight printing' has the following options:
■ 'Check'

The system checks for failing printhead nozzles.
■ 'Check and optimize'

The system checks for failing printhead nozzles and corrects the alignment. 
Use the KO - Printer - Calibration - Overnight printing check interval 
setting to define the number of prints after which the system automatically 
does a check or calibration.

■ 'Off'
The system will not do a calibration or check.

Calibration is only possible when one of the following media types are loaded 
on the system.

■ Standard paper
■ Premium coated paper
■ Bond
■ Coated bond
■ Matte photo paper
■ High gloss photo paper
■ Deluxe bond.

If these media types are not available on the system, calibration is delayed until 
the next time a print is made on one of these media types.
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Note: If the system detects a failing printhead and the fallback mode is 
enabled, the system automatically switches to the fallback mode (see ‘Fallback 
mode’ on page 178).
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Introduction to maintenance

This chapter describes the maintenance activities for the operator. 

The operator can perform the following maintenance activities.
■ Replace the ink tanks
■ Replace failing printheads
■ Replace the maintenance cassette
■ Clean the scan area.
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Maintenance activities for the printer

Replace the ink tanks

Introduction

The Océ TCS400 contains the following four ink tanks:
■ One tank for the cyan ink. Capacity 400 ml.
■ One tank for the magenta ink. Capacity 400 ml.
■ One tank for the yellow ink. Capacity 400 ml.
■ One tank for the black ink. Capacity 400 ml.

The ink level card on the printer operator panel indicates the ink level of each 
color as a percentage.

You can replace the ink tanks at any time. A wizard is not required.

When to do

You must replace an ink tank in the following situations:
■ The ink level indicator on the printer operator panel displays 0%. The 

indicator flashes when the ink tank is empty. If you replace the ink tank, the 
printer can continue to print on the ink present in the system.

■ A pop-up message appears on the screen and displays the message 'Out of 
[color] ink. Replace ink tank'. The system produces a double audio signal. 
The red LEDs of the printer operator panel remain illuminated. The printer 
stops. Immediate action is required.
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How to remove an ink tank

1 Press the dimpled recess in the ink tank inward and upward to release the ink 
tank.
[58] Push the tank inward and upward

[58] Push the tank inward and upward

2 Pull the ink tank straight out of the slot.
[59] Pull the tank out

[59] Pull the tank out

The indication for the removed tank on the printer operator panel changes into 
a dashed line.
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How to place an ink tank

Attention: Make sure that you replace an ink tank with a tank that contains ink 
of the same color.

1 Hold the ink tank with the color of the label towards you.
The ink tanks are arranged in the same sequence as shown on the printer 
operator panel. From left to right, the sequence of the ink tanks is cyan, 
magenta, yellow, black (CMYK). A label on the ink tank indicates the color of 
the ink in the ink tank.
Note: Do not shake the ink tank or touch the opening of the ink tank.

2 Slide the ink tank into the slot until you feel a resistance and stop.
Note: The ink tank fits in only one way. The ink tank fits only into the slot 
dedicated for the color. If you attempt to place the ink tank the wrong way or 
in the wrong slot, the ink tank will not fit. Do not attempt to force it.

3 Press the dimpled recess in the ink tank inward and downward until the ink 
tank clicks into place.
When the printer detects the full ink tank, the ink level indicator on the printer 
operator panel displays 100%.
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Replace a defective printhead

Introduction

The Océ TCS400 contains the following ten printheads:
■ Two printheads for cyan (C)
■ Two printheads for magenta (M)
■ Two printheads for yellow (Y)
■ Four printheads for black (K).

Always follow the instructions in the wizard on the printer operator panel when 
replacing a defective printhead.
After you replace a defective printhead, the system performs an alignment. The 
alignment requires the use of media. Make sure at least one roll of media is 
loaded before you enter the 'Replace printhead' wizard.

Only replace printheads if they are defective. Changing printheads that are not 
defective will shorten the printhead lifetime and cause problems with the ink 
system.

Note: Only replace a defective printhead from the 'Replace printhead' wizard.

When to do

The system indicates which printheads are defective. Only replace the 
printheads the system indicates.

The system uses the following methods to indicate defective printheads:

■ An error message prompts you to replace the defective printheads.
■ The printhead information card on the on-line screen indicates the 

printheads with defective nozzles with an icon that shows a printhead with 
the nozzles.

When the printhead nozzles are defective, you can continue to print. If the 
fallback mode is enabled the output quality will not decrease. The print speed 
will decrease.(see ‘Replace a defective printhead’ on page 186).
If the fallback mode is not enabled, the output quality will decrease. The print 
speed will not decrease.
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How to remove a printhead

Attention: Do not open the top cover when you are not in the wizard. When you 
open the top cover outside the wizard, the system produces a long, 
uninterrupted audio signal audio signal. The red LEDs on the printer operator 
panel remain illuminated. If you open the top cover during printing, the printer 
stops. After you close the cover, the print is cut. Then the whole print job is 
restarted.

1 Press the on-line / off-line key on the printer operator panel to take the printer 
off-line.

2 Use the upper softkeys to scroll to the 'Replace printhead' card.

3 Press the softkey below the 'Replace printhead' card to enter the wizard.
An introduction screen displays the message 'Use this wizard to replace 
printheads. A roll is needed for calibration.'

4 Press the key for 'Next'.
The screen displays the message 'Select roll to use'.
The system performs a calibration at the end of the wizard. You can only 
calibrate on six defined media types (see ‘Overnight printing’ on page 179). If 
calibration is not possible with the media available on the printer, the system 
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asks you to load the correct media. If calibration is possible with one of the 
rolls, the system automatically uses the correct media roll. If calibration is 
possible with both rolls, use the lower softkeys to select the roll to use.

5 Press the key for 'Next'.
The screen displays the message 'Carriage moving to center position...' while 
the carriage moves to the center.
The screen displays 'Open top cover.'

6 Open the top cover.

The screen displays the message 'Replace printheads' and the printheads that 
you must replace.
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7 After replacing the defective printheads, press the key for 'Next'.
Find the correct printhead number on the printhead carriage.

8 Pull the metal clamp of the printhead cover up. The cover moves up.

Hold the clamp with one hand because the clamp is connected to a spring 
mechanism.
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9 Use your other hand to remove the printhead. Move the printhead away from 
the center of the carriage and remove the printhead.

How to place a printhead

1 Remove the protective tape from the new printhead.
Note: Do not touch the contact and nozzle areas of the printhead after you 
remove the protective tape.

2 Hold the clamp with one hand and use your other hand to place the new 
printhead in the printhead holder.
The printhead only fits in one way.

3 Move the printhead towards the center until the printhead clicks into the 
connection slot.

4 Carefully release the clamp.
On the operator panel, press the softkey for 'Next'.

5 The screen displays the message 'Is printhead [number and color] reinserted or 
new?'
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6 Press the softkey for 'Reinserted' or 'New'.
Select 'Reinserted' if you refit the printhead that you just removed.
Select 'New' if you replaced the original printhead.
The screen displays this message for every printhead you replaced.
Note: To achieve optimal print quality, the system must know if the inserted 
printhead is warm or cold. A reinserted printhead will be warm while a new 
printhead will be cold. Always store your printheads at room temperature.

7 The screen displays the message 'Make sure that all head covers are properly 
positioned.'
Press the key for 'Done'.
The screen displays the message 'Close top cover.'

8 Close the top cover.
The screen displays the message 'Carriage moving to home position...'

9 Press the softkey for 'Next' to start the calibration and the alignment of the 
printheads. The screen displays 'Calibrating...'.
The calibration process takes several minutes.
You can stop the calibration process at any time. Press the key for 'Cancel' to 
stop the calibration process.
When the calibration is completed, the screen displays the calibration status.
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Replace the maintenance cassette

Introduction

The maintenance cassette wipes the printheads and caps the printhead nozzles.

When to do

Replace the maintenance cassette in the following situations:
■ The printer operator panel displays the message 'Maintenance cassette 

nearly full.'
The print quality can deteriorate. Replace the cassette as soon as possible.

■ The printer operator panel displays the message 'Maintenance cassette full. 
Press Continue to start the Replace cassette wizard.'
The Océ System Control Panel also indicates that you must replace the 
cassette.

The message 'Maintenance cassette full. Press Continue to start the Replace 
cassette wizard' appears.

When the maintenance cassette is full, the system produces a double audio 
signal. The red LEDs of the printer operator panel remain illuminated. 
Immediate action is required.
The printer operator panel displays this message after about 5000 m2 of output. 
The exact value depends on the print modes you use.

The message gives access to a wizard that contains the procedure to replace the 
maintenance cassette.

When the maintenance cassette is not in position when the system starts up, the 
system produces an error signal The red LEDs of the printer operator panel 
remain illuminated. The printer operator panel displays the message 
'Maintenance cassette not present.' The message gives access to a wizard that 
contains the procedure to replace the maintenance cassette.

You can always access the wizard in the off-line mode.
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How to remove the maintenance cassette

Attention: Do not remove the maintenance cassette if you are not in the wizard. 
You can seriously damage the printheads. If you open the maintenance door 
outside the wizard, an error message prompts you to close the door.

1 Press the on-line / off-line key on the printer operator panel to take the printer 
off-line.
If you replace the cassette as the result of the message ' Maintenance cassette 
full. Press Continue to enter the Replace cassette wizard.', press the softkey for 
'Continue' to enter the 'Replace cassette.' wizard. Then continue with step 4.

2 Use the upper softkeys to scroll to the 'Replace cassette' card.

3 Press the softkey below the 'Replace cassette' card to enter the wizard.
An introduction screen displays the message 'Use this wizard to replace the 
maintenance cassette.'
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4 Use the upper right softkey to enter the wizard at the introduction screen.
The screen displays the message 'Carriage moving to center position...' while 
the carriage moves to the center.
Then, the screen displays the message 'Open maintenance door.'

5 Open the door to the maintenance cassette.
The screen displays the message 'Remove cassette.'

6 Press the green grip to the left to release the cover that gives access to the 
maintenance cassette.
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7 Pull out the maintenance cassette.

Note: Always store the old maintenance cassette in a horizontal position to 
prevent the spilling of ink. Be careful with the ink on the maintenance cassette.

How to place the maintenance cassette

1 Slide the new maintenance cassette into the cassette holder.
2 Close the cover of the maintenance cassette . The cover locks automatically.

The screen displays the message 'Is the cassette you placed used or new?'
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3 Press the key for 'Used' or 'New'.
Select 'Used' if you inserted a cassette that was used before. The end-of-life 
counter is not reset to zero.
Select 'New' if you inserted a cassette that was not used before. The end-of-life 
counter is reset to zero.
Note: Make sure you select the correct option. Never select 'New' for a used 
cassette. This can cause serious damage your printer.

4 Close the door to the maintenance cassette.
The screen displays the message 'Carriage moving to home position...'
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Maintenance activities for the scanner

Clean the scan area

Introduction

This section describes how to clean the glass plate and the white platen of your 
Océ TCS400 scanner. You can find the required tools in the maintenance kit 
supplied with the scanner.

Required tools

Two lint-free cloths.

Streak-free, glass cleaner.
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How to clean the scan area

Attention: Do not use abrasives, acetone, benzene or fluids that contain these 
chemicals: Do not spray liquids directly on the scanner.

1 Turn off the scanner and disconnect the power plug.
2 Open the scanner cover to expose the pressure platen.
3 Remove the pressure platen.

Use one hand to press down on the platen. 
Put two fingers in the openings on the front of the slider. Move the slider 
toward the center until the pressure platen disengages.
[60] Use one hand to press down on the platen. Put two fingers in the openings on the front of the slider. Move the slider toward the center until the pressure platen disengages

[60] Use one hand to press down on the platen. Put two fingers in the openings on the front of 
the slider. Move the slider toward the center until the pressure platen disengages
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Repeat the procedure for the other slider.
Use the two handles on top of the pressure platen to remove the pressure platen.
[61] One of the two handles on top of the pressure platen

[61] One of the two handles on top of the pressure platen
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4 Clean the glass plate.
Clean the glass plate with a lint-free cloth and a mild, streak-free, glass cleaner. 
Use a separate clean, dry lint-free cloth to dry the glass plate completely.

5 Clean the white platen.
The white background platen is on the back of the pressure platen you removed 
in step 3. Clean the white surface and the transport rollers with a lint-free cloth 
and a mild, streak-free, glass cleaner. First clean the platen's white area and 
then the transport rollers. Use a separate clean, dry lint-free cloth to thoroughly 
dry the platen and the rollers.

6 Replace the pressure platen.
Use the two handles on top of the pressure platen to replace the pressure platen 
upright on the glass plate.
Make sure the springs are fit over the pins.
[62] Make sure the springs are fit over the pins

[62] Make sure the springs are fit over the pins
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Replace the handles.
7 Return the sliders to their default position.

Move the slider to the center of the pressure platen passed the safety button. 
Hold the slider in its position. 
[63] The location of the safety button

[63] The location of the safety button

Press the safety button and release the slider.
Use one hand to press down on the platen.
Make sure that the slider is returned to the default position.
Repeat the procedure for the other slider.
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Introduction to error handling

This chapter describes what to do if an error occurs on the Océ TCS400.

The following types of errors can occur on the Océ TCS400 printer:
■ A media jam
■ A system error
■ A permanent error
■ The end of the roll of media is reached while you print
■ A door or cover is open, although you are not in a wizard
■ The carriage is away from its home position too long
■ The media required for the job is not available on the printer
■ The Océ Queue Manager contains damaged jobs that you cannot delete

The following types errors can occur on the Océ TCS400 scanner:
■ An original jam
■ A system error
■ A permanent error
■ A smartcard error (see ‘Correct smartcard errors’ on page 216)
■ An adjustment error (see ‘How to adjust the pressure platen to the thickness 

of your original’ on page 159)
■ A calibration error (see ‘Calibrate the scanner’ on page 146).
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Clear the errors on the printer

Remove jammed media

Introduction

If a media jam occurs, the system produces a double audio signal. The red 
LEDs of the printer operator panel remain illuminated. If a jammed media 
error occurs on the system, immediately remove the jammed media to prevent 
damage to the printer.
The system handles the error recovery for the jammed media through a series 
of dialog boxes. Use the following procedure to remove the jammed media:

How to remove jammed media

Attention: Never use a knife to cut loose the jammed media. If you use a knife 
to cut loose the media, you can damage the printer.

1 Open the cover or door that the printer operator panel indicates.

2 Use a pair of scissors to cut loose the media.
3 Remove the jammed media from the output side of the printer.
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4 Press the softkey for 'Done' to confirm that you removed the jammed media.
5 Close the cover or door that the printer operator panel indicates.

6 Insert the roll of media in the printer.
The printer is ready for use.

Note: If you remove the media from the front of the printer, there is a risk of ink 
pollution in the media feed section.
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System errors and permanent errors

Introduction

If a system error or a permanent error occurs, the system produces a double 
audio signal. The red LEDs of the printer operator panel remain illuminated. 

How to correct system errors 

1 A system error is an error that the system can recover. If a system error occurs, 
an error code is displayed on the screen.

2 If a system error occurs, you must turn the printer off and on.
Note: After the system is turned off, wait a few seconds before you turn the 
system on again.

How to deal with permanent errors

1 A permanent error is an error that neither the system nor the operator can 
recover. A permanent error does not recover when you restart the system. If a 
permanent error occurs, an error code is displayed on the screen.

2 If a permanent error occurs, contact your local Océ service organization. Make 
sure you have the error code at hand when you contact your local Océ service 
organization.
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Miscellaneous errors

Introduction

This section describes the following errors:
■ The end of the media roll is reached while you print.
■ A door or cover is open although you are not in a wizard.
■ The carriage is away from its home position too long. The printheads can 

become dry.
■ The media required for the job is not available on the printer.
■ Possible obstruction of ink path.
■ Excessive temperature or humidity.
■ The Océ Queue Manager contains damaged jobs that you cannot delete.

End of roll

If the setting KO - Printer - Automatic roll switch in the Océ Settings Editor 
is set to 'On' and the other roll contains the same media type, the printer 
automatically switches to the other roll.
If the end of the media roll is reached during printing and the other roll does 
not contain the same media type, the system produces a short interrupted audio 
signal. The red LEDs on the printer operator panel flash two times.
The output is dried to make retraction of the output possible.

Cover or door opened

You are only allowed to open the top cover when you are in the 'Replace 
printhead' wizard.
You are only allowed to open the maintenance door when you are in the 
'Replace cassette' wizard.

When you open the top cover or the maintenance door without accessing the 
wizard, the system produces a warning signal. The red LEDs on the printer 
operator panel remain illuminated. If you open a door or cover during printing, 
the printer stops. A message on the printer operator panel tells you to close the 
top cover or the maintenance door. Close the top cover or the maintenance door 
to continue.
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If the cover or door is opened while the printer prints a job, the print is cut after 
you close the cover. Then the whole print job is restarted.

Carriage away from home position too long

Attention: If the carriage stays away from its home position too long, the 
printheads become dry. When the printheads are dry, you must replace the 
printheads.

Always replace the printheads or the maintenance cassette in one continuous 
action to prevent the drying of the printhead nozzles.
When you replace a printhead or the maintenance cassette, the carriage moves 
to the center. When the carriage is in the center too long, the system produces 
an error signal The red LEDs on the printer operator panel remain illuminated. 
The printer operator panel also displays a message. Press the key for 'OK' to 
acknowledge the error message.
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Required media not available

If the Océ Power Logic® controller tries to print on a type of media that is not 
available on the printer, the printer operator panel displays a media request. 
The system produces a short interrupted audio signal. The red LEDs of the 
printer operator panel remain illuminated. Replace the media roll to continue. 
The following shows an example of the message.

Possible obstruction of ink path

If the ink tank is full, but the printer detects no ink in the ink reservoir, it is 
possible that the ink path is blocked. The system produces a short interrupted 
audio signal. The red LEDs on the printer operator panel flash two times, and 
the following error message appears on the screen:

Press the key for 'OK'. The ink level indicator for the color on the on-line 
screen of the printer operator panel is grayed out and flashes.

If this error occurs, contact your local Océ service organization. Make sure you 
have the error code at hand when you contact your local Océ service 
organization.
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Temperature or humidity out of range

The system produces a short interrupted audio signal. The red LEDs on the 
printer operator panel flash two times. Press the key for 'OK'. The system 
information card on the on-line screen of the printer operator panel displays the 
following message until the problem is solved:

If this error persists, contact your local Océ service organization. 

Clear the set memory 

Attention: When you clear the set memory, all jobs on the system are deleted.

Clear the set memory when the Océ Queue Manager contains damaged jobs 
that you cannot delete.
You can clear the set memory from the Océ System Control Panel.

From the 'System' menu, select 'Clear the system' to delete all the jobs on the 
system.

If you do not have a keyboard, mouse and monitor with your controller, you 
can also clear the system with the 'Configure system' wizard on the printer. (see 
‘Configure the network settings of the Océ TCS400’ on page 49).
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Clear the errors on the scanner

Remove a jammed original

Introduction

If an original jam occurs, the screen displays an error message. If such an 
original jam occurs on the system, immediately remove the jammed original to 
prevent damage to the original.

When to do

An original jam can occur while the original is fed into the scanner. (see ‘Feed 
the original’ on page 156)

How to remove a jammed original

1 Use the softkeys for 'Forward' or 'Rewind' to remove the jammed original from 
the scan area.

2 If the removing of the original with the softkeys can cause damage to the 
original, lift the pressure platen and remove the original by hand.
The sections about how to adjust the pressure platen and about how to clean 
the scan area describe how to lift the pressure platen.(see ‘Thick originals’ on 
page 158). (see ‘Clean the scan area’ on page 197)
[64] How to remove a jammed original

[64] How to remove a jammed original
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System errors and permanent errors

Introduction

If a system error or a permanent error occurs, the screen displays an error 
message with the error code.

[65] A system error message on the scanner operator panel

[65] A system error message on the scanner operator panel

[66] A permanent error message on the scanner operator panel

[66] A permanent error message on the scanner operator panel

How to correct system errors and permanent errors

Refer to the procedure to correct system errors and permanent errors on the 
printer. Use the same procedure on the scanner. (see ‘System errors and 
permanent errors’ on page 207).
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Miscellaneous errors

Introduction

This section describes the following errors:
■ A smartcard error
■ An adjustment error
■ A calibration error.

A smartcard error

If a smartcard error occurs on the scanner, follow the instructions on the screen 
and make sure the smartcard is correctly installed.
(see ‘Correct smartcard errors’ on page 216)

An adjustment error

The scanner can only perform the automatic adjustment if the pressure platen 
is placed in the default position.

If the pressure platen is not in the default position for longer than a defined 
time, the following error message can appear:

If this error message appears, return the pressure platen to the default position. 
Wait until the scanner adjustment is complete, then adjust the pressure platen 
again.
(see ‘Thick originals’ on page 158)
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A calibration error

When calibrating the scanner, the following error message can appear:

If this error message appears, first update the IT8 file with the IT8 file that 
matches the scanner calibration sheet, then calibrate the scanner.
(see ‘Update the IT8 file for scanner calibration’ on page 149)
(see ‘Calibrate the scanner’ on page 146)

Before you calibrate the scanner, always make sure you fulfill all requirements 
described in the Calibrate the scanner section of chapter 7. If an error message 
appears, follow the instructions on the screen.(see ‘Calibrate the scanner’ on 
page 146)
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Correct smartcard errors

Introduction

The Océ TCS400 scanner contains a smartcard. The smartcard is located inside 
the front compartment in the small drawer marked 'PUSH'.

[67] The smartcard is found inside the front compartment in the small drawer marked PUSH

[67] The smartcard is found inside the front compartment in the small drawer marked PUSH

When to do

If the smartcard is not installed correctly, the screen displays an error message. 
When the screen displays an error message, follow the instructions on the 
screen. The scanner only functions when the smartcard is installed correctly.

How to install the smartcard correctly 

1 Press the small drawer marked 'PUSH' inside the front compartment of the 
scanner.
The drawer opens.

2 Install the smartcard with the contact side downward.
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Océ Power Logic® controller: Océ 
Settings Editor
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Introduction to the Océ Power Logic® controller: Océ Settings 
Editor

Introduction

This chapter gives information about the Océ Settings Editor. The on-line help 
of the Océ Settings Editor application contains exact information about 
specific settings.

You can access the Océ Settings Editor locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller. You 
must use Océ Remote Logic® to connect to the Océ Settings Editor if you do 
not have a keyboard, mouse and monitor with your Océ Power Logic® 
controller.

Description of the Océ Settings Editor

Use the Océ Settings Editor to define the default settings for the system 
according to your requirements. The Océ Settings Editor includes the 
following types of settings:
■ Key Operator settings (KO settings)
■ System Administrator settings (SA settings).

A password protects the KO settings and the SA settings. Without a password, 
you can only view the settings.

The key operator is allowed to change the following groups of settings (see 
‘Define the settings in the Océ Settings Editor’ on page 228):
■ Job settings for the print jobs
■ Printer settings
■ System settings.
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The system administrator is allowed to change the following groups of settings 
(see ‘Define the settings in the Océ Settings Editor’ on page 228):
■ Poker settings
■ Printer language (PDL) settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings.

In the 'Anonymous' mode, the operator is not logged on. The anonymous user 
is allowed only to view the settings.
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Overview of the Océ Settings Editor

Start the Océ Power Logic® controller applications

Introduction

You can start the Océ Power Logic® controller applications locally on the 
controller or from a remote workstation. This section describes how to start the 
applications locally on the Océ Power Logic® controller. The section 'Start the 
applications with Océ Remote Logic®' describes how to start the applications 
from a remote workstation (see ‘Start the applications with Océ Remote 
Logic®’ on page 256).

Start the applications locally on the Océ Power Logic® Controller

1 Select the 'Launcher' application.
2 Select the required application.

The application starts with your default system.
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Overview of the Océ Settings Editor

The structure of the Océ Settings Editor
[68] The structure of the Océ Settings Editor

[68] The structure of the Océ Settings Editor

The Océ Settings Editor displays the following fields:

1 The menu bar
2 The top toolbar
3 The left toolbar
4 The settings area
5 The status bar.
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The menu bar
[69] The menu bar

[69] The menu bar

[32] The menu bar items

[32] The menu bar items

Menu Function

'File' ■ Log on to a user mode
■ Log off from the previous user mode
■ Open a file that contains saved settings
■ Save the current settings to a file
■ Connect to a different controller ( for remote users 

only).
■ Close the application.

'Edit' ■ Define the host name
■ Define the default system you want to connect to 

during start-up
■ Use 'Automatic logon' to start the Océ Settings 

Editor application automatically in the defined user 
mode.

'View' ■ Toggle between the display languages
■ Toggle between the display of the KO settings and 

the SA settings.

'Help' ■ Access the contents of the on-line help
■ Get more information about the copyright and the 

version of the application.
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The top toolbar
[70] The top toolbar

[70] The top toolbar

[33] The buttons of the top toolbar

[33] The buttons of the top toolbar

Button Function

'Open' Open a file that contains saved settings.

'Save as...' Save all the KO settings or the SA settings in a file.

'Apply' Apply the changes you made to the settings.
Note: The button is enabled after you change a setting. 
The button is disabled after you apply the settings, or 
after an undo action.

'Undo' Restore the settings to the state before the settings 
were changed. The 'Undo' button does not restore the 
factory default.
Note: The button is enabled after you change a setting. 
The button is disabled after you apply a changed 
setting.
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The left toolbar
[71] The left toolbar

[71] The left toolbar

[34] The buttons of the left toolbar

Button Function

'Jobs' Gives access to the settings for the jobs.
Note: The 'Jobs' button is only available in the key 
operator view.

'Printer' Gives access to the settings for the printer.
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[34] The buttons of the left toolbar

Click a button to access the special group of settings of this button. A shadow 
highlight indicates which button is activated.

The on-line help in the Océ Settings Editor includes complete information 
about the different settings.

'System' Gives access to the settings for the system.

'Scanner' Gives access to the settings for the scanner.

Button Function
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The settings area
[72] The settings area

[72] The settings area

[35] The par ts of the settings area

[35] The parts of the settings area

Part Function

Tree structure Display the settings.
Open a folder to show all the settings in that folder.
The display does not include the unavailable settings for 
the system components.

Update area Define the settings selected in the tree structure.
The update area can contain additional information (def-
inition and values) about the selected setting.
Only authorized users can change the settings. If the user 
is not authorized to change a setting, the update area is 
grayed out.
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The status bar

The status bar at the bottom of the Océ Settings Editor displays the following 
(from left to right):
■ The system status ('connected' or 'disconnected').
■ The system name ('local host' if you are working on the controller).
■ The user mode (key operator, system administrator or anonymous).
■ The view mode (KO Settings or SA Settings).
[36] The icons for the connection status

[36] The icons for the connection status

Icon Description

The Océ Settings Editor is connected to a system.

The Océ Settings Editor is not connected to a system.
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Use the Océ Settings Editor

Define the settings in the Océ Settings Editor

Introduction

The Océ Settings Editor allows you to define the following settings:
■ Key operator settings (KO settings)
■ System administrator settings (SA settings).

You need a password to change the KO settings and SA settings (see ‘Log on 
to the controller applications’ on page 264).

Note: Only one key operator, system administrator or repro operator at a time 
is authorized to change the settings. An error message appears when a second 
user tries to log on to the key operator mode or system administrator mode. 
Multiple users are authorized to view the settings.

How to define the key operator settings

1 Log on to the key operator mode.
2 Use the buttons on the left toolbar to display the required group of settings.
3 Select the required settings in the tree structure.
4 Define the settings in the update area.
5 Click the 'Apply' button to confirm the new settings.
6 Log off from the key operator mode to prevent unauthorized use of the 

application.

How to define the system administrator settings

1 Log on to the system administrator mode.
2 Use the buttons on the left toolbar to display the required group of settings.
3 Select the required settings in the tree structure.
4 Define the settings in the update area.
5 Click the 'Apply' button to confirm the new settings.
6 Log off from the system administrator mode to prevent unauthorized use of the 

application.
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Save, load, and print the settings

Introduction

It is possible that you need different settings for different customers, 
departments or other conditions. For this reason, you can save the settings to a 
file and then load the settings from a file.

The Océ TCS400 has the following special files for your use:
1 Backup.kos/Backup.sas

These files contain the previous values for the key operator settings and the 
system administrator settings before the last 'Apply'.

2 Current.kos/Current.sas
These files contain the values for the key operator settings and the system 
administrator settings after the last 'Apply'.

If you need a complete overview of all settings defined in the Océ Settings 
Editor, you can print a list of all current settings.

How to save the settings to a file

1 From the 'File' menu, select 'Save as'.
You can also click the 'Save as' button on the toolbar.
If the client is a local client, the screen displays a dialog box. The user can enter 
a file name. The file is saved in the specified directory on the system.
If the client is a remote client, the screen displays a dialog box. The user can 
enter a directory name and a file name.
Note: Repro operators and anonymous users are not authorized to save the 
settings to a file.
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How to load the settings from a file

1 From the 'File' menu, select 'Open'.
You can also click the 'Open' button on the toolbar.
The screen displays a dialog box from where you can browse to the required 
file.

2 Click the 'Apply' button.
The settings are transferred to the system.
If you are logged on as a key operator, the system only loads the KO settings.
If you are logged on as a system administrator, the system only loads the SA 
settings.
Repro operators and anonymous users are not authorized to load the settings 
from a file.

How to print a list of the current settings

1 From the 'System' menu in the Océ System Control Panel, select 'Print 
settings'.
A list of the current settings on the Océ Power Logic® controller is printed.
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Introduction to the Océ Power Logic® controller: Océ System 
Control Panel

Description of the Océ System Control Panel

The Océ System Control Panel application provides you with the following 
information about the status of the system.
■ Status of the printer
■ Descriptions of the different types and sizes of available media on the 

system
■ The ink level for each color
■ Status of the scanner
■ Status of the controller
■ The amount of set memory in use.

You can access the Océ System Control Panel locally on the controller if you 
have a keyboard, mouse and monitor with your Océ Power Logic® controller. 
You must use Océ Remote Logic® to connect to the Océ System Control Panel 
if you do not have a keyboard, mouse and monitor with your Océ Power 
Logic® controller.

See 'Océ Power Logic® controller: Océ Settings Editor' for information about 
how to start the application locally on the controller.(see ‘Start the Océ Power 
Logic® controller applications’ on page 220).
See 'Océ Power Logic® controller: Océ Remote Logic®' for information about 
how to start the application from a remote workstation. (see ‘Start the 
applications with Océ Remote Logic®’ on page 256).

User operations in the Océ System Control Panel

The Océ System Control Panel allows you to do the following:
■ Make a demo print. See Make a demo print
■ Print your system configuration (see ‘Save, load, and print the settings’ on 

page 229)
■ Clear the system memory (see ‘Miscellaneous errors’ on page 208)
■ Shut down the system (see ‘Turn the Océ Power Logic® controller and the 

printer off’ on page 43).
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Overview of the Océ System Control Panel

Overview of the Océ System Control Panel

The structure of the Océ System Control Panel
[73] The structure of the Océ System Control Panel

[73] The structure of the Océ System Control Panel

The Océ System Control Panel includes the following items:

1 The menu bar
2 The toolbar, with buttons to access the view area
3 The status of the printer and printheads
4 An overview of the loaded media types
5 The ink level indicators
6 The status of the scanner
7 The status of the Océ Power Logic® controller
8 The amount of set memory in use
9 The status bar.
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The menu bar
[37] The items of the menu bar

[37] The items of the menu bar

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the 
password.

■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller (only for 

remote users).
■ Click 'Close' to leave the Océ System Control panel.

'Edit' Click 'Options' to define the following:
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to 

automatically start up in the defined user mode.
■ Select the two screen languages.

'View' ■ Select one of the display languages for the application.
■ Display the items for the status control. Click an item to 

view the status. The items correspond with the buttons of 
the toolbar.

'System' ■ Click 'Print settings' to print a report of the configuration 
settings.

■ Click 'Demo print' to make a demo print.
■ Click 'Clear system' to remove all the jobs from the system.
■ Click 'Shut down' to shut down the system.

'Help' ■ Click 'Contents' to access the topics of the on-line help.
■ Click 'About' for general information about the Océ System 

Control Panel.

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


Océ Power Logic® controller: Océ System Control Panel 235

The toolbar

Click the buttons on the toolbar of the Océ System Control Panel to check the 
status of the items in the view area. If operator action is required, the 
appropriate button will flash.

[38] The buttons of the toolbar

[38] The buttons of the toolbar

Item Function

'Printer' View the status of the printer and the printheads. If the printer 
operator panel displays an error, the 'Printer' status window of 
the Océ System Control Panel will display the same error.

'Media' View the status of the media (available, empty or disabled). 
The 'Media' display also shows information about the available 
media sizes and media types.
Note: If a roll is disabled, the roll icon is grayed out. The text 
'-disabled-' replaces the media information.

'Ink' View the ink levels of the four colors.

'Controller' View the status of the controller.

'Memory' Check the amount of set memory that is available. The 
percentage on the right-hand side of the set memory meter 
indicates the amount of set memory in use. The colors 
indicate the following:

■ Green indicates that the set memory has sufficient space for 
a large print job or many small jobs.

■ Orange indicates that the set memory approaches the red 
zone. Large print jobs may not be possible.

■ Red indicates that the set memory is (nearly) full. The 
system does not accept new print jobs. Remove files or wait 
until files are printed and automatically removed from the 
memory.

Note: Define the threshold values for the orange zone and the 
red zone in the Océ Settings Editor.
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The status bar

The status bar at the bottom of the Océ System Control Panel displays the 
following:
■ The system status (connected or disconnected).
■ The system name ('localhost' if you work on the Océ Power Logic® 

controller).
■ The job status (for example 'Printing').
■ The user mode ('Key operator', 'Repro operator', 'System administrator', 

'Service operator' or 'Anonymous').
[39] The icons of the status bar

[39] The icons of the status bar

Icon Function

The Océ System Control Panel is connected to a system.

The Océ System Control Panel is not connected to a sys-
tem.
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Icons

The Océ System Control Panel uses a number of icons to display the 
information about the media available on the printer. The following icons are 
used:

Icon Description

The media roll is available and the roll is ready to print

The media roll is disabled.

The media roll is enabled but empty.

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


238 Océ TCS400 User manualDownloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


239

Océ TCS400

User manual

Chapter 14 
Océ Power Logic® controller: Océ 
Queue Manager

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


240 Océ TCS400 User manual

Introduction to the Océ Power Logic® controller: Océ Queue 
Manager

Introduction

This chapter describes how to view and manage the jobs with the Océ Queue 
Manager.

You can access the Océ Queue Manager locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller. You 
must use Océ Remote Logic® to connect to the Océ Queue Manager if you do 
not have a keyboard, mouse and monitor with your Océ Power Logic® 
controller.

See 'Océ Power Logic® controller: Océ Settings Editor' for information about 
how to start the application locally on the controller. (see ‘Start the Océ Power 
Logic® controller applications’ on page 220).
See 'Océ Power Logic® controller: Océ Remote Logic®' for information about 
how to start the application from a remote workstation (see ‘Start the 
applications with Océ Remote Logic®’ on page 256).

Description of the Océ Queue Manager

The Océ Queue Manager application provides you with a graphical image of 
the print queue, the history queue or the inbox queue.

The Océ Queue Manager allows you to perform the following:
■ View the queue of jobs
■ Cancel the current job
■ Delete jobs in the queue
■ Place jobs on hold in the queue 
■ Print jobs from the history queue
■ Print jobs from the inbox queue
■ Move jobs to the top of the queue
■ Give priority to jobs in the queue
■ Restart the jobs that were placed on hold in the queue.
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User modes

The Océ Queue Manager has the following user modes:
■ The key operator mode
■ The repro operator mode
■ The system administrator mode
■ The service operator mode.

This mode is for the Océ service engineer only.
■ The anonymous mode.

The user modes provide the following permissions:
■ The repro operator, the key operator and the system administrator user 

modes allow you to hold, resume and delete the jobs. A repro operator, key 
operator or system administrator is allowed to move jobs to top.

■ The anonymous user mode only allows the user only to view the queue. All 
the buttons and menu items are disabled in this mode. The anonymous user 
is allowed to cancel the jobs when the user works locally with the Océ 
Queue Manager on the controller.

Note: The key operator, the system administrator and the repro operator have 
the same access permissions to functions in the Océ Queue Manager and the 
Océ System Control Panel. The permissions to access the settings in the Océ 
Settings Editor vary according to the different user modes.
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Overview of the Océ Queue Manager

Overview of the Océ Queue Manager

Introduction

This section contains an overview of the Océ Queue Manager application. Use 
the Océ Queue Manager to manage the jobs in the job queue.

The structure of the Océ Queue Manager

The Océ Queue Manager includes the following items:

1 The menu bar
2 The toolbar
3 The window for the print queue
4 The window for the inbox queue or history queue
5 The status bar.
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The Océ Queue Manager uses columns to display the following information 
for each job:
■ The current status and the schedule of the job
■ The name of the job
■ The type of job (a print job or a copy job)
■ The name of the user who sent the print job
■ The number of sets and pages
■ Remarks.

Note: Drag the table header separators to change the width of the columns. 
Drag a column to a new position to change the sequence of the columns.

The menu bar
[40] The items of the menu bar

[40] The items of the menu bar

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the 
password.

■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller 

(only for remote users).
■ Click 'Close' to leave the Océ Queue Manager.

'Edit' Click 'Options' to define the following:
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to 

automatically start up in the defined user mode.
■ Select the two screen languages.

'View' ■ Toggle between the defined display languages.
■ Toggle between the 'Inbox' queue and the 'History' 

queue.
■ Define the 'Column options'. Select the table headers 

you want to see when you open the Océ Queue 
Manager.

'Job' Display the actions for a job. The menu items correspond 
with the toolbar buttons.

'Help' ■ Click 'Contents' to access the topics of the on-line 
help.

■ Click 'About' for general information about the Océ 
Queue Manager.
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The toolbar
[41] The toolbar buttons

[41] The toolbar buttons

The status bar

The status bar at the bottom of the Océ Queue Manager displays the following:
■ The system status (connected or disconnected).
■ The system name ('localhost' if you work on the Océ Power Logic® 

controller).
■ The job status (for example 'Printing').
■ The user mode ('Key operator', 'Repro operator', 'System administrator', 

'Service operator' or 'Anonymous').

The window for the print queue 

The print queue window in the left-hand pane contains two sections.
■ The top section above the separation line shows the job that is printed.
■ The bottom section under the separation line shows the jobs that wait to be 

printed. The window displays the jobs in the order in which the jobs are 
received.

Button Function

'Hold' Place a job on hold in the print queue .

'Resume' Continue a job that was placed on hold.

'Move to top' Move a job to the top of the print queue, to give the job 
priority.

'Delete' Delete a job from the print queue.

'Properties' View the properties of a selected job.

'Print' Print a job from the print queue.
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The window for the inbox queue or history queue

The inbox queue in the right-hand pane contains the jobs that were sent to the 
inbox on the controller. You can print the jobs, delete the jobs and view the 
properties of the jobs. The print jobs are sent to the inbox when the setting KO 
- System - Job management - Print jobs in the Océ Settings Editor is set to 
inbox or if 'Send to inbox' is enabled in the driver.

The history queue in the right-hand pane contains the jobs that have been 
printed. You can print the jobs, delete the jobs and view the properties of the 
jobs. Use the setting KO - System - Job management - History queue - Print 
job lifetime in the Océ Settings Editor to define how long the jobs must remain 
in the history queue.
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Icons

The Océ Queue Manager uses a number of icons to display information about 
a job in the queue. The following icons are used:

Icon Description

Receiving a job in the inbox or the print queue.

Received a job in the print queue.

Processing a job in the print queue.

Processed a job in the print queue.

An active job in the print queue (bold font and above the gray 
separation line).

Printing a job.

Delivering a job to the history queue.

Delivered a job to the history queue.

Deleted a job.

A job that is put on hold by default . This icon indicates that 
the job is displayed in the inbox.

A job is on hold.

Warning, a media request.
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Use the Océ Queue Manager

User operations in the Océ Queue Manager

Introduction

The Océ Queue Manager allows you to perform the following:
■ Print a job from the inbox queue or the history queue
■ Cancel jobs

This action deletes jobs from the print queue.
■ Abort jobs.

This action cancels an active print job.
■ Place jobs on hold

This action places print jobs on hold. When you place jobs on hold other 
jobs take priority.

■ Restart jobs on hold.
This action resumes jobs that were previous placed on hold.

The Océ Queue Manager displays the jobs in the sequence that the jobs are 
received. The copy jobs have priority over the print jobs. 

How to print jobs from the inbox queue or the history queue

1 Select the jobs in the history queue or the inbox queue.
Print jobs are sent to the inbox queue if the setting KO - System - Job 
management - Print jobs is set to 'Inbox' or if you have enabled 'Send to 
inbox' in the printer driver.
After you print a job from the print queue, the job moves to the history queue.

2 From the 'Job' menu, select 'Print', or click the 'Print' button on the toolbar.
3 The job moves to the print queue.

You can select more than one job with the mouse and the shift or control key.
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How to print a number of sets of a job from the history queue

1 Log on as a key operator or as a system administrator.
2 Select the job in the history queue.
3 Open the 'Job properties' dialog box.

Use one of the following methods to open the 'Job properties' dialog box:
■ From the 'Job' menu, select 'Properties' or, 
■ Click the 'Properties' button on the toolbar or, 
■ Right-click the job and select 'Properties'.

4 Select the 'Settings' tab in the 'Job properties' dialog box.
5 Change the number of sets in the 'Sets' field.
6 Print the job as described in the paragraph above.

The system prints the indicated number of sets.

How to cancel jobs from the Océ Queue Manager

Attention: You can never undo this action.

1 Select the jobs in the print queue, the history queue, or the inbox queue.
2 From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

A cross icon indicates the deleted job.
The system does not print the canceled job.
You can select more than one job with the mouse and the shift or control key.
Note: An anonymous user cannot cancel a job from a remote system.

How to cancel active print jobs from the Océ Queue Manager

Attention: You can never undo this action.

1 Select the active job in the print queue.
2 From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

The printer stops the printing immediately.
If the controller was still processing part of the job, the controller flushes the 
job.
Note: An anonymous user cannot cancel a job from a remote system.
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How to place jobs on hold in the Océ Queue Manager

1 Select the jobs in the print queue.
2 From the 'Job' menu, select 'Hold', or click the 'Hold' button on the toolbar.

A job that is placed on hold keeps its position in the print queue. The job will 
not print until the job is resumed. While a job is on hold, other jobs are printed. 
The jobs that were in the queue behind the job on hold are also printed.
You can select more than one job with the mouse and the shift or control key.
Note: The active print job cannot be placed on hold in the Océ Queue Manager.

How to restart jobs in the Océ Queue Manager

1 Click the job that was placed on hold.
2 From the 'Job' menu, select 'Resume', or click the 'Resume' button on the 

toolbar.
The job restarts.
You can select more than one job with the mouse and the shift or control key.

How to give priority to jobs in the Océ Queue Manager

1 Select the jobs in the print queue.
2 From the 'Job' menu, select 'Move to top', or click the 'Move to top' button.

You can select more than one job with the mouse and the shift or control key.
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Introduction to Océ Remote Logic®

The applications of Océ Remote Logic®

You must use Océ Remote Logic® to connect to the Océ Power Logic® 
controller applications if you do not have a keyboard, mouse and monitor with 
your Océ Power Logic® controller.

You can use Océ Remote Logic® to run the following applications from a 
remote workstation:
■ Océ Settings Editor

Use the application to change the default settings of the system.
■ Océ Queue Manager

Use the application to manage the print jobs.
■ Océ System Control Panel

Use the application to view the status of the printer, the scanner and the 
controller. You can also view the media available on the printer and the 
amount of set memory in use.

User modes

The Océ Remote Logic® controller applications have different user modes (see 
‘The Océ TCS400 users’ on page 13). An additional user mode is the 'Service 
operator' mode. This mode is for the Océ technician only.
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Install and start Océ Remote Logic®

Install Océ Remote Logic® on your system

Introduction

The Océ Remote Logic® application can run on all platforms with Java™ 
Virtual Machine. This section describes the installation procedures for the 
different types of platforms.

Before you begin

To install Océ Remote Logic® on Windows® 9.x, NT, ME, XP, or 2000, your 
system must be at least equipped with a Pentium® 233 with 32 Mb RAM.

Installation procedure for Microsoft® Windows® platforms

1 Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® controller 
CD-ROM into the CD-ROM drive of your PC.

2 The installation starts automatically. If does not start automatically, run 
Setup.exe.

3 Select the required language in the installation wizard and click 'OK'.
[74] Select the setup language

[74] Select the setup language

4 Follow the instructions on the screen to complete the installation of Océ 
Remote Logic®.
Note: You can only use Océ Remote Logic® when TCP/IP is enabled on your 
system. Refer to your system administrator for help with the installation 
procedure for TCP/IP.
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Installation procedure for UNIX™ platforms

1 Check if a Java™ Runtime Environment (JRE) is installed on the system.
2 From the directory Products/remotelogic/UNIX, unpack the contents of the 

file RemoteLogic_vX.tar to a subdirectory on the system.
3 Use tar xvf RemoteLogic_vX.tar to unpack the file.
4 Set the environment variable RL_VM_HOME to point to the installation of 

the JVM.
5 Run the file remotelogic with the applications as parameters (for example 

remotelogic QM SCP SE to start the three applications), or use remotelogic 
AL as the application launcher.

UNIX™ versions and the required JRE

Note: OS = Operating System, JRE = Java™ Runtime Environment

Where to download the Java™ Runtime Environments
[42] Download Java™ Runtime Environments

[42] Download Java™ Runtime Environments

UNIX™ version OS ver-
sion

JRE Default installa-
tion directory

IBM® AIX 4.1.5 1.1.6 /usr/jdk_base

IBM® AIX 4.2.1 1.1.8 /usr/jdk_base

IBM® AIX 4.3.3 + 
fix

1.2.2 /usr/jdk_dev2

IBM® AIX 4.3.3.10 
+ fix

1.3.0 /usr/jdk_java130

SUN® Solaris™ 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX® 1.0 1.1.3

LINUX® 1.2 1.1.8

Platform Preferred version Download location

1 1.1.8 http://www.ibm.com/java

2 C.01.18.xx http://www.unix.hp.com/ja-
va

3 N/A http://www.ibm.com/java

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


Océ Power Logic® controller: Océ Remote Logic® 255

Installation procedure for other platforms

1 Install Java™ Virtual Machine (version 1.1.8).
2 From the Océ Remote Logic® CD-ROM, load RemoteLogic_vX.tar or 

RemoteLogic_vX.zip.
3 Set the environment variable RL_VM_HOME to point to the 

Java™Products/remotelogic/UNIX installation directory.
4 If necessary, edit the Océ Remote Logic® script or batch file.
5 Use the Océ Remote Logic® script or batch file to start the applications.
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Start the applications with Océ Remote Logic®

Introduction

Use the following two methods to start the applications with Océ Remote 
Logic®.
■ Use the programs menu of your operating system.
■ Use a command line parameter.

Use the programs menu to start the applications

1 Select 'Océ Remote Logic'
2 Select the 'Launcher' application.
3 Select the required application.

The application starts with your default system.

Note: You can select another system than your default system (see ‘Connect to 
the controller’ on page 260).
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Use command line parameters to start the applications

Six command line parameters are available to facilitate the start of the 
applications.

■ configfile=<config_file>
Sets the configuration file to use.

■ server=server
Sets the indicated server as the server to connect to.

■ language1=lang
Specifies the first language in combination with the parameter 
country1=country.

■ country1=country
Specifies the first language in combination with the parameter 
language1=language.

■ language2=lang
Specifies the second language in combination with the parameter 
country2=country.

■ country2=country
Specifies the second language in combination with the parameter 
language2=language.

Note: Always use a matching combination of language and country (see the 
following table).
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Parameters of supported languages
[43] Parameters of supported languages

[43] Parameters of supported languages

Apply the parameters to the applications

Apply the parameters to the following applications:
■ QM.exe (Océ Queue Manager)
■ SCP.exe (Océ System Control Panel)
■ SE.exe (Océ Settings Editor)
■ AL.exe (Application launcher).

The easiest method for applying the parameters to the applications is to create 
a shortcut for an application. Then add the command line properties.

Language Language parameters Country parameters

Danish da DK

Swedish sv SV

Norwegian no NO

Finnish fi FI

Hungarian hu HU

Czech cs CZ

Polish pl PO

German de DE

Dutch nl NL

UK English en GB

US English en US

French fr FR

Italian it IT

Spanish es ES

Portuguese pt PT

Chinese simplified cn CN

Chinese traditional cn TW

Japanese ja JP

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


Océ Power Logic® controller: Océ Remote Logic® 259

Note: The .exe files are usually located in C:\Program Files\Remote 
Logic\Bin.

Example of a command line parameter

The example below shows how to start the controller applications with the 
configuration file 'Myconfig.cfg', connected to the 'MyTCS400' server. The 
first language is set to UK English and the second language is set to French.

C:\Program Files\Remote Logic\Bin\AL.exe
configFile=Myconfig.cfg server=MyTCS400 language1=en country1=GB 
language2=fr country2=FR.
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Connect to the controller

Introduction

After you start one of the Océ Remote Logic® applications, you must connect 
to the Océ Power Logic® controller of the Océ TCS400. You must connect to 
the system for every separate application.

You can perform the following when you connect to the controller: 
■ Select a system from the drop-down list.
■ Add a system to the drop-down list.
■ Remove a system from the drop-down list.

If the Océ TCS400 is not available in the 'Connect to' dialog box, you must add 
the Océ TCS400 to the list of available systems.

How to connect to a system

1 Open the application you want to run.
2 From the 'File' menu, select 'Connect to'.
3 Select the system from the drop-down list.
4 Click 'OK'.

Note: From the 'File' menu, select 'Options' to define the default system. This 
is recommended if you frequently connect to the same system.

How to add a system

1 From the 'File' menu, select 'Connect to'.
2 Click 'Edit'.

The 'Edit systems' dialog box appears.
3 Enter the IP address or the name of the system in the 'Systems' box.
4 Click 'Add'.

The system is added to the list.
5 Click 'OK' two times to return to the application.
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How to remove a system

1 From the 'File' menu, select 'Connect to'.
2 Click 'Edit'.

The 'Edit systems' dialog box appears.
3 Select the system you want to remove.
4 Click 'Remove'.

The system is removed from the list.
5 Click 'OK' two times to return to the application.
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Use Océ Remote Logic®

Automatic logon

Introduction

The 'Automatic logon' option enables you to start an application automatically 
in the indicated user mode.

How to enable automatic logon

1 From the 'Edit' menu, select 'Options'.
The 'Options' window appears.

2 Select the 'Enable automatic logon' checkbox.
3 From the drop-down box, select the user mode for the automatic logon.
4 Enter the password that corresponds to the selected user mode.
5 Click 'OK'.

Automatic logon is now enabled.
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Change the password

How to change the password

1 From the 'File' menu, select 'Log on'.
2 Click 'Password' in the dialog box.
3 Open the drop-down list and select a user.
4 Enter the old password.
5 Enter the new password.
6 Enter the new password a second time to confirm.
7 Click 'OK' to save the new password.
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Log on to the controller applications

User modes

The Océ Power Logic® controller contains the following user modes:
■ Key operator
■ Repro operator
■ System administrator
■ Service operator.

Chapter 1 contains more information about the types of users (see ‘The Océ 
TCS400 users’ on page 13). Chapter 9 contains more information about the 
user modes in the Océ Settings Editor (see ‘Introduction to the Océ Power 
Logic® controller: Océ Settings Editor’ on page 218). Log on to the correct 
user mode in the Océ Settings Editor to change the key operator settings or the 
system administrator settings.

Only assigned operators are allowed to use the user modes. Different 
passwords are required to access the user modes.
You do not need a password for the anonymous user mode.

Passwords

■ The default password for the system administrator is SysAdm.
■ The default password for the key operator is KeyOp.
■ The default password for the repro operator is ReproOp.

If a user is logged on, the user can change the password for the current user 
mode. (see ‘Change the password’ on page 263)

Note: The passwords are case sensitive.

Authorization

Only one key operator, system administrator or repro operator at a time is 
authorized to change the settings.
An error message appears when a second user tries to log on to the key operator 
mode or system administrator mode. 
There is no limitation of users authorized to view the settings.
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[75] Error message when a second user tries to log on

[75] Error message when a second user tries to log on

How to log on to the controller applications

1 From the 'File' menu, select 'Log on'.
2 Select the required user name.
3 Enter the password.
4 Click 'OK'.

You are now logged on as special user. If you are not logged on, you have 
'Anonymous' user permissions. (see ‘The Océ TCS400 users’ on page 13).
The status bar at the bottom shows the user mode.
The logon is limited to one user only.

Note: You must separately log on to each application.

How to log off from the controller applications

From the 'File' menu, select 'Log off'.
You return to the anonymous user mode. Log off from the controller 
applications to prevent unauthorized use.

Note: You must separately log off from each application.
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Introduction to account logging

Introduction

This chapter describes the account logging function of the Océ TCS400.

Note: Account logging is only supported for the print jobs.

The account logging function

The Océ Power Logic® controller can keep track of all your print jobs. The job 
information and the use of media is stored for each job. Account logging 
enables you to collect information about the jobs done for different users and 
accounts.

All data are stored in a file: the account log file. The account log file contains 
a record for all the jobs handled on the Océ TCS400.
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Use account logging

Use account logging

Introduction

Account logging includes the following steps:
■ Enable the account logging option
■ Define the file properties
■ Print the jobs on the correct account
■ Get the generated account log file
■ Use the generated account log file.

Enable the account logging option

Account logging is an option. A password protects the use of account logging. 
Enter the password in the Océ Settings Editor ( KO - System - Enabling 
passwords - Account logging) to use this option.
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Define the file properties

■ File format
The account logging information is stored in a file. The format of the file is 
ASCII (ISO Latin-1 encoding) or UTF-16. The format depends on the 
defined format for the log file. The file format is YYYYMMDD.csv (for 
ASCII files), or YYYYMMDD.txt (for UTF-16 files). Define the file name 
in the Océ Settings Editor.

■ File content
The content of the account log file is based on a text file that includes a 
sequence of lines of text. A line of text is a sequence of characters. Records 
include a sequence of fields separated by a field separator character. Each 
line of text is a record. A record type identifier, which is the first field in a 
record, indicates the type of record.

■ File storage
The account log file is stored on the controller. Every day, the controller 
generates an account log file. You can define the time during which the 
account log file is kept on the controller. Define the time in the Océ Settings 
Editor.

■ File field separator
The file field separator separates the items of a record in the account log file. 
The file field separator depends on the regional settings of your operating 
system. By default, the file field separator is set to 'semicolon'. Make sure 
you define the same file field separator in the Océ Settings Editor as in the 
regional system settings for your operating system. For example, for 
Windows® operating systems, you can find regional system settings under: 
Start - Settings - Control Panel - Regional Setting - Number - List separator.

■ Escaping method
If the text in the field separator contains the field separator character, end of 
line or double quote then the text in the field changes as follows:
Quotes are replaced by double quotes.
The double quotes enclose the text.

This escaping method is compatible with Microsoft® Access and Microsoft® 
Excel.

Print the jobs on the correct account

For a print job, define the 'Account ID' and the 'User ID' in the printer driver or 
in the job submission software (for example, Océ Print Exec® workgroup).
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Get the generated account log file

The account log files are stored in the 'Accounting' directory on the controller. 
You can get your files from the local host through FTP (File Transfer Protocol).

Use the generated account log file

After you got the account log file from the controller, you can view and use the 
data that stored in the records. You can, for example, import the account log 
file into Microsoft® Excel or Microsoft® Access.
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Import the account log file into Microsoft® Excel

How to import the account log file into Microsoft® Excel

1 Start Microsoft® Excel.
2 Open the account log file on your system.

Microsoft® Excel shows the content of the account log file (see ‘Account 
information in the log file’ on page 276).

3 You can now process the data in the account log file.
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Get the account log files through FTP

How to get the account log files through FTP in a web browser

1 Start a web browser.
2 Enter the ftp address of the Océ TCS400 system.

The browser shows the ftp directories on the Océ TCS400 system.
[76] The FTP directory on the system

[76] The FTP directory on the system

Note: Set the name of the system in the Océ Settings Editor.
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3 Browse to the 'Logging' directory.
The account log files are shown.
[77] The account log files

[77] The account log files

4 Save the account log files to any destination on your system.

How to get the account log files through FTP from an MS-DOS® box

1 Launch an FTP client.
2 Enter the ftp command.

An MS-DOS® box appears with the FTP prompt.
3 Enter the Open command.
4 Enter the host name or the IP address of the Océ Power Logic® controller.
5 Press 'Enter'.

The connection with the controller is now established and a window appears 
asking you for a user name.
Note: Instead of the steps 2 through 5, you can also enter ftp (host_name) in 
the FTP client.
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6 Enter your user name 'anonymous', and enter as your password also 
'anonymous', or simply press 'Enter' to start the connection
A connection is now set up for the default user 'anonymous'.

7 Enter binary to set 'binary' as the transmission mode.
8 Use the command cd accounting to go to the 'Logging' directory.
9 Get the account log file.

10 Enter bye to quit FTP.
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Account information in the log file

Account information in the log file

Introduction

This section describes the standard fields available in the log files.

Structure of the log file

The standard log file is a normal CSV file that you can use in a spreadsheet 
application. The first line contains the titles of columns that match to the names 
of the fields.

An account log record (1 line) is generated for each output page. A job that has 
several pages of output, will have a similar number of account log records.

Each line of text is a record. All records that are part of a single job will have 
the same value for the 'Job Unique ID' field. The 'Job Unique ID' field is part 
of each record and is unique for each job in the file. Use the 'Job Unique ID' 
field to collect records that are part of a single job and to calculate the totals for 
the whole job.

The first field in each record is a 4-digit number in ASCII, which identifies the 
record type. The fields in a record have a fixed order determined by the record 
type. The first two digits of the record type identify the product. See the table 
below.

The records include a sequence of fields separated by a field separator 
character.

The fields contain alphanumeric text, semicolons and end-of-lines. When a 
device does not support a function, or when a function was not used for the job, 
the field remains empty.
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The log file contains two different record types, 6410 and 6411.
The first record in each account log file is 6410 and contains a list of 
abbreviated field names that occur in the records of type 6411. The 6410 record 
type is always the same in each account log file and is used as a comment. For 
example to explain the meaning of the fields if the file is imported in an 
application like Microsoft® Excel.
The 6411 record in each account log file contains the actual account log 
information (the second up to the last record in the account log file). (see 
‘Description of the parameters in the standard account log file’).

Note: The Océ TDS800 uses the record types 6110 and 6111. The Océ TDS600 
uses the record types 6210 and 6211. The Océ TDS400 uses the record types 
6310 and 6311. 

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


278 Océ TCS400 User manual

Description of the parameters in the standard account log file

The table below describes the fields in the standard CSV account log file.

[44] The fields in the standard CSV account log file

Parameter Type Length 
(max)

Description

Record type num 4 Each account log file starts with a 
record of type 6310. This is a fixed 
record which only contains the abbre-
viated field names used in records of 
the type.

Record type identifiers for the 
different Océ systems. 

■ 6111 for the Océ TDS800
■ 6211 for the Océ TDS600
■ 6311 for the Océ TDS400
■ 6411 for the Océ TCS400.

Account ID 
(AccID)

text 255 Account ID. Escaped according to es-
caping rules.
When the Account ID is not available, 
this field is empty.
Note: The 9-digit numeric 'AccountID' 
is converted to a textual representation 
without any prefix. For OJT tickets the 
textual representation is set to 
the'AccountID' field in the ticket.

User ID 
(UserID)

text 255 ID of the user who sent the job. Es-
caped according to escaping rules.
When the User ID is not available, this 
field is empty.
Note: The 9-digit numeric 'UserID' is 
converted to a textual representation 
without any prefix. For OJT tickets the 
textual representation is set to 
the'UserID' field in the ticket.
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Job ID (Jo-
bID)

text 255 ID of job (for example, the job name) 
as indicated in a job ticket. Escaped 
according to escaping rules.
When the User ID is not available, this 
field is empty.
Note: For OJT tickets the textual 
representation is set to the'JobName' 
field in the ticket.

Machine ID 
(MachID)

text 255 Unique ID for the system. 
Note: When you have a configuration 
with a printer, the Machine ID is the 
serial number of the printer. When you 
have a scanner only configuration, the 
Machine ID is the serial number of the 
scanner. 

Record ver-
sion (Ver-
sion)

num 2 Version number of the record. Starts at 
0.
Records are numbered from the first 
layer of the first input page to the last 
layer of the last input page of the job

Job Unique 
ID (JobUID)

num 8 Unique job ID, generated by the con-
troller. The Job Unique ID is unique 
for each job in the log file. 

Record num-
ber (RecNr)

num 6 Sequence number of this record in the 
account log for this job. Starts at 0. 

Job submis-
sion source 
(JobSrc)

text 255 Host name or IP address of the source 
of the job. If the source of the job sub-
mission is not available, leave the field 
empty.

Channel type 
(ChnType)

text N/A The Protocol used for the job submis-
sion. Includes LPD, SMB, PSERVER, 
FTP, CENTRONICS.

Receive date 
year (RcvY)

num 4 The year when the source page was re-
ceived.

Receive date 
month (M)

num 2 The month when the source page was 
received.

Parameter Type Length 
(max)

Description

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


280 Océ TCS400 User manual

Receive date 
day (D)

num 2 The day of the month when the source 
page was received.

Receive time 
hours (h)

num 2 The hour when the source page was re-
ceived.

Receive time 
minutes (m)

num 2 The minute when the source page was 
received.

Receive time 
seconds (s)

num 2 The second when the source page was 
received.

Source loca-
tion (SrcLoc)

text 255 The location of the input file. 

Source page 
number 
(SrcPg)

num 6 The page number of the input page in 
the source file. Starts at 1.

Source type 
(SrcType)

text N/A The type of source page. The different 
types of PDLs are TIFF, CALS, PDF, 
PS, NIRS, HPGL, HPGL2, C4, CAL-
COMP, and ASCII.

Source width 
(SrcWth)

num 6 Native width of source page in units ( 
1 unit = 1/72 inch).

Source 
height (SrcH-
gt)

num 6 Native height of source page in units ( 
1 unit = 1/72 inch).

Output width 
(OutWth)

num 6 Actual width of output page in units ( 
1 unit = 1/72 inch).

Output 
height (Out-
Hgt)

num 6 Actual height of output page in units ( 
1 unit = 1/72 inch).

Width scale 
(WthScl)

num 4 The scaling factor, in %, applied to the 
original in the width direction.

Height scale 
(HgtScl)

num 4 The scaling factor, in %, applied to the 
original in the height direction.

Parameter Type Length 
(max)

Description
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Mirroring 
(Mirror)

text 2 Mirroring applied to the original. LR 
(vertical mirror) or TB (horizontal 
mirror). If mirroring is not applied, 
this field remains empty. 

Rotation an-
gle (Rot)

num 3 The angle of the scaled original when 
you rotate to the left. The possible val-
ues are 0, 90, 180, 270. An angle of 0 
indicates that the orientation of the 
source and the output image are iden-
tical.

Process type 
(PrcType)

text N/A The type of processing that was 
done for this page.

■ PLOT
■ COPY
■ STF (scan to file)
■ CHK (check plot)
■ ICOPY (interrupt copy)
■ INTRNL (internal job)
■ REPLOT (from history queue).

Process com-
pletion (Prc-
Cmplt)

text N/A How the process was completed for 
this page. 

■ DONE (normal termination)
■ ABRT (job canceled by user)
■ ERR (error occurred)

When an error occurred or the job was 
cancelled, the last page that was cor-
rectly delivered has the value DONE 
and an additional record with value 
ABRT or ERR is generated for the first 
page after that (the page that failed to 
deliver due to the error).

Delivery date 
year (DlvY)

num 4 The year when the page was delivered. 

Delivery date 
month (M)

num 2 The month when the page was deliv-
ered.

Parameter Type Length 
(max)

Description
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Delivery date 
day (D)

num 2 The day of the month when the page 
was delivered.

Delivery time 
hours (h)

num 2 The hour when the page was delivered.

Delivery time 
minutes (m)

num 2 The minute when the page was deliv-
ered.

Delivery time 
seconds (s)

num 2 The second when the page was deliv-
ered.

Output page 
number (Out-
Pg)

num 6 The page number of the output page in 
this job. Starts at 1. 

Output media 
type (Med-
Type)

text N/A The type of output medium.
■ PPAPER (plain paper)
■ TRANSPARENT
■ FILM
■ POLYESTER
■ VELLUM
■ TRANSLUCENT
■ PAPERDRAFT
■ PAPERSTANDARD
■ BOND
■ BONDDELUX
■ PAPERSTANCOATED
■ PAPERPREMCOATED
■ BONDCOATED
■ BONDCOATEDHIGHRES
■ PHOTOPAPERMATT
■ PHOTOPAPERGLOSS
■ TRACINGPAPER
■ BONDTRANSLUCENT
■ MONOVELLUM
■ COLORVELLUM
■ FILMMATT.

The field is empty for scan-to-file jobs.

Parameter Type Length 
(max)

Description
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Output media 
special 
(MedSpc)

text 1 Indicates whether special output me-
dia was selected. Y or N.
The field is empty for scan-to-file jobs.

Output media 
weight (Med-
Wgt)

text N/A The weight of the output media .
■ LIGHT
■ NORMAL
■ HEAVY.

If the weight of the output media is not 
known, this field remains empty. The 
field is empty for scan-to-file jobs.

Output media 
source (Med-
Src)

text N/A Source of the output media. For exam-
ple, ROLL1, ROLL2.
The field is empty for scan-to-file jobs.

Output fold 
method 
(Fold) 

text N/A Folding in 2 directions
■ AFNOR
■ ERICSSON
■ DIN.

Folding in 1 direction
■ AFNOR1
■ ERICSSON1
■ DIN1.

Off-line folding is not logged.
The field is empty for scan-to-file jobs.

Output bind-
ing method 
(Bind)

text N/A Specifies the binding method for 
the output media.

■ EDGEONLY (only binding edge)
■ REINFORCE
■ PUNCH.

The field is empty for scan-to-file jobs.

Parameter Type Length 
(max)

Description
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Output media 
destination 
(MedDst)

text N/A Output media destination in case of 
physical output

■ BELT1
■ BELT2
■ BELTS
■ CDT
■ IRT
■ FIRSTFOLD
■ STACKER.

The field is empty for scan-to-file jobs.

Output file 
type (File-
Type)

text N/A Type of output file in case of digital 
output.

■ TIFF
■ CALS
■ PDF.

The field is empty for print jobs and 
copy jobs.

Output file 
compression 
(FileCmpr)

text N/A Compression method of output file 
in case of digitaloutput.

■ GROUP3
■ GROUP4
■ PACKBITS
■ LZW.

The field is empty for print jobs and 
copy jobs. The field is empty for 
scan-to-file jobs without compression.

Output file 
size (FileSz)

text 9 Size of output file in bytes (including 
all pages incase of multi-page output 
files) in case of digital output.
The field is empty for print jobs and 
copy jobs.

Parameter Type Length 
(max)

Description
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Output file 
destination 
(FileDst)

text 255 Name of the destination for the output 
file as used in the Océ Scan Manager, 
in case of digital output. If multiple 
pages in one job have the same desti-
nation file, a multi-page file is generat-
ed.
The field is empty for print jobs and 
copy jobs.

Output reso-
lution (width 
direction)

num 4 The resolution of output in width di-
rection, in dpi.

Output reso-
lution (height 
direction)

num 4 The resolution of output in height di-
rection, in dpi.

Completion 
ID (CmpId)

num 8 The completion ID indicates the in-
stance number of the job. Starts at 1. 
More than 1 job instance occurs when 
the jobs are restarted from the history 
queue. 

Output color 
mode(ColM-
od)

text 255 The color mode of the job.
■ color
■ MONOCHROME

Output quali-
ty 
mode(QualM
od)

text 255 The quality mode of the job.
■ CHECK
■ RELEASE
■ PRESENTATION.

Parameter Type Length 
(max)

Description
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[44] The fields in the standard CSV account log file

Note: This table is a complete list of all standard fields for all systems. When a 
system does not support a function, the field remains empty.

Output con-
tent 
type(Cont-
Mod)

text 255 The content type of the print jobs
■ LINES/TEXT
■ AREA FILL
■ STANDARD
■ POSTER.

Image type 
(ImageType

text 255 The image type of the copy and 
scan-to-file jobs.

■ PHOTO
■ LINE ART
■ MAPS
■ ARTWORK
■ DARK ORIGINALS
■ BLUEPRINT.

Parameter Type Length 
(max)

Description
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Account information for the media format

If a standard output media format is selected for a job, the values in the log file 
match the values in the following table: Any different values indicate that a 
non-standard media format was selected in the job.

[45] Media format for output media

Format name Width (units of 1/72 
inch)

Height (units of 1/72 
inch)

A0 (33 x 47 ") 2384 3370

A1 (23 x 33") 1684 2384

A2 (17 x 23") 1191 1684

A3 842 1191

A4 595 842

E 2448 3168

D 1584 2448

C 1224 1584

B 792 1224

A 612 792

E+ 2592 3456

D+ 1728 2592

C+ 1296 1728

B+ 864 1296

A+ 648 864

B1 (10 x 14") 2004 2835

B2 (10 x 14") 1417 2004

B3 (10 x 14") 1001 1417

B4 (10 x 14") 709 1001

30 x 42 2160 3024

jis B1 2064 2920

jis B2 1460 2064

jis B3 1032 1460
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[45] Media format for output media

The width and the height values change position for output with landscape 
orientation.

Note: The above list is not a list of supported media types and sizes. Not all 
systems support all the described media types and sizes.

jis B4 729 1032

jis B5 516 729

Format name Width (units of 1/72 
inch)

Height (units of 1/72 
inch)
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Specifications of the Océ TCS400 printer 

Technology Multiple printhead thermal inkjet.

Printheads 10 Semi-permanent printheads with 208 nozzle
■ 4 Black printheads
■ 2 Cyan printheads
■ 2 Magenta printheads
■ 2 Yellow printheads.

True resolution 600 x 600 dpi

Ink tanks 400 ml disposable ink tanks

Ink level monitoring Ink level indication on the printer operator panel and 
through Océ Remote Logic®

Out of ink signaling

Print speed Grayscale
■ 1 33x47" (portrait) per 1 minute and 10 seconds 

or 1.0 m2/min

Color
■ 1 33x47" (portrait) per 2 minutes and 20 seconds 

or 0.5 m2/min

Maximum productiv-
ity

Grayscale
■ 55 m2/h

Color
■ 27 m2/h

Minimum pen thick-
ness

0.080 mm

Media sources 1 or 2 front loadable rolls

Media core diameter 2"

Maximum roll length 132 yards

Output delivery Slide, accessible from the roll side
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Output sizes Width
■ DIN: From 17x23" to 33x47", 36", and 28x39"
■ ANSI: From 22" to 36"

Length
■ 9.6 - 200 inches

Drawing margins ■ Leading and trailing strip: 5 mm
■ Left and right side: 3 mm

Width detection Automatic

Media types ■ Uncoated: 20 - 30 lb. bond
■ Coated: 24 - 30 lb. bond
■ Specialties

Calibration ■ Automatic printhead alignment
■ Failing nozzle compensation
■ Unattended printing in the overnight mode.

Dimensions 58.44" x 29.72" x 78.4" (H x D x W)

Voltage 100-120 / 230 V

Frequency 50/60 Hz

Power consumption ■ EPA-sleepmode (printer and Océ Power Logic® 
controller, not including the monitor)
< 39 W

■ Standby
110 W

■ In operation
160 W

Weight 363 - 396 lbs.

Safety approvals TüV GS, CETECOM, CE, UL, (c)UL, CB, FCC 
Class B

Other ■ Maintenance cassette.
■ EPA Energy Star® compliant.
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Specifications Océ TCS400 scanner 

Technology ■ Free-standing console
■ Océ Image Logic® real-time image processing

Scan speed Grayscale
■ 1.65 yards per minute

Color
■ .55 yards per minute.

Optical resolu-
tion

508 dpi

Scan width 1,016 mm (40")

Original feed Center loading

Original size Minimum
■ 6" x 4" (L x W)

Maximum
■ 200" x 44" (L x W).

Maximum media 
thickness

15 mm (0.6")

Exposure control ■ Exposure dark areas
■ Exposure light areas.

Scale method ■ Custom scale
A range of 10% - 1000% (0.1% fixed step interval).

■ Automatic
The output image fits on the selected output format.

■ 1 to 1.
No scaling.

Input mode ■ Single sheet
■ Set

Number of cop-
ies

1 - 99 (scan once print many)

Image quality ■ Automatic background compensation
■ Equalize
■ Deskew.
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Image editing ■ Mirroring
■ Horizontal shift
■ Vertical shift
■ Blueprint
■ Area selection.

Function ■ Pre-programming of next job
■ Programmable default settings
■ Standard cut, synchro cut and custom cut modes
■ Leading and trailing strip adjustment (0 - 16 inches)
■ Concurrent scanning and printing
■ Scan to file.

Scanner Mainte-
nance Kit 

■ Maintenance software (integrated in the Océ Power 
Logic® Controller)

■ Maintenance sheet.

Voltage 100-240 V

Frequency 50/60 Hz

Dimensions 51" x 25" x 64" (H x D x W)

Weight 104 kg

Safety approvals TüV GS, CE, UL, (c)UL, CB, EMC Directive 
89/336/EEC, FCC Class B
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Supported media types and sizes

Introduction

Océ systems and materials are matched for optimal quality and performance. 
You are therefore recommended to use only approved Océ materials in the Océ 
TCS400. A full list of Océ materials for use in the Océ TCS400. The list 
includes plain paper, transparent paper, colored papers and different polyester 
films is available from your Océ representative.

Media types

The Océ TCS400 supports the following media. 

Media name Notes

Uncoated media

Océ Draft Paper 20 lb. bond

Océ Standard Paper 24 lb. bond

Océ Check Bond Uncoated 20 lbs US equivalent of Océ 
Draft Paper

Océ Deluxe Bond Uncoated 24 lbs US equivalent of Océ 
Standard Paper

Coated media

Océ Premium Grade 24 lb. bond

Océ Color Bond Coated 24 lb. bond

Océ Smart Matte Paper 100 45 lb. bond

Special media

Océ Smartfit Plus Photogloss 47 lb. bond

Océ Tracing Paper 24 lb. bond

Océ Translucent Bond 16 lb. bond

Océ Translucent Bond 18 lb. bond

Océ Monochrome Vellum 16 lb. bond

Océ Monochrome Vellum 20 lb. bond

Océ Color Vellum 20 lb. bond
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Media sizes 

Océ Double Matte Film 95 µ

Océ Double Matte Erasable Film 3 mil

Océ Double Matte Erasable Film 4 mil

Maximum Minimum

Media width 91.44 cm 24 inch

Roll length 110 yards Not applicable

Media name Notes
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Specifications Océ Power Logic® controller

Océ Power Logic® controller hardware

Platform Océ controller with embedded Windows® 
XP

Memory 256 Mb, expandable to 512 Mb

Hard disk capacity 40 GB. Two high speed hard discs, one ded-
icated to file spooling and one for set memo-
ry

Graphical user interface Optional keyboard, mouse and monitor

Standard interface 10/100BaseT with RJ45

Optional interfaces Token Ring 4/16 Mb 

Network protocols TCP/IP, SMB, IPX/SPX, FTP, LPD

Power consumption Controller: < 75 W
Monitor: 200 W

Electrical requirements 100-120 / 230 V, 50/60 Hz

Applicable software Océ Power Logic® controller software
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Océ Power Logic® controller software

The Océ Power Logic® controller software consists of a basic module and a 
print module.

[46] Basic module

[46] Basic module

[47] Print module

Basic functions File spooling on the controller.
Concurrent receiving, processing and print-
ing of digital jobs.

Basic applications ■ Océ Settings Editor
■ Océ System Control Panel
■ Océ Queue Manager
■ Océ Remote Logic®

■ Océ Print Exec® Workgroup LT

Optional Account logging.
Records jobs by user and account number. 
Information stored in a (ASCII or UTF-16) 
file for later use.

Print processing technology Print Optimization Kernel (Poker)

Number of prints 1 - 999
Set memory: send once, process once, print 
many

Roll selection and switching Manual
Automatic

Print manipulation Rotation
Auto-scaling
Positioning
Pen management
Trailing strip adjustment; add up to 400 mm

Color modes ■ Grayscale
■ Color

Quality modes ■ Check
■ Release
■ Presentation

Content modes ■ Lines & Text
■ Area fills
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[47] Print module

Image types Color
■ Line art
■ Photo
■ Map
■ Artwork.

■ Grayscale
■ Line art
■ Photo
■ Dark original
■ Blueprint.

Printer transfer curves Standard

Language sensing Automatic Language Sensing (ALS)

Standard file formats ■ Vector: HPGL, HPGL/2, Calcomp
■ Raster: HP-RTL, TIFF 6.0, NIFF, 

CALS-I, NIRS, C4, ASCII

Cut length ■ Standard cut
■ Synchro cut
■ Custom cut

Optional Adobe® PostScript 3™ PDF printing
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Specifications Océ Scan Logic®

Application Océ Scan Manager, integrated scanning solution with 
Océ View Station LT

Scan destinations Maximum of 10 destinations.
■ Scan to the local controller
■ Scan to a Microsoft® Windows network location with 

Server Message Block (SMB)
■ Scan to an internet location with File Transfer 

Protocol (FTP).

Resolution 72, 200, 300, 400, and 600 dpi.

File formats ■ TIFF
■ PDF
■ CALS-I.

Available file or-
ganization types 
for TIFF files

■ RAW
■ Stripped
■ Tiled.

Available file 
compression 
methods

TIFF file format
■ None (uncompressed)
■ Group 3 2D
■ Group 4
■ Packbits.

PDF file format
■ Group 4
■ Flate.

CALS-I file format
■ Group 4.
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Available color 
depths

TIFF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

PDF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

CALS-I file format
■ Black & white, 1 bit per pixel.

Scan mode Single scan.

File naming Automatically generate unique file names for each scan.

Viewing View scans at point of scanning.

Océ Image Log-
ic®

The best scan quality for different image types.

Ease of use Scan to file from the scanner operator panel.
Scan directly to a local or a remote destination.

Requirements 768 Mb on the controller and a graphical user interface

Options Océ View Station for editing and enhancement of 
scanned documents
Océ Batch Processor for automated editing.
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Specifications drivers and job submission software

Océ drivers 

Optional application software

Software environment Required driver Remarks

Microsoft® Windows® 9.x, 
ME, 2000, NT 4.0, XP

Windows® Printer Driver Generating 
HP-GL/RTL

AutoCAD® 14 (on all sup-
ported platforms)

Océ ADI 

AutoCAD® 
2000/2001/2002 (on all 
supported platforms)

Océ HDI 

Graphical application soft-
ware on Microsoft® Win-
dows, Apple® Macintosh 
and Unix™ Postscript

Océ Postscript 3

Function Application software

Job submission ■ Océ Print Exec® Workgroup
■ Océ Print Exec® LT
■ Océ Print Exec® Pro
■ Océ Repro Desk

Viewing ■ Océ View Station LT
■ Océ View Station
■ Océ View Station and Batch Processor
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Instructions for safe use

Introduction

Océ designed products are tested in accordance with the strictest international 
safety standards. It is important that you observe the safety rules included in 
this appendix to help assure safe working with the Océ TCS400.

Maintenance

■ Do not remove any screws from fixed panels.
■ Do not do any maintenance activities other than the maintenance activities 

for the parts and the maintenance materials described in this manual.
■ Do not place any liquids on the machine.
■ Use maintenance materials and other materials for their original purpose 

only.
■ Keep maintenance materials away from children.
■ Do not mix cleaning fluids or other substances.
■ To avoid the risk of introducing hazards, all modifications to Océ equipment 

are strictly reserved to properly qualified and trained service technicians.

Connection

Attention: Do not move the machine yourself, but contact your Customer 
Service.

It is recommended to connect only those products which meet the (inter)nation-
al product safety and radio frequency interference standards, and to use an at-
tachment cable as specified by Océ.
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■ If for some reason you have to move the machine yourself, please make sure 
that the mains power point has the right fuse capacity. See the Océ TCS400 
safety data sheet in this appendix for information about maximum current.

■ Do not bridge any mechanical or electrical circuit breakers.
■ Do not use an extension lead to connect the machine.
■ This machine is not designed for connection to an IT power system. An IT 

power system is a voltage network in which the neutral wire is not 
connected to earth.

■ When the machine is connected through a wall socket, place the machine 
near a wall socket that is easily accessible.

■ When the machine is connected through a fixed connection to the electricity 
grid, the disconnect device in the fixed connection must be easily 
accessible.

Surroundings

■ Make sure that the machine is placed on a level, horizontal surface of 
sufficient strength. See the Océ TCS400 safety data sheet in this appendix 
for information about the weight of the equipment.

■ Make sure there is sufficient space around the machine. This facilitates 
reloading materials as well as maintenance.

■ Do not place the machine in rooms which are subject to excessive vibration.
■ Do not place the machine in rooms which are too small or insufficiently 

ventilated. See the Océ TCS400 safety data sheet in this appendix for 
information about space and ventilation requirements.

General

■ Always use materials recommended by Océ and developed for the Océ 
TCS400. Materials not approved by Océ can cause errors in your machine.

■ Do not use the machine when it is emitting unusual sounds. Remove the 
plug from the power socket or turn off the fixed connection to the electricity 
grid and contact Customer Service.

Note: This is a class A product. In a domestic environment, this product may 
cause radio interference, in which case the user may be required to take 
adequate measures.
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Safety data sheets

Introduction

The disclaimer below applies to all safety data sheets in this manual. Contact 
your local Océ organization for questions about Océ products regarding health, 
safety and environment. You can find the address of your local Océ 
organization in appendix C of this manual.

Disclaimer 

The safety data sheets in this manual have been compiled to the best of our 
knowledge. They are intended as a compact guide to the safe handling of this 
product. We reserve the right to revise safety data sheets, as new information 
becomes available. It is the user's responsibility to determine the suitability of 
this information for the adoption of safety precautions as may be necessary. It 
is the user's responsibility to contact Océ to make sure that the safety data 
sheets are the latest ones issued. If and in so far as limitation of liability is 
permitted under the applicable laws, we do not accept liability for any 
inaccuracy that may occur in this information. 

Note: Not all safety data sheets were available at the moment this manual was 
published. The Océ organization in your country will be pleased to send you a 
copy of the missing sheets. You can find the address of the Océ organization in 
your country in appendix C of the user manual.
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Product safety data sheet Océ TCS400 printer

The content of this safety data sheet is subject to the disclaimer of liability on 
page (see ‘Disclaimer’) of this manual. 

Material safety data sheet Océ inksOcé TCS400

This safety data sheet was not available at the time this manual was published.
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Product safety data sheet Océ TCS400 scanner

The content of this safety data sheet is subject to the disclaimer of liability on 
page (see ‘Disclaimer’) of this manual. 

PRODUCT SAFETY DATA SHEET

Océ-USA, Inc.

Number E-760-a-US
Date June 2003

Copyright © 2003 Océ-Technologies B.V., Venlo, NL

Model Océ TCS400 Scanner

Description Wide format color scanner
Scan width
Scan speed

40 “ 
0,5 m/min

Dimensions Width 1340 mm
Depth 490 mm
Height 1070 mm

Weight 102 kg

Voltage 100-240 V
Frequency 50-60 Hz
Current-rated 1.1-0.45 A
Power consumption, plug-in 58 W (incl user interface)
Power consumption, stand by 104 W (incl user interface)
Power consumption, operation 119 W (incl user interface)
Mains connection Cable with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP X0 (IEC 529)

Sound pressure level
(at operator position)

Standby In operation
26 dB(A) main-body 51 dB(A); 

impulse  Li =8 dB(A)
Sound power level 37 dB(A) main-body 61 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 104 W; in operation 119 W
Ozone emission Not applicable

Room volume Recommendation: min. 15 m3

Room ventilation Recommendation: min. 7.5 m3/h (natural ventilation)

Use simulation at random 
operation

Not applicable

Consumables Not applicable

Additional safety information None

Listed according to standard UL 1950 and CAN/CSA-C22.29 No.950
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EPA ENERGY STAR®

Introduction

Océ-Technologies B.V. has joined the ENERGY STAR® Program of the United 
States Environmental Protection Agency (EPA). The purpose of the ENERGY 
STAR® Program is to promote the manufacturing and marketing of 
energy-efficient equipment, thereby potentially reducing combustion-related 
pollution. Using the energy management features outlined below prevents 
unnecessary power consumption, which helps to prevent air pollution from 
electricity generating plants and saves money on your utility bills.

As an ENERGY STAR® Partner, Océ-Technologies B.V. has determined that this 
printer model meets the ENERGY STAR® guidelines for energy efficiency.

See the Product Safety Data Sheet in this appendix for power use data.

Attention: If this printer is upgraded to a multifunctional device by adding a 
wide format color scanner, the system does not comply with the ENERGY STAR 
sleep mode specification for a wide format multifunction device. The Energy 
Star® logo which appears in the printer operator panel only refers to the 
printer.
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Features

The EPA ENERGY STAR® Criteria for printers involves the following feature.
■ Sleep mode

The power use of some functions is automatically decreased to save energy. 
The printer enters the sleep mode 30 minutes after the last print job is 
completed. The key operator can adjust this default time within a range 
between 30 and 240 minutes.
It is suggested that you determine the appropriate default time for your work 
pattern by changing the setting in increments of 30 minutes and testing each 
setting for at least a week. If, due to your usage pattern, a 240 minute limit 
still causes sizable inconvenience, the key operator can disable the sleep 
mode.

ENERGY STAR® is a U.S. registered mark.
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Reader's comment sheet 

Questions 

Have you found this manual to be accurate? 
O Yes 
O No

Were you able to operate the product, after reading this manual? 
O Yes 
O No 

Does this manual provide sufficient background information? 
O Yes 
O No 

Is the format of this manual convenient in size, readability and arrangement 
(page layout, chapter order, etc.)?
O Yes 
O No 

Could you find the information you were looking for? 
O Always 
O Most of the times 
O Sometimes 
O Not at all 

What did you use to find the required information? 
O Table of contents 
O Index 

Are you satisfied with this manual?
O Yes 
O No 

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest 
improvements overleaf or on a separate sheet. 
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Comments:
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------
Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please do fill in your occupation) 

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to: 

Océ-Technologies B.V.
For the attention of ITC User Documentation. 
P.O. Box 101, 
5900 MA Venlo
The Netherlands 

Send your comments by E-mail to: itc-userdoc@oce.nl 

For the addresses of local Océ organizations see: http://www.oce.com 
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Addresses of local Océ organizations 

Océ-Australia Ltd. 
P.O. Box 363
Ferntree Gully MDC
Vic 3165
Australia
http://www.oce.com.au/ 

Océ Japan Corporation
3-25-1, Nishi Shinbashi
Minato-Ku
Tokyo 105-0003
Japan
http://www.ocejapan.co.jp/

Océ-Osterreich GmbH 
Postfach 95
1233 Vienna
Austria
http://www.oce.at/

Océ-Belgium S.A.
Rue Astrid 2/A
1143 Luxembourg-Belair 
http://www.oce.lu/indexfr.htm

Océ-Belgium N.V./S.A. 
J. Bordetlaan 32
1140 Brussel
Belgium
http://www.oce.be/

Océ Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy 
Lot 4A, Jalan 19/1 
46300 Petalig Jaya 
Selangor Darul Ehsan
Malaysia
www.ocemal.com.my

Océ-Brasil Comércio e Indústria Lt-
da.
Av. das Nações Unidas, 11.857 
Brooklin Novo
São Paulo-SP 04578-000
Brazil
http://www.oce-brasil.com.br/ 

Oce-Mexico
Ave. Prol. Paseo de la Reforma No. 
61-6A2
Col. Paseo de las Lomas
Delegación Álvaro Obregón
México, D.F., 01330
México
www.oceusa.com

Océ-Canada Inc. 
4711 Yonge Street, Suite 1100 
Toronto, Ontario M2N 6K8
Canada
http://www.oce.ca/

Océ-Norge A.S. 
Postboks 4434 Nydalen
Gjerdrums vei 8
0403 Oslo
Norway
http://www.oce.no
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Océ Office Equipment (Beijing) Co., 
Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China
http://www.oce.com.cn

Océ-Poland Ltd. 
Ul. Lopuszaska 53 
02-232 Warszawa 
Poland
http://www.oce.com.pl 

Océ-Czech Republic ltd.
Hanusova 18
140 21 Praha 4
Czech Republic
http://www.oce.cz/ 

Océ-Lima Mayer, S.A.
Av. José Gomes Ferreira, 11 Piso 2 - 
Miraflores 
1497-139 Algés
Portugal

Océ-Danmark a/s 
Vallensbækvej 45
2605 Brøndby
Denmark
http://www.oce.dk/ 

Océ Singapore Pte Ltd.
190 MacPherson Road
#03-00 Wisma Gulab 
Singapore 348548 

Océ Finland OY
Tallberginkatu 2 A, PL 163
00180 Helsinki
Finland
http://www.oce.fi

Océ España SA 
Business Park Mas Blau
Osona, 2 08820 El Prat de Llobregat
Barcelona
Spain
http://www.oce.es 

Océ-France S.A. 
32, Avenue du Pavé Neuf
93161 Noisy-le-grand, Cedex 
France
http://www.oce.fr/

Océ-Svenska AB
P.O. Box 754
S-191 27 Sollentuna
Sweden
http://www.oce.se 

Océ-Deutschland GmbH
Solinger Straße 5-7
45481 Mülheim/Ruhr
Germany
http://www.oce.de/ 

Océ-Schweiz AG 
Sägereistrasse 29
CH8152 Glattbrugg
Schwitzerland
http://www.oce.ch
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Océ-Hong Kong and China head of-
fice
12/F 1202 The Lee Gardens
33 Hysan Avenue 
Causeway Bay
Hong Kong
http://www.oce.com.hk/

Océ (Thailand) Ltd. 
B.B. Building 16/Floor
54 Asoke Road
Sukhumvit 21
Bangkok 10110
Thailand

Océ-Hungaria Kft.
1241 Budapest
Pf.: 237
Hungary
http://www.oce.hu/

Océ-Nederland B.V. 
P.O.Box 800 
5201 AV 's-Hertogenbosch 
The Netherlands
http://www.ocenl.nl/ 

Océ-Ireland Ltd.
3006 L ake Drive 
Citywest Business Campus
Saggart
Co. Dublin
Ireland

Océ (UK) Limited 
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ 
United Kingdom
http://www.oce.co.uk

Océ-Italia S.p.A. 
Strada Padana Superiore 2/B 
20063 Cernusco sul Naviglio (MI) 
Italia
http://www.oce.it/ 

Océ-USA Inc. 
5450 North Cumberland Avenue
Chicago, IL 60656
USA
www.oceusa.com
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Index

A
Account logging

Account file parameters 278
Account file structure 276
Define account ID 270
Define user ID 270
Enable 269
file properties 270
FTP

MS-DOS box 274
Web browser 273

function 268
Get log file 271
import in Excel 272
log file information 276
media format information 287

Align 74
Area selection 68
Auto view 107
Automatic background compensation 145
Automatic logon

enable 262
Automatic scaling 72, 94

B
Background comp. 145

C
CAD drawings

Color 128
color (high density) 128
Grayscale 127

Calibration
scanner 146

Clean cut the media 162

Clean the glass plate of the scanner 198
Clean the scan area 198
Clean the white platen of the scanner 198
Clear set memory 211
color modes

color 118
grayscale 118

Components
Power Logic controller 36
printer 18
system 16

Configure system
Network adapter 50

Connectivity Manual 11
Content modes

Area fills 120
Lines & Text 120

Controller
turn off 43
turn on 42

Copy job
Create and start 64
Set 64
Single sheet 64

Copy quality
optimize 145

Copy quality problems
solutions 145

Cut the output 161

D
Dark areas 145
Demo print 134
Description of output quality problems 135
Description of quality problems 130, 133
Deskew 33, 145
Destination

manage 104
Display counters 29
documentation set 11
Drivers 301
drivers

documentation 12
Drying time

change 177
typical drying times per media type 175
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E
Energy save modes

Energy save mode 44
Sleep mode 44

Equalize 145
Errors

Carriage away from home position too long 
209

Cover or door opened 208
damaged jobs 211
End of roll 208
Permanent errors 207
Possible obstruction of ink path 210
Required media not available 210
Set memory

damaged jobs 211
red zone 211

System errors 207
Temperature or humidity out of range 211
types 204

Exposure 145

F
Fallback mode 178, 186
Feed the original 156
File formats 91
File name

define 106
File size 86

G
GIS drawings

Color 128
color (high density) 128

H
Humidity 137, 175, 179

I
Image quality 86
Image type

Artwork 121
Blueprint 121
Dark original 121
Line art 121
Map 121
Photo 121

Ink tank
place 185
remove 184
replace 183

Ink usage 29
IT8 file

update 149

J
Jammed media

Remove 205
Jammed original

Remove 212
Job submission 54, 55

FTP 58
Print Exec® workgroup 57
printer drivers 56

job submission software
documentation 12

L
Language

change 28, 29
Light areas 145
Load media roll 169

M
Maintenance cassette

Place 195
Remove 193

Media roll
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define 171
load 169
remove 165
wizard 171

Media type
select 174

Media usage 29

N
Network configuration 49

O
Océ Power Logic® controller

applications 37
location 36
set display language 46

Océ View Station LT 96
On-line helps

drivers 12
job submission software 12
Océ Power Logic 12

On-line mode
ink level information 28
job information 28
media information 28
printhead information 28
system information 28

Optimize copy quality 145
Optimize Output quality 137
Optimize print quality 141
Optimize scan quality 145
Original

feed 156
Original settings 66, 85
Originals

thick 158
Output quality 116, 117, 123

Optimize 137
Output quality problems

solutions 137
Overnight printing 179
Overview

system 16

P
Password 263, 264
Place

Maintenance cassette 195
Printheads 190

Power Logic Controller
System Control Panel 233

Power Logic controller
Log off 265
Log on 265
Queue Manager 240
Remote Logic 252
Settings Editor 221
Start the applications 220
Supported languages 258
System Control Panel 232

Print Exec® workgroup 57
Print job

delete 153
resume 153
stop 153

Print quality
Optimize 141

Print speed 123
Print system configuration 230
Printer

turn off 43
turn on 42

Printer drivers 56
Printer operator panel 24

change language
off-line screen 47
on-line screen 47

keys 26
off-line mode 29
on-line mode 28
red attention LEDs 26
screen 25
set display language 46

Printheads
Fallback mode 186
Place 190
Remove 187
Replace 186

PUSH 216

Downloaded From ManualsPrinter.com Manuals

http://www.manualsprinter.com


320 Océ TCS400 User manual

Q
Quality check print 129
Quality mode

CAD drawings
Color 128
color (high density) 128
Grayscale 127

GIS drawings
Color 128
color (high density) 128

Quality modes
check 119
presentation 119
release 119

Queue Manager
Cancel jobs 154, 248
History queue window 245
Icons 246
Inbox queue window 245
Job priority 249
Menu bar 243
Overview of the functions 240
Place jobs on hold 154, 249
print jobs 247
printer window 244
Restart jobs on hold 154, 249
Status bar 244
Structure 242
Toolbar 244
User modes 241
User operations 247

R
Relation output quality and media types 124
Remote Logic

Add system 260
Connect to controller 260
Install

UNIX 254
Windows 253

Remove system 261
Remote logic

applications 252
Command line parameters 257

start applications 256
Remove

Jammed media 205
Jammed original 212
Maintenance cassette 193
Printheads 187

Remove media roll 165
Replace

ink tank 183
Replace printheads 186
Retrieve the scanned files 84

S
Scale 72, 94

automatic 72, 94
Scan Manager 96
Scan quality

optimize 145
Scan quality problems

solutions 145
Scan to file

settings 86
Scanned file

delete 108
print 107
view 107
view the properties 108

Scanner
turn on and off 43
warm up 43

Scanner calibration 145
scanner calibration 149
Scanner operator panel

change language
 48

set display language 46
Settings

Copy 61
scan to file 79, 82

Scan-to-file
settings 79, 82

Scan-to-file job
Create and start 83

Self-support Guide 11
Set memory

clear 211
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Settings Editor
Key operator settings 218, 228
Load settings 230
Save settings 229
System administrator settings 218, 228

Shift 74
Smartcard 216
Specifications

Controller
Hardware 296
software 297

Drivers 301
Media sizes 295
Media types 294
Océ Scan Logic© 299
Optional application software 301
Printer 290
Scanner 292

System
turn on 41

System Control Panel
Icons 237
Menu bar 234
Print a list of current settings 230
Print system configuration 230
Status bar 236
Toolbar 235
User operations 232

T
Temperature 179
Temporary store

clear 108
Thick originals 158
Tone scale area check 132
Turn on and off

scanner 43
Turn on system 41
Turn the printer and the controller off 43
Turn the printer and the controller on 42

U
User mode 96, 264

User's Manual 11
Users 13

anonymous user 13
common user 13
key operator 13
repro operator 13
system administrator 14

W
Warm up

scanner 43
Wizard

Change the media type 165
Configure system 49
Feed and cut 161

clean cut 162
Optimize print quality 137, 141
Replace cassette 193
Replace ink tank 184
Replace printhead 187
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